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Chapter 1
Getting Started

Like most users of business software you probably bought 
MultiLedger because you’ve got a job to do. But before you jump into 
the chapter on setting up a company, please read this brief chapter on 
what you should know before you start using MultiLedger.

Hardware and System Requirements

Multiledger for Windows:
• 10 MB free disk space

• Windows 7 or higher 

• Windows compatible printer

MultiLedger for Macintosh

• 10 MB free disk space

• Mac OS 10.6 or higher

• Macintosh compatible printer
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How to Get Help
Only registered users are entitled to technical support from CheckMark 
Inc. For information on CheckMark’s Extended Support options, 
please refer to the brochure that was included with your MultiLedger 
package or go to the support page on our website.

Registered users also receive update and upgrade information. So 
please take a few moments to read the License Agreement, fill out and 
sign the Registration Card, and drop it in the mail. If you would like to 
expedite your registration, you can fill out the Registration Card and 
fax us a copy at (970) 225-0611.

Note While CheckMark is happy to offer you help in using our accounting 
software, we can only offer limited accounting help or advice. 
However, we maintain a network of independent CheckMark 
Consultants who offer services beyond the support that CheckMark 
provides. You’ll find a directory of consultants on our web site, 
www.checkmark.com/consultant_search.php.

Before you call
You can help us make your phone call more effective by doing the 
following before you call:

Fax, mail, or e-mail
registration

• In order to receive support from CheckMark Inc., we need to have 
record of your registration. Fax your registration to us at 970-225-
0611, E-mail your registration to shipping@checkmark.com or 
mail us the Registration Card that is found in the MultiLedger 
package

Read manual • Many users want to start using a program without reading the 
manual. However, if you have any questions about how to use 
MultiLedger, please read the relevant sections in this manual 
before calling us. The manual contains procedures to accomplish 
most accounting tasks. If you feel the manual lacks any crucial 
information, please tell us.

Look for help in
Knowledge Base

• You can find many answers in the Knowledge Base on our 
website:

http://www.checkmark.com/knowledgebase.php

or click on the CheckMark Knowledge Base link under the Help 
menu in MultiLedger.
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Know your registration
number or customer

number

• When you call for technical support, you will be asked for your 
registration or customer ID number. You will find your registration 
number printed on the software package and on the part of the 
registration card you keep. Your customer number can be found on 
any order forms you had received from us.

Know your version
number

• Also before you call, you should know your multiledger version 
and date. The version is on the title bar above the command center.

How to reach us
You can reach us in the following ways:

• You can submit support questions from our web site, as well as 
find answers in our Knowledge Base:

Web Address: http://www.checkmark.com/login

• A call-back system for Telephone Technical Support is available 
between 8 a.m. and 5 pm MT, Monday through Thursday and 
between 8 a.m. and 4 p.m. MT on Fridays.

Phone support: (970) 225-0387

• You can fax us questions or comments at any time:

Fax registration and support: (970) 225-0611

• You can e-mail us at:

Support@checkmark.com

• You can write us:

CheckMark, Inc.
Attn.: Technical Support
323 Drake Rd., Ste 100
Fort Collins, CO 80526
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What You Should Know Before using MultiLedger
Before you start Using MultiLedger, you should know how to perform 
the following basic operations:

• Move and copy files.

• Click, drag, and highlight text

• Choose commands from menus

• Open and close windows

• Use control buttons, check boxes, radio buttons, and scroll bars

• How to navigate through dialog boxes

If you are unfamiliar with any of these topics, refer to the owner’s 
manual that came with your copy of Microsoft Windows or your 
Macintosh computer.

Cross-Platform Versions
The Multiledger CD-ROM, if you purchased one, contains both the 
Windows version and the Macintosh version of the MultiLedger. You 
can install the software on a PC, a Mac, or both, according to the 
software’s License Agreement. this brief section describes the basic 
differences between the two platforms, as well as how this manual can 
be used for either version of the software.

Cross-Platform Considerations
MultiLedger is a multi-user, cross-platform accounting software. You 
can have up to ten users accessing data over a networks of PCs, Macs, 
or a combination of the two. You can also move company files back 
and forth across platforms if your computers are not networked. 
Chapter 5 in this manual explains how to use the multi-user capabilities 
in MultiLedger and Chapter 12 explains how to backup company files 
and restore the files on another platform.

Important OSX Server has a problem handling “byte-range locking” requests from 
Windows (i.e., SMB) users and Mac users simultaneously. If you have 
both Mac and PC users on MultiLedger, you’ll need a Windows Server. 
If you are on an all Mac network, you need to have a dedicated server 
or workstation where the company data resides.
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Platform Differences
For the most part, MultiLedger for Windows and MultiLedger for 
Macintosh are functionally identical. Wherever there are notable 
differences, however, the applicable platform is clearly noted in this 
manual.

Installing MultiLedger on Windows
Follow the steps below to install MultiLedger on your Windows 
computer. For instructions on installing MultiLedger on a Macintosh, 
see “Installing MultiLedger on a Macintosh” on page 7.

Note If you will be using MultiLedger’s multi-user capabilities, see also 
Chapter 5, “Multi-User MultiLedger.”

1 Start your computer as you normally would.

**For CD Install**

2 Insert the MultiLedger disk.

3 Follow the on-screen instructions for installing MultiLedger.

4 Eject the MultiLedger program disk from your computer

**For Download Install**

5 Click on the link provided to download. After the download is 
complete, double-click the download file.

6 Follow the on-screen instructions to complete installation

Important MultiLedger is copyrighted. You may only copy the program according 
to the terms set forth in the License Agreement.

After MultiLedger is finished installing, a folder named “MultiLedger” 
is installed in the Program Files/CheckMark directory.
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Starting MultiLedger and Opening a Sample Company on 
Windows

The following steps show you how to start MultiLedger and open a 
company file (using a sample company as an example). If you want to 
immediately begin setting up a company with MultiLedger, go to the 
next chapter “Initial Setup.”

1 Click the shortcut on your Desktop.

2 Choose Open Company from the File menu

3 Select the “SampleCo” folder, then click Open, or double click the 
“SampleCo” folder.

The dialog box shows the three ML Sample Companies you can 
choose from: “Constructions Sample Co.”, “Retail Sample Co.”, and 
“Service Sample Co.”

4 Select a sample company, then click Open.

The dialog box now shows a highlighted MultiLedger sample company 
file.

5 Click open again.

Once MultiLedger is running with a company open, MultiLedger’s 
Command Center is enabled on your screen.
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Opening Recently Used Companies On Windows
MultiLedger stores the paths to the last five open companies, which 
makes opening frequently used company files easy.

1 Click the shortcut on your Desktop

2 Choose Open recent Company from File menu, then drag out to select 
the desired company files

Note If you use one set of company files on a regular basis, you can have 
MultiLedger automatically open that set of files when you launch 
MultiLedger. For more information, see “Setting Program Preferences” 
on page 76.

Installing MultiLedger on a Macintosh
Follow the steps below to install MultiLedger for Macintosh on your 
Hard drive:

Note If you will be using MultiLedger’s multi-user capabilities, see also 
chapter 5, “Multi-User MultiLedger.”

1 Start your computer as you normally would.

**For CD Install**

2 Insert the MultiLedger disk.

3 Double-click the ML Installer icon.

4 Follow the on-screen instructions for installing MultiLedger.

5 Eject the MultiLedger program disk from your computer

**For Download Install**

6 Click on the link provided to download. After the download is 
complete, double-click the download file.

7 Follow the on-screen instructions to complete installation
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Important MultiLedger is copyrighted. You may only copy the program according 
to the terms set forth in the License Agreement.

A folder named “MultiLedgerf” is installed in the Applications folder 
and automatically opens.

Starting MultiLedger and Opening a Sample Company on 
Macintosh

The following steps show you how to start MultiLedger and open a 
company file (using a sample company as an example). If you want to 
immediately begin setting up a company with MultiLedger, go to the 
next Chapter “Initial Setup.”

1 Open the MultiLedgerf folder that was installed on your hard drive.

2 Start MultiLedger by double-clicking the MultiLedger™ icon.

3 Choose Open Company from the File menu

4 Select the ML Samples folder, then click Open, or double-click the ML 
Samples folder.

The dialog box now shows the three ML Sample Companies you can 
choose from: “Construction Sample Co.”, “Retail Sample Co.”, and 
“Service Sample Co.”

5 Select a sample company, then click Open.

The dialog box now shows a highlighted MultiLedger sample company 
file
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6 Click Open again.

Once MultiLedger is running with a company open, MultiLedger’s 
Command Center is enabled on your screen and you are ready to start 
exploring MultiLedger.

Opening Recently Used Companies on Macintosh
MultiLedger stores the paths to the last five open companies, which 
makes opening frequently-used company file easy.

1 Start MultiLedger by double-clicking the MultiLedger™ icon in the 
Multiledgerf folder.

2 Choose Open Recent Company from the File menu, then drag out to 
select the desires company files.

Note If you use one set of company files on a regular basis, you can have 
MultiLedger automatically open that set of files when you launch 
MultiLedger. For more information, see “Setting Program Preferences” 
on page 76.
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The Command Center
When you open a company with MultiLedger, the first thing you’ll 
notice is MultiLedger’s Command Center. The Command Center is 
divided into three sections: Setup, Transactions, and Reports. To use 
the Command Center, simply click the button of the window you want 
to open.

When you have a company open with MultiLedger, the Command 
Center is active and MultiLedger displays the path to your company 
files at the bottom of the window, as well as how many users currently 
have the company files open. When MultiLedger is running but no 
company files are open, the Command Center is disabled.

Note Please note that not all menu commands are represented in the 
Command Center. Some dialogs and windows, such as those found 
under the File menu, can only be accessed using the pull-down menus 
or keyboard shortcuts.
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Accessing Multiple Open Windows
With MultiLedger, you can have multiple windows open at once. 

To open multiple windows using the Command Center.

1 Click a button in the Command Center to open a window.

2 Click anywhere in the Command Center to reactivate it, or choose 
Commands from the Windows menu.

3 Click another button in the Command Center.

To access multiple windows using the pull-down menus, select an 
option from one of the pull-down menus, then select another.

Note You can quickly go to an open window, by choosing the window’s 
name from the Windows menu.

Where to Go From Here
To get acquainted with MultiLedger, try processing a few transactions 
by following the procedures in Chapter 7 and Chapter 8 in sample 
company.

To begin setting up your company with MultiLedger, go to Chapter 2, 
“Initial Setup.”

To exit MultiLedger, choose Exit from MultiLedger’s File menu in 
Windows. On Macintosh, choose Quit under the MultiLedger menu.
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Chapter 2
Initial Setup
This chapter shows you how to set up a company with MultiLedger, 
and discusses the following topics:

• Entering company information

• Setting up your company’s chart of accounts and beginning 
account balances.

• Entering prior outstanding receivables and payables, as well as 
inventory or service items

Optional setup information, such as passwords, salespeople, sales tax. 
budgets, jobs, preferences, user settings, shipping methods, profit 
centers, and financial statement format are covered in Chapter 4, 
“Setup Options.”

This chapter uses the sample companies provided on the MultiLedger 
program disk to show how information appears after a company has 
been set up. Your setup, of course, depends on your specific 
accounting needs.

What You’ll need
You’ll need the following information to set up a company in 
MultiLedger:

Ending date of prior year This is the last day of your company’s previous accounting year. For 
many companies, the last day of their previous accounting year is 
December 31st. However, MultiLedger can accommodate any month-
end date for a company operating on a non-calendar fiscal year.

If your company is a new start-up company, and you don’t have an 
ending date for your company’s previous fiscal year, you should enter 
the date that corresponds to the year just prior to the year you wish to 
start tracking company data. For example, if your new company’s fiscal 
year starts January 1, 2017, you would enter 12/31/2016 as the Ending 
Date of Prior Year.
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Starting Transaction
Entry

You can start transaction entry at the beginning of your fiscal year or 
any other month. For example, if financial information has already been 
summarized through 3/31/17, an you would like to start daily 
transactions on 4/1/17, account balances could be entered for January, 
February, and March by doing a general journal entry to record the 
transaction totals for each amount for those months. Or you could enter 
all transactions for those months so the detail is available for the entire 
year.

Note While you cannot enter transaction details prior to your current fiscal 
year, you can enter outstanding accounts receivable and accounts 
payable transactions with dates in an earlier year.

Chart of accounts You can adapt your current chart of accounts, create a new one, or copy 
and then modify an existing chart of accounts from one of the 
MultiLedger sample companies or the Sample COAs folder.

Beginning ledger account
balances

You can use the values from a trial balance or balance sheet report or 
the period just prior to your current fiscal year for your beginning 
balances in MultiLedger.

Note You can begin entering transactions in MultiLedger before all your 
beginning balances are entered or finalized.

List of outstanding
accounts receivable and

accounts payable
invoices

To track receivables and payables on an accrual basis, you should have 
a list of outstanding receivables and payables. These are invoices that 
your company has not yet received payment for or that your company 
has not yet paid as of the first day of your current fiscal year.

Important Outstanding receivables or payables that are dated prior to your current 
fiscal year are entered as individual invoices for each customer or 
vendor through the Sales Journal or Payables Journal.

Outstanding receivables or payables that are dated within your current 
fiscal year should be entered as new transactions through the Customer 
Invoices, Sales Journal, Item Purchases, or Payables Journal windows. 
For more details, see the “Customer Transactions” and “Vendor 
Transactions” in chapter 8 and 9.

The total for outstanding receivables invoices and the total for 
outstanding payables invoices you enter with a date prior to your 
current fiscal year should match the beginning balances you set up for 
the Accounts Receivable and Accounts Payable ledger accounts.
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Steps to Setting Up
Below is a checklist of the steps you should follow to set up a company 
with MultiLedger and the windows you’ll use. Some of the steps are 
optional and may not apply to your particular company setup. The rest 
of this chapter and Chapter 3, “Customer, Vendor & Item Setup” 
explain each step in detail.

Steps for Creating a New 
Company

MultiLedger Window

� Create a new Company

� Copy an existing chart of accounts 
from a MultiLedger sample company. 
(You can also enter a new chart of 
accounts, which would come later in 
the process.)

� Enter the company name and address. Company Information

� Select the Ending Date of Prior Year Company Information

� Enter/modify a chart of accounts Chart of Accounts

� Assign posting categories Interface Accounts

� Enter beginning ledger balances Account Balances

� Enter Customers Customer Setup

� Enter outstanding receivables prior to 
current fiscal year

Sales Journal

� Verify outstanding receivables setup Customer Reports

� Enter Vendors Vendor Setup

� Enter outstanding payables dated 
prior to current fiscal year

Payables Journal

� Verify outstanding payables setup Vendor Reports

� Setup inventory or service items Item Setup

� Verify beginning inventory Item Reports
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Creating a New Company File on Windows
1 Open MultiLedger by clicking the shortcut on your desktop.

2 Choose New Company from the File menu.

3 Enter a name for your company files.

The default location for your company files is the MultiLedger 
directory.

Important Use a short name, such as “ABC” instead of “American Business 
Company,” to identify your company files. The name is used only to 
identify your company’s data files - it does not appear on reports. A 
short name will be easier to find in a window on your desktop or in a 
dialog box than a long one.

You can easily rename your company files at any time. For more 
information, see “Renaming Company Files” on page 235.You should 
NEVER rename your files using any other method, as you may make 
your files inaccessible.

4 Click Save.
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A folder called “COAs” is installed in the “MultiLedger” folder. This 
folder contains several charts of accounts that you can modify for your 
own business. Appendix B, “Sample Charts of Accounts,” in this 
manual shows each of the sample charts of accounts.

5 Select Yes or No

If you want to create a new chart of accounts, click No. After you 
click no, MultiLedger’s Command Center appears on your screen with 
only the Company Information button enabled

All other Command Center buttons are disabled until you set up basic 
company information. The next section shows you how to do this.

If you want to copy an existing chart of accounts, click Yes.

Open the “COAs” folder, then select the chart of accounts you want to 
copy. You can also open the “SampleCo” folder, select the folder for 
the type of chart of accounts you want to copy, then select the chart of 
accounts.



18 Chapter 2 Initial Setup

6 Click open.

MultiLedger’s Command Center appears on your screen with only the 
Company Information button enabled.

All other Command Center buttons are disabled until you set up basic 
company information. For more information, see “Setting Up Basic 
Company Information” on page 20.

Creating a New Company File on Macintosh
1 Double-click the MultiLedger™ alias on the dock or desktop.

2 Choose New Company from the File menu.

3 Enter a name to identify your company, choose the location where you 
want to save your company files, and click save. It’s best to save this 
either on the Hard Drive or in the Documents folder. A new folder 
containing your company files will be created with the name you entered.

Important Use a short name for your company files, such as “ABC” instead of 
“American Business Company”. The name is used only to identify the 
folder that is created and the company’s data files saved in that folder. 
For example, entering the name “ABCf” would contain data files whose 
names begin with “ABC”. The “f” is automatically added to the folder 
name to identify it as a folder.

The name “ABC” does not appear on reports or cheques. You will set 
up the company name for reports and cheques in the company 
information window.

Note You can easily rename your company files at any time. For more 
information, see “Renaming Company Files” on page 235. You should 
never rename your own business. Appendix B, “Sample Charts of 
Accounts,” in this manual shows each of the sample charts of accounts.



Creating a New Company File on Macintosh 19

4 After the new company name has been entered, click Save.

A folder called “Sample COAs” is installed in the “MultiLedgerf” 
folder. This folder contains several charts of accounts that you can 
modify for your own business. Appendix B, “Sample Charts of 
Accounts,” in this manual shows each of the sample charts of accounts.

5 Select Yes or No.

If you want to create a new chart of accounts, click No and skip to 
Step 1 on the next page.

If you want to copy an existing chart of accounts, click Yes.

Open the “Sample COAs” Folder, Then select the chart of accounts 
you want to copy. Or you can also open the “ML Sample Companies” 
folder, select the folder for the type of chart of accounts you want to 
copy, then select the chart of accounts:
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Click Open.

MultiLedger’s Command Center appears on your screen with only the 
Company Information button enabled.

All other Command Center buttons are disabled until you set up basic 
company information. the next section shows you how to do this.

Setting Up Basic Company Information
When you first start a new company file in MultiLedger, only a few 
MultiLedger commands are available until you enter basic company 
information and select an Ending Date of Prior Year.

1 Click Company Information in the Command Center.
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2 Enter the company name that you want to appear at the top of reports 
and on cheques.

Note The company name and address also print on invoices and customer 
statements. For more details, see “Using the Print Screen” on page 90.

3 Enter the company’s address.

4 If the last date of your previous fiscal year differs from the date in the 
Ending Date of Prior Year field, enter the correct ending date.

The Ending Date of Prior Year should correspond to the end of your 
fiscal year.

If you are starting a new company, and don’t have an ending date for 
your company’s previous fiscal year, you should enter a date that 
corresponds to the year just prior to the year you wish to start tracking 
company data. For example, if your company is starting January 1, 
2017, you would enter 12/31/17 as the Ending Date of Prior Year.

Enter the date in the MM/DD/YY format.

Initially, the last date of the previous calendar year is entered (based on 
your computer’s system clock). You can override the date to match the 
ending of your company’s fiscal year.

Note The Company Information window also shows some basic 
information from your company files, such as number of general ledger 
accounts, customers, vendors, items, and salespeople.

Note The E-mail field is optional.

5 Close the window.

Important The Ending Date of Prior Year cannot be changed after saving. If you 
save the wrong dates, you must start over with a new company.

6 Click OK to save the company information, an Ending Date of Prior 
Year or Click Cancel to return to the Company Information Window.
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Setting Up the Chart of Accounts
The numbering and sequencing of a company’s accounts provides the 
foundation for the financial reports generated by MultiLedger. While 
you can add accounts as needed throughout the year, careful thought 
and planning should go into the initial design and numbering of your 
company’s chart of accounts.

Note Setting up income or expense accounts alphabetically with at least 10 
digits between numbers allows accounts to be easily searched and 
allows for insertion of additional accounts in alphabetic order.

Guidelines for Setting Up Accounts
Account numbers must meet the following requirements:

• Each account number (except for profit centers) must be four 
digits long.

• Each account number must adhere to the types of accounts shown 
below.

For example: all Asset must fall within the 1000-1999 range, all 
Liabilities must fall within the 2000-2999 range, and so on.

Note Certain headings and ranges can be changed for financial statements. 
For details, see “Customizing Financial Statements” on page 80.

Important: • Do not set up an account to accumulate income (or loss) for the 
current year. MultiLedger calculates the current year net income, 
but does not store it in a ledger account

Assets 1000-1999

Liabilities 2000-2999

Owner’s Equity or Capital 3000-3999

Income 4000-4999

Cost of Sales 5000-5999

Operating Expenses 6000-8999

Other Income 9000-9499

Other Expenses 9500-9999
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• Be sure to enter a retained earnings or accumulated owner’s equity 
account in the 3000-3999 range. Current year income (or loss) is 
closed into this account at year end.

• Enter only one Accounts Receivable account, one Accounts 
Payable account, and one Inventory account.

Entering the Accounts

Note If you are going to use profit centers, see “Setting Up Profit Centers in 
the Chart of Accounts” on page 75. For guidelines about entering profit 
centers into your chart of accounts.

1 Click Chart of Accounts in the Command Center.

2 Enter an account number in the left-hand edit box and press TAB.

Important Account numbers must meet certain requirements. For more 
information, to see the previous section see “Guidelines for Setting Up 
Accounts” on page 22.

If you want to produce
a Cash Flow

Statement, be sure to
assign the Cash Flow

Designations

Type an account
number in this box,

and press TAB

...then type in the
account name here,

then click Save

Create your account
numbers according to

these guidelines

Setup MICR to print on
blank cheque stock for
one or more accounts
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3 Enter the account description in the right-hand edit box

4 (optional) If you will be printing on blank cheque stock and need to 
setup MICR for your bank accounts, you can setup this information 
now. For more information on setting up MICR encoding see “Setting Up 
the MICR Encoding Information” on page 93.

5 If needed, click on then appropriate radio button for Cash Flow 
Designation.

See table below for details.

6 Click Save to add the new account to the list.

Repeat steps 2-6 for each account than you want to enter into the Chart 
of Accounts.

The accounts are saved when you close the Chart of Accounts 
window.

Setting Up Cash Flow Designations
MultiLedger defaults to the Cash Flow designations in the following 
chart to produce a Cash Flow Statement. You can change the default 
and assign the accounts to a different designation by clicking on the 
account in the list and clicking on the radio button for the Cash Flow 
designation that you want to assign the account to, then click Save.

Designation Default Account 
Range

Purpose

Cash 1000-1099 Cash balance at beginning and end of period

Operating 
Activity

1100-1899
2000-2599

Cash generated from day-to-day business 
operations.

Investing 
Activity

1900-1999 Cash invested in furniture, equipment or other 
long term assets.

Financing 
Activity

2600-3999 Includes loans, investments by the owner, and 
retained earnings. Also includes reductions in 
equity due to owners draws on profits.
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Modifying Account Numbers and Names
To modify an account, highlight the appropriate account line, modify 
the existing account description, and press ENTER. Account numbers 
cannot be modified, you must delete the entire account and then enter a 
new account number. If you try to change an account number, a new 
account will be added to the list but the old one will not be removed or 
changed. For information on re-numbering accounts see 
“Renumbering Accounts” on page 237.

Deleting Accounts
To delete an account, highlight the appropriate account line, and 
choose the Delete button. (If Delete is dimmed, an account is probably 
not highlighted. Select an account and try again).

If you try to delete an account that has transactions from the open 
months, the following warning appears:
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Setting Up Posting Categories

Category Descriptions
The following table describes the purpose of each category and the 
MultiLedger windows that use it.

Category Windows Purpose

Cash Account
Asset 1000-1999

Vendor Payments
Disbursements Journal

Customer Payments
Receipts Journal

Paying vendor and writing cheques decreases 
this account.

Making deposits from customer payments and 
cash receipts increases this account

Accounts Receivable
Asset 1000-1999
only one allowed

Customer Invoices
Sales Journal

Customer Payments

Invoices increase this account.

Customer payments decrease this account.

Accounts Payable
Liability 2000-2999

only one allowed

Item Purchases
Payables Journal

Vendor Payments

Buying inventory and entering payables 
increase this account.

Vendor payments decrease this account

Retained Earnings
Equity 3000-3999

Retained earnings, capital account, or owner’s 
equity. Income is closed into this account when 
the company’s fiscal year is closed.
Note: You must assign an account number to 
the Retained Earnings posting category.

Shipping Charged
Income 4000-4999

Customer Invoices If you charge customers shipping or freight on 
invoices, assign the appropriate account here

Shipping Paid
Cost of Sales 5000-

5999

Item Purchases If you separate shipping from the cost of 
inventory, assign the appropriate account for 
shipping paid to vendors.

Inventory
Asset 1000-1999
only one allowed

Item Purchases
Adjust Inventory

If you track inventory, assign the appropriate 
account for buying and selling inventory items. 
The calculated cost of sales will be subtracted 
from this account when the item is sold in 
Customer Invoices.

Sales Tax Paid
Cost of Sales 5000-

5999

Item Purchases If you separate sales tax from the cost of 
buying inventory, assign the appropriate 
account for sales tax paid to vendors here.
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Assigning Posting Categories
1 Click Interface Accounts in the Command Center.

The list on the left shows your company’s chart of accounts. The list on 
the right shows the posting categories.

Note Only one account number can be assigned to each posting category. 
However, you can use different Cash Accounts by selecting them from 
the pop-up list on the appropriate transaction window. The default 
account, however, will stay the same.

2 Select a ledger account from the list on the left.

First, click a ledger
account...

...then click a category name to
assign the account to the

appropriate posting category
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3 Click the appropriate posting category on the right

Repeat steps 2-3 for each posting category that you need to use. For 
details about each category, see the previous section, “Category 
Descriptions.”

You must assign account numbers to the Cash and Retained Earnings 
categories.

Important If a category is not assigned a number but it is used in transactions, 
MultiLedger posts the amount to the first account number (usually the 
cash account) from your chart accounts.

4 Close the window to save the categories

To remove an account from a posting category, click the category 
name without an account selected in the list on the left (To deselect an 
account simply click it again so that it’s no longer highlighted). You 
cannot remove an account from the Cash Account Category. However, 
you can re-assign it an account number.

To re-assign an account to a posting category, select a new account 
from the list on the left, and then click the category on the right.

Setting Up Ledger Account Balances
You don’t have to enter account balances before you begin transaction 
entry; however, to obtain a valid balance sheet you must enter the 
beginning balances for the accounting period you will be starting 
transaction entry in MultiLedger.

Note You can enter or adjust these balances at any time during the current 
year.

Important A retained earnings ledger account must have been assigned to a posting 
category (using the Interface Accounts window) before account 
balances can be saved.
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1 Click account Balances in the Command Center.

2 Enter the amount for the highlighted account balance from your trial 
balance or balance sheet report and press TAB.

Important The amounts you enter should be current balances as of the date - not 
monthly activity.

When you press TAB, the amount in the edit box above the list replaces 
the highlighted account balance in the list, and the next account 
balance in the list is highlighted for editing.

Enter beginning balances for each account using positive numbers to 
represent debits and negative numbers, (prefaced with a minus sign (-
)), to represent credits. Typically, liability, equity, and income 
accounts have credit balances (for example, -30719.60) while asset and 
expense accounts have debit balances (no minus sign).

After all the balances have been
entered, the Ledger Balance should

be 0.00
After checking that the Ledger

Balance is 0.00, click Save

Enter the
amount for the

account, and
press TAB

Credit balances
should be

prefaced with a
minus (-) sign
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Repeat step 2 for each account balance. You can scroll through the 
account balances using the scroll bar or tab key. You can also click an 
account balance to select it for editing. Be sure to TAB out of the last 
account you edit, or changes to that account will not be saved.

3 After all balances have been entered, check to see if the Ledger Balance 
amount (just above the balance edit box) is 0.00.

If the Ledger Balance is not 0.00, then your accounts are out of 
balance.

Why your Ledger
Balance might not be

0.00

• A common mistake is not putting a minus (-) sign before credit 
amounts.

• A current income account and value were entered. MultiLedger 
automatically calculates the current year net income for the 
income statement and balance sheet reports.

• You have not tabbed out of the last amount entered.

Note Since MultiLedger functions as a double-entry bookkeeping system, the 
Ledger Balance for each period should total 0.00. You can temporarily 
Save a ‘non-zero’ balance, but you should correct the balances as soon 
as possible to correctly reflect your company’s financial information. 
Once you correct the balances, the totals will be reflected in future 
month transactions.

4 Click Save.

Setting Up Prior Outstanding Receivables
Outstanding receivables that are dated prior to your current fiscal year 
are entered as invoices for each customer through the Sales Journal. 
Transactions entered with dates prior to your current fiscal year do not 
affect ledger balances.

Outstanding receivables that are dated within your current fiscal year 
should be entered as new transactions through the Customer Invoices 
or Sales Journal windows. For more details, see chapter 7, “Customer 
Transactions.”

The steps for entering prior outstanding receivables are as follows:

1 Set up Customer Terms. (See Chapter 3)

2 Enter names and information for customers with outstanding 
receivables on the Customer Setup window. (See Chapter 3)
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3 Enter all outstanding receivables for each customer in the Sales 
Journal.

4 Verify the outstanding receivables setup by checking balances on an 
Accounts Receivable report on the Customer Reports window.

The following sections explain steps 3 and 4.

Entering Outstanding Receivables
Once entered, outstanding receivables appear in Customer Payments.

Before your outstanding receivables you should have already set up 
customer terms and customer information.

The total for outstanding receivables invoices that you enter with a date 
prior to your current fiscal year should match the beginning balance 
you set up for the Accounts Receivable ledger account in Account 
Balances.

1 Click Sales Journal in the Command Center.

After the Sales Journal window opens, the cursor is in the Invoice # 
field.

Make sure you enter a date that
is prior to your Start Month
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Note For more details about the fields on the Sales Journal window, see 
“Sales Journal Field Descriptions” on page 143.

2 Enter or edit the invoice number.

Each invoice must have a document number associated with it. Invoice 
numbers can contain both letters and numbers, but must end in a 
number and are limited to eight characters. Invoice numbers are 
automatically increased by one after you save the transaction.

When the cursor enters the Customer field, a pop-up list of customers 
appears:

If the pop-up list doesn’t appear, customers have not yet been set up. 
To set up customers, see Chapter 3, “Customer, Vendor & Item Setup.”

3 Select a customer form the list and click OK (or double-click a 
customer name).

The customer name and address are entered in the Customer field, and 
the cursor moves to the Date field.

4 Enter original invoice date.

Enter the outstanding receivable’s invoice date using the format MM/
DD/YY. For example December 27, 2016, would be entered like this: 
12/27/16. Make sure you enter a date that is prior to your company’s 
current fiscal year. The invoice date along with the terms selected will 
determine the invoice’s due date.

Note You can enter dates in the DD/MM/YY format by selecting the 
“International Date Format [dd/mm/yy]” option on the Preferences 
Window under the File menu.

Customers
pop-up list

If you want to
search the list
by any part of
the customer
name, make

sure the “Find
Anywhere”

check box is
selected
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5 Enter a Statement Description.

Statement descriptions print on customer statements. You could enter a 
purchase order number or note here for reference. If you don’t enter a 
description, the customer name is automatically copied into this field 
when you save the transaction.

After you press TAB, the cursor moves to the Terms field. A pop-up list 
of terms appears:

If terms have not yet been set up, the cursor skips the Terms Field and 
moves to the Ledger Account field. To set up terms, see “Customer 
Terms” on page 50. If default terms were selected in the Customer 
setup window, those terms will be highlighted when this field is 
selected.

6 Select the desired term and click OK (or double-click the desired term) 
or click Cancel to not enter any terms.

Terms pop-up
list

If you want to
search the list
by any part of

the term
name, make

sure the “Find
Anywhere”

check box is
selected
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The cursor moves to the Ledger Account field, and a pop-up list of 
accounts appears:

7 Select a sales account from the list and click OK (or double-click the 
account name).

You can type the first few characters of the account number or name to 
automatically select the desired account.

Since transactions that are dated prior to your current fiscal year do not 
affect the General Ledger balances, the specific ledger account you 
choose really doesn’t matter. However, usually when you enter a 
transaction in the Sales Journal, you choose a sales account in the 
4000-4999 range.

After a ledger account is entered, the cursor moves to the Job field. 
Unless jobs have been set up already, the cursor skips the Job field and 
moves to the Description field. Even if you want to use jobs, you don’t 
need to set up any jobs until after your basic company setup is finished; 
a jobs report will not show any transactions dated prior to your current 
fiscal year.

8 Enter a description.

If you don’t enter a description, the customer’s name will 
automatically be copied to this field.

9 Enter the total amount of the prior outstanding invoice.

You don’t need to enter a dollar sign (&) or any zeros for .00 cents.

Ledger
Accounts

pop-up list
If you want to
search the list
by any part of

the account
number, make
sure the “Find

Anywhere”
check box is

selected
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10 Press TAB to add the line to the detail list.

Note You should enter the total for the outstanding invoice on one detail line.

11 Click Save

12 Click Yes.

After clicking Yes, the document is saved, and the invoice number is 
automatically increased by one.

13 Repeat steps 2-12 for each outstanding receivable.

After pressing TAB, the invoice
detail line is listed here.... ...and the Invoice Total is updated
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Verifying the Outstanding Receivables Setup
After entering all your outstanding receivables that are dated before 
your current fiscal year, you can use a Customers report to verify the 
setup.

1 Click Customer Reports in the Command Center.

2 Make sure Accounts Receivables is selected. 

Don’t select any customers from the customer list. When no customers 
are highlighted, all the customers with outstanding invoices will be 
reported.

Note If you have entered current year transactions, you should change the 
Cutoff Date to the prior year-end date. Otherwise, the Cutoff Date is not 
important.

All the customers
you set up are

shown here

Don’t worry about
the sorting options
or Cutoff Date for

this report

Click View or Print
to see the report
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3 Click View or Print.

After clicking View, a report window appears:

4 Verify that the total for the “Amount” column on the reports equals 
the “Accounts Receivable” balance listed on the report.

Note Customer reports are discussed in more detail in Chapter 10, 
“Customer, Vendor & Item Reports.”

What to do if your outstanding receivables 
don’t balance
Several reasons could cause your outstanding receivables not to 
balance with the Accounts Receivable ledger balance:

• An outstanding receivable was not entered.

Solution: Enter the outstanding receivable in the Sales Journal.

• The wrong amount was entered for an outstanding receivable.

Solution: Delete the incorrect outstanding receivable by following the 
steps below, and then enter the correct outstanding receivable in the 
Sales Journal.

The report total and the
Accounts Receivable
balance should agree

This is the amount that was
entered for the Accounts

Receivable balance on the

Report total
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Deleting an incorrect outstanding receivable entry

Important Deleting an outstanding receivable from Customer Payments in the 
following way will leave no record of the deletion. This procedure is 
used only to delete incorrect outstanding receivables that were entered 
with a date prior to your current fiscal year, and should not be used to 
delete outstanding receivables dated within or after your current fiscal 
year.

1 Click Customer Payments in the Command Center.

2 Select the Appropriate outstanding receivable from the list. 

3 Choose the Delete button.

4 Click Yes.

The outstanding receivable is deleted and removed from the list. Since 
the outstanding receivable did not affect any general ledger balances 
when it was entered (because it had a date that was prior to your 
company’s current fiscal year), it should not affect any general ledger 
balances when it is deleted.

• Accounts receivable had an incorrect starting balance.

Solution: Correct the accounts receivable balance by editing the 
amount on Account Balances.

Setting Up Outstanding Payables
Outstanding payables are those invoices that your company has not yet 
paid. Outstanding payables that are dated prior to your current fiscal 
year are entered as totals for each vendor in the Payables Journal. 
Transactions entered with dates prior to your current fiscal year do not 
affect ledger balances.

Outstanding payables that are dated within or after your current fiscal 
year should be entered as new transactions in Item Purchases or the 
Payables Journal windows. For more details, See Chapter 8, “Vendor 
Transactions.”
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The total for outstanding payables invoices that you enter with a date 
prior to your current fiscal year should match the beginning balance 
you set up for the Accounts Payable ledger account on Account 
Balances.

The steps for setting up outstanding payables are as follows:

1 Enter names and information for vendors with outstanding payables in 
Vendor Setup. (See Chapter 3)

2 Enter all the prior outstanding payables for each vendor in the 
Payables Journal.

3 Verify the outstanding payables setup by checking balances on an 
Accounts Payable report.

The following sections explains steps 2 and 3.

Entering Outstanding Payables
Once entered, prior outstanding payables appear in Vendor Payments.

Before entering your outstanding payables you should have already set 
up vendor information.

1 Click Payables Journal in the Command Center.

Make sure you enter a date
that is prior to your current

fiscal year
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When the Payables Journal window opens, the cursor is in the 
Document # field.

Note For more details about the fields on the Payables Journal window, see 
“Sales Journal Field Descriptions” on page 143.

2 Enter or edit the document number.

Each Payables Journal document must have a document number 
associated with it. Document numbers can contain both letters and 
numbers, but must end in a number and are limited to eight characters. 
Document numbers are automatically increased by one after you save 
the transaction.

When the cursor enters the Vendor field, a pop-up list of vendors 
appears:

If the pop-up list doesn’t appear, vendors have not yet been set up. To 
set up vendors, see Chapter 3, “Customer, Vendor & Item Setup.”

3 Select a vendor from the list and click OK (or double-click a vendor 
name).

The vendor name, address, and any terms are entered in the Vendor 
and Due Date fields, and the cursor moves to the Date field.

4 Enter the outstanding payable’s date.

Enter the outstanding payable’s date using the format 
MM/DD/YY. For example, December 5, 2015 would be entered like 
this: 12/5/15. Make sure you enter a date that is prior to your 
company’s current fiscal year.

Vendors
pop-up list

If you want to
search the list
by any part of

the Vendor
name, make

sure the “Find
Anywhere”

check box is
selected
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The initial due date for the payable is 30 days (as defined on the 
Preferences window under the File menu) after the document date 
unless other terms were set up for the vendor on the Vendor Setup 
window. To change the due or discount dates, click under the label 
“Due Date” and edit the values.

Note You can enter dates in the DD/MM/YY format by selecting the 
“International date format [dd/mm/yy]” option on the Preferences 
window under the File menu.

5 Enter a cheque stub description.

The description will print on a cheque stub. You could enter the 
vendor’s reference (invoice) number or note here for reference. If you 
don’t enter a description, the vendor’s name automatically copied into 
this field when our save the transaction.

After pressing TAB, the cursor moves to the Ledger Account field, and 
a pop-up list of accounts appears:

6 Select an expense account from the list and click OK (or double-click 
the account name).

You can type the first few characters of the account number or name to 
automatically select the desired account.

Since transactions that are dated prior to your current fiscal year do not 
affect General Ledger balances, the specific ledger account you choose 
really doesn’t matter. However, usually when you enter a transaction in 
the Payables Journal, you should choose an expense account in the 
6000-8999 range.

Ledger
Accounts

pop-up list
If you want to
search the list
by any part of

the account
number, make
sure the “Find

Anywhere”
check box is

selected
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After a ledger account is entered, the cursor moves to the Job Field. 
Unless jobs have been set up already, the cursor skips the Job field and 
moves to the Description field. Even if you want to use jobs, you don’t 
need to setup any jobs until after your basic company setup is finished; 
a jobs report will not show any outstanding transactions dated prior to 
your current fiscal year.

7 Enter a description.

If you don’t enter a description, the vendor’s name will automatically 
be copied to this field. Or you can set a Preference under the File 
menu to Use Cheque Stub Description in Payables Journal. For 
information on setting preferences see “Setting Program Preferences” 
on page 76.

8 Enter the amount of the prior outstanding payable.

You don’t need to enter a dollar ($) or any zeros for .00 cents.

9 Press TAB to add the line to the detail list.

10 Click Save.

11 Click Yes

After clicking Yes, the document is saved, and the document number is 
automatically increased by one.

Note For more detailed descriptions of the fields in the Payables Journal, see 
“Payables Journal Field Descriptions” on page 183.

After pressing TAB, the
invoice detail line is listed

here....

...and the Invoice Total is updated
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Verifying the Outstanding Payables Setup
After entering all your outstanding payables that are dated before your 
current fiscal year, you can use a Vendors report to verify the setup.

1 Click Vendor Reports in the Command Center.

2 Make sure Accounts Payable is selected.

Don’t select any vendors from the vendors list. When no vendors are 
highlighted, all the vendors with outstanding payables will be reported.

Note If you have entered current year transactions, you should change the 
Cutoff Date to the prior year-end date. Otherwise, the Cutoff Date is not 
important.

All the vendors you
set up are shown

here

Don’t worry about
the sorting options

or Cutoff date for
this report

Click View or Print
to see the report



44 Chapter 2 Initial Setup

3 Click View or Print.

After clicking View, a report window appears:

4 Verify that the total for the “Amount” column on the report equals the 
“Accounts Payable” balance listed on the report.

Note Vendor reports are discussed in more detail in Chapter 10, “Customer, 
Vendor & Item Reports.”

What to do if your outstanding payables 
don’t balance
Several reasons could cause your outstanding payables not to balance 
with the Accounts Payable ledger balance.

• An outstanding payable was not entered.

Solution: enter the out standing payable in the Payables Journal.

• The wrong amount was entered for an outstanding payable in 
the Payables Journal.

Solution: Delete the incorrect outstanding payable by following the 
steps below, and then enter the correct outstanding payable.

The report total and the
Accounts Payable balance

should agree

This is the amount that was
entered for the Accounts
Payable balance on the

Account Balances window

Report total
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Deleting an incorrect outstanding payable entry

Important Deleting an outstanding payable from Vendor Payments in the 
following way will leave no record of the deletion. This procedure is 
used only to delete incorrect outstanding payables that were entered 
with a date prior to your current fiscal year, and should not be used to 
delete outstanding payables dated within or after your current fiscal 
year.

1 Click Vendor Payments in the Command Center.

2 Select the appropriate outstanding payable from the list.

3 Choose the Delete button.

4 Click Yes.

The outstanding payable is deleted and removed from the list. Since 
the outstanding payable did not affect any general ledger balances 
when it was entered (because it had a date that was prior ti your 
company’s current fiscal year), it should not affect any general ledger 
balances when it is deleted.

• Accounts payable had an incorrect starting balance.

Solution: Correct the accounts payable balance by editing the amount 
on an Account Balances.

Setting Up Items
Items can be classified as inventory or non-inventory (for service 
sales). 

1 Enter the name and information for each inventory item by following 
the instructions see “Setting Up Items” on page 65.

2 Verify the items you set up by checking balances on an Inventory-
current report. 

Step 2 is explained in the following section.
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Verifying the Items Setup
After entering all your inventory items, you can use an Inventory- 
current report to verify the setup. The total On Hand Cost for all your 
items should equal the general ledger balance for the inventory 
account. the following procedure shows you how to check these 
values.

1 Click Item Reports in the Command Center.

2 Select Inventory-current radio button.

You do not need to select any inventory items from the items list. 
When no items are highlighted, all inventory items will be reported.

3 Click View or Print.

After clicking View, a report window appears:

The report total and the
Inventory balance should

agree

This is the amount that was
entered for the Inventory
balance on the Account

Balances window

Report total



Setting Up Items 47

4 Verify that the report total equals the “Inventory” balance listed.

These two amounts should agree.

Note Item reports are discussed in more detail in Chapter 10, “Customer, 
Vendor & Item Reports.”

What to do if your inventory doesn’t 
balance
The following are some reasons that could cause your inventory not to 
balance with the Inventory ledger balance:

• An incorrect starting inventory balance was entered.

Solution: Correct the inventory balance by editing the amount in 
Account Balances.

• Incorrect values were entered for an inventory item.

Solution: Double check the values entered for an item on Item Setup.
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Chapter 3
Customer, Vendor & Item Setup

This chapter discusses the following topics:

• Defining customer terms

• Setting up customers

• Setting up vendors

• Setting up items
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Customer Terms
Using customer terms is optional in MultiLedger. Customer terms 
determine how long a customer has until payment is due and whether 
they’ll receive a discount for early payment. If you don’t define 
customer terms for your company, an invoice’s due date will be the 
same as the invoice date. You can define up to twelve customer terms.

Customer Terms Field Descriptions
The following section describes the fields on Customer Terms.

Description Enter a name up to 13 characters long, including letters, numbers, and 
symbols.

Terms are usually named for the time period and any discounts that 
should apply. For example, “2/10 Net 30” means the invoice’s due date 
is 30 days after the invoice date, and that the customer will receive a 
2% discount if they pay within 10 days.

Days til Due Enter the number of days until the invoice is due. Days til Due 
determines the due date for invoices that use the term.

For example, if you enter 30 for Days til Due for a “2/10 Net 30” term, 
the due date for an invoice using “2/10 Net 30” and dated 3/7/17 would 
be 4/6/17.

Days til Due is also used to create aged accounts receivable reports and 
customer statements. The maximum number of Days til Due is 999.

Note If no value is entered in til Due, then the invoice date is used as the due 
date, regardless of the name of the term.
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Early Payment
Discount

Early Payment Discount determines the discount percentage the 
customer will receive if an invoice is paid within the specified discount 
period. The Early Payment Discount is applied automatically on 
Customer Payments if the customer pays within the discount period.

For example, if you enter 2 for the Early Payment Discount and an 
invoice using that term has a total of $1000.00 due, the discount would 
equal $20.

Enter a whole number, up to two digits, for the Early Payment 
Discount. The maximum Early Payment Discount is 99.

Early Payment Due
Days

Early Payment Due Days determines the number of days after the 
invoice date that an early payment discount applies. The discount date 
appears on Customer Payments.

Enter a whole number, up to two digits, for the Early Payment Due 
Days. The maximum Early Payment Due Days is 99.

Setting Up Customer Terms
1 Click Customer Terms in the Command Center.

The example below shows customer terms that are set up in the Retail 
Sample Company:

2 Enter a name for the term.

Note Enter your most common terms first so they appear in the Terms pop-
up list during transaction entry. The first term in the pop-up list is 
highlighted automatically unless the customer has been set up with 
Default Terms.
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3 Continue defining the term by filling in the appropriate fields.

See the section, “Customer Terms Field Descriptions,” earlier in this 
chapter for more information and tips.

4 Click Save. 

The prefix number and colon (:) are automatically entered when you 
click Save.

5 Repeat steps 2-4 for up to 12 customer terms.

Modifying Customer Terms

Important After modifying a term, any outstanding Customer Invoices or Sales 
Journal invoices using the old term have the new term’s name (If 
changed), but the Days til Due. Early Payment Discount, and Early 
Payment Due Days will not be changed unless the invoice is modified 
and resaved.

To edit or modify a term, select the term from the list, modify the 
information, and click Save.

Deleting Customer Terms
You cannot delete a single term from the list. You can, however, delete 
the entire list of terms.

To delete the entire list of terms, first select a term from the list. Then, 
while holding down the Ctrl key (Windows) or the COMMAND key (a) 
(Macintosh), click Save.

Important After deleting the list of terms, any existing Customer Invoices or Sales 
Journal invoices using the old term will have no term name, but the 
Days til Due, Early Payment Discount, and Early Payment Due Days 
will not change unless the invoice is modified and resaved.
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Customers

Customer Setup Field Descriptions
The following section describes the fields on Customer Setup.

Inactive Check this box to designate a customer as inactive, Inactive customers 
appear at the bottom of a customer list with a tilde (~) before their 
names.

Marking a customer as inactive is an alternative to immediately 
deleting a customer. You can still view reports for inactive customers, 
and you can make an inactive customer active again by unchecking the 
Inactive box. An Inactive customer, however, is not deleted when you 
close the year.

Delete when Close
Year

Marking the option “Delete when Close Year” leaves the customer as 
active, and as long as no outstanding invoices exist for the customer, 
that customer will be deleted when the year is closed.

Name Enter a name up to 36 characters long, including spaces.

Code You can use an optional code field to sort or classify customers. For 
details, see “Codes for Customers, Vendors, and Items” on page 100.

Contact Enter a contact name up to 30 characters long, including spaces.

Address Enter an address up to 30 characters long, including spaces.

City, Province,
Postal Code

Enter city, province, and postal code up to 30 characters long, 
including spaces.

Notes and Add’l Notes Enter any internal notes you may have for a customer, such as the 
preferred shipping method or an internal customer number. The Notes 
field and Add’l Notes field are each 30 characters long. The notes 
entered here appear in the Notes field in Customer Invoices and the 
Sales Journal, and on the Customer Information report.

There is a check box on Preferences under the File menu, that when 
checked, allows the Note and Add’l Notes you’ve set up for a customer 
to print on Sales Journal invoices. They do not, however, print on 
Customer Invoices or appear in the General Ledger.

Phone Enter a customer’s phone number up to 30 characters long, including 
spaces.

The information entered here appears on the Customer Information 
report.
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Fax Enter a customer’s fax number up to 30 characters long, including 
spaces.

This information appears on the Customer Information report.

E-mail Enter a customer’s E-mail address up to 30 characters long. When you 
click the button at the top of the window, it will take you to your E-
mail and automatically enter the E-mail address in this field.

If you have an E-mail address setup, you can E-mail a quote or invoice 
directly to your customer.

This information appears on the Customer Information report.

Website Enter either a customer’s website up to 30 characters long, including 
spaces. You must include the www. portion of the address. When you 
click the button at the top of the window, it will take you to the website 
listed in this field.

This information appears on the Customer Information report.

Terms When you click to the right of this label, a pop-up list of terms appears 
If the pop-up list does not appear, terms have not yet been set up.

The term entered here will be highlighted automatically in the pop-up 
list when you reach the Terms field in Customer Invoices or the Sales 
Journal.

Business # Enter a customer’s Business identification number up to 15 characters 
long, including spaces.

This number appears on the Customer Information report.

Salesperson When you click to the right of this label, a pop-up list of salespeople 
appears. If the pop-up list does not appear, salespeople have not yet 
been set up.

The salesperson entered here will be highlighted automatically in the 
pop-up list when you reach the Salesperson field in Customer Invoices.

Credit Limit Enter the credit limit for a customer. Enter a whole number, with no 
decimal points. If you exceed the credit limit when you save a 
Customer Invoice or Sales Journal invoice, an alert appears.

Enter the credit limit as a whole number up to nine digits long.

Sales Tax1 When you click to the right of this label, a pop-up list of sales tax 
categories appears. If the pop-up list does not appear, sales tax 
categories have not yet been set up.

The sales tax entered here will be highlighted automatically in the pop-
up list when you reach the first Sales Tax field in Customer Invoices.
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Sales Tax 2 When you click to the right of this label, a pop-up list of sales tax 
categories appears. If the pop-up list does not appear, sales tax 
categories have not yet been set up.

The sales tax entered here will be highlighted automatically in the pop-
up list when you reach the second Sales Tax field in Customer 
Invoices, unless you have the Skip Tax 2 During Invoice Entry box 
checked on the Preferences window under the File menu. You could 
use the default Sales Tax 1 and Sales Tax 2 fields to keep track of the 
different sales tax categories for a customer. For example, you could 
designate Sales Tax 1 as the customer’s provincial tax and Sales Tax 2 
as the customer’s harmonized sales tax. That way, the correct sales tax 
categories will be selected automatically when you reach the Sales Tax 
fields on a Customer Invoice.

Sales Discount % The Unit Price on items sold to a customer on Customer Invoices will 
be reduced by the percentage entered here.

The maximum Sales Discount % is 99.99.

Sales Account When you click to the right of this label, a pop-up list of your chart of 
accounts appears. Select the account to associate with the customer and 
click OK. When the customer is selected in the Sales Journal, the 
account will be automatically highlighted in the Ledger Account pop-
up list.

To remove the default account, click to the right of the label to open 
the pop-up list and click Cancel.

Pricing Level Click the appropriate radio button to assign the correct pricing level for 
items for your customers. Pricing levels 1, 2, and 3 refer to the prices 
you set up for your items on Item Setup. If you do not assign a pricing 
level to a customer, Selling Price 1 will be selected automatically for 
items on Customer Invoices.
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Setting Up Customers
1 Click Customer Setup in the Command Center.

2 Enter a customer Name

Note You can use an optional code field to sort or classify customers. For 
details, see “Codes for Customers, Vendors, and Items” on page 100.

3 Enter a contact name and customer’s address.

4 Enter any other relevant customer information.

See “Customer Setup Field Descriptions” on page 53 for more 
information and tips.

5 Click Save.

The customer name is added to the list on the right.

Notes entered here
appear on Customer

Invoices and Sales
Journal windows

Default selections
made here save time

during transaction
entry

If you attempt to save an invoice that
exceeds the credit limit entered here, a

warning appears.
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Modifying Customer Information
To modify existing customer information, first select the customer 
name from the list. Then modify the relevant customer information. Be 
sure to click Save after modifying any information, or your changes 
will be lost.

Deleting a Customer
You can delete a customer as long as the customer is not associated 
with any transactions in the open months. First, select the customer 
from the list, then click the Delete button.

If you try to delete a customer that is associated with transactions in the 
open months, the following message appears:

Important Because of restrictions with the multi-user capabilities of MultiLedger, 
you must be the only user accessing the company files to delete a 
customer.

Note As an alternative to deleting a customer, you can mark a customer as 
inactive by checking the “Inactive” box or selecting “Delete when 
Close Year on Customer Setup see “Customer Setup Field 
Descriptions” on page 53.

Vendors

Vendor Setup Field Descriptions
The following section describes the fields on Vendor Setup.

Inactive Check this box to designate a vendor as inactive. Inactive vendors 
appear at the bottom of a vendor list with a tilde (~) before their names.

Marking a vendor as inactive is an alternative to deleting a vendor. You 
can still view reports for inactive vendors, and you can make an 
inactive vendor active again by unchecking the Inactive box. An 
Inactive vendor is not deleted when you close the year.
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Delete when Close
Year

Marking the option “Delete when Closing Year” leaves the vendor as 
active, and as long as no outstanding invoices exist for the vendor, that 
vendor will be deleted when the year is closed.

Name Enter a vendor name up to 36 characters long, including spaces.

Code You can use an optional code field to sort or classify customers. For 
details, see “Codes for Customers, Vendors, and Items” on page 100.

Contact Enter a contact name up to 30 characters long, including spaces.

Address Enter an address up to 30 characters long, including spaces.

City, Province,
Postal Code

Enter the city, province, and posta code up to 30 characters long, 
including spaces.

Notes/Ref# Enter any notes you may have for a vendor up to 30 character long, 
including spaces.

The notes entered here appear on Item Purchases and the Payables 
Journal, and on the Vendor Information report. They also print on 
cheques. They do not, however, print on Item Purchases or Purchase 
Orders or appear in the General Ledger.

Add’l Notes Enter any internal notes you may have for a vendor up to 30 characters 
long, including spaces.

The notes entered here appear on Item Purchases and the Payables 
Journal, and on the Vendor Information report. They do not, however, 
print on Item Purchases, cheques, or Purchase Orders, or appear in the 
General Ledger.

Phone Enter a phone number up to 30 characters long, including spaces.

This information appears on the Vendor Information report.

Fax Enter a vendor’s fax number up to 30 characters long, including 
spaces. 

This information appears on the Vendor Information report.

E-mail Enter a vendor’s E-mail address up to 30 characters long, including 
spaces. When you click the button at the top of the window, it will take 
you to your E-mail and automatically enter the E-mail address in this 
field. 

If you have an E-mail address setup, you can E-mail an item purchase 
invoice or purchase order directly to your vendor.

This information appears on the Vendor Information report.

Website Enter a vendor’s website up to 30 characters long. you must include the 
www. portion of the address. When you click the button at the top of 
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the window, it will take you to the website listed in this field.

This information appears on the Vendor Information report.

Business # Enter a vendor’s Business ID number up to 15 characters, including 
spaces.

Default Account When you click to the right of this label, a pop-up list of your chart of 
accounts appears. Select the account to associate with the vendor and 
click OK. When the vendor is selected in the Payables Journal or 
Disbursements Journal, the account will be automatically highlighted 
in the Ledger Account pop-up list.

To remove the default account, click to the right of the label to open the 
pop-up list and click Cancel.

Default Amount Enter an amount (such as for rent) that would automatically be entered 
when the vendor is selected in the Payables Journal or Disbursements 
Journal.

The Default Amount can be up to six places to the left and two places 
to the right of the decimal point (999999.99).
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Due Days/Day of
Month

You can assign terms to a vendor, such as days until due, discount %, 
or the number of discount days you’re given by the vendor.

If Day of Month is checked, the due date is the same day of each 
month. For example, if you enter 15 in the edit box, the due date will 
always be the 15th day of the month. The maximum number of Due 
Days is 31 if Day of Month is checked.

If Day of Month is not checked, the due date is the number of days 
after the invoice date. For example, if you enter 15 in the edit box, the 
due date would be fifteen days after the invoice date. The maximum 
number of Due Days is 240 if the Day of Month is not checked.

Initially, when you set up a new vendor, Due Days is 30, which is 
based on the value entered for Default Vendor Due Days in Preferences 
under the File menu and Day of Month is not checked, if you don’t 
have a value in Due Days, MultiLedger uses the invoice date as the due 
date and as the aging date for payables.

If you change a vendor’s default settings on Vendor Setup, it will not 
change any outstanding payables for that vendor. Also, vendor terms 
(due dates) can be changed for individual Item Purchases or Payables 
Journal transactions on the transaction window.

Discount % Enter the percentage, if any, by which this vendor discounts your 
purchases for an early payment. If you process the payable before the 
discount date has passed, the discount will be applied automatically on 
Vendor Payments.

The maximum Discount % is 99.99.

Discount Days Discount Days determines the number of days after the invoice date 
that an early payment discount applies.

The maximum number of discount days is 99.

Credit Limit Enter the credit limit extended to you from a vendor. Enter a whole 
number, with no decimal points. If you exceed the credit limit when 
you save an Item Purchase or Payables Journal Transaction, an alert 
appears. Enter the credit Limit as a whole number up to nine digits 
long.



Vendors 61

Setting Up Vendors
1 Click Vendor Setup in the Command Center.

2 Enter a Vendor name.

Note You can use an optional code field to sort or classify vendors. For 
details, see “Codes for Customers, Vendors, and Items” on page 100.

Check this box to mark a
vendor as Inactive, but

retain in list

Check this box to mark a
vendor to be deleted

when the year is closed

Default selections made
here save time during

transaction entry

If you attempt to save an
invoice that exceeds the credit

limit entered here, a warning
appears

Notes entered here
appear on Item
Purchases and

Payables Journal
windows, but do not

print on checks

Notes entered here
appear on Item
Purchases and

Payables Journal
windows, and print on

checks
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3 Enter a contact name and the vendor’s address.

4 Enter any other relevant vendor information.

See “Vendor Setup Field Descriptions” on page 57 for more 
information and tips.

5 Click Save.

The vendor name is added to the list on the right.

Modifying Vendor Information
To modify existing vendor information, first select the vendor name 
from the list. Then modify the relevant vendor information. Be sure to 
click Save after modifying any information, or your changes will be 
lost. 

Deleting a Vendor
You can delete a vendor as long as the vendor is not associated with 
any transactions in the open months. First, select the vendor from the 
list, then click the Delete button.

If you try to delete a vendor that is associated with transactions in the 
open months, the following message appears:

Important Because of restrictions with the multi-user capabilities of MultiLedger, 
you must be the only user accessing the company files to delete a 
vendor.

Note As an alternative to deleting a vendor, you can mark a vendor as inactive 
by checking the “Inactive” box or mark “Delete when Close Year” on 
the vendor setup window, see “Vendor Setup Field Descriptions” on 
page 57.
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Items

Item Setup Field Descriptions
The following section describes the fields on Item Setup.

Name Enter the item name up to 36 characters long, including spaces.

Code You can use an optional code field to sort or classify items. For details, 
see “Codes for Customers, Vendors, and Items” on page 100.

Selling Price 1, Selling
Price 2, Selling Price 3

Each item you set up can have three different pricing levels. Assigning 
multiple pricing levels is a two-step process. First, you set up the 
different pricing levels is a two-step process. First, you set up the 
different pricing levels for items, then you assign the correct pricing 
level to your customers. Assigning pricing levels to customers is 
discussed earlier in this chapter.

For example, you could set up the retail and wholesales prices for your 
items as Selling Price1 and Selling Price 2. Then, you could set up 
your retail customers with Selling Price 1 as their default, and your 
wholesale customers with Selling Price 2 as their default. That way 
you can be sure that you charge the right price to your different types 
of customers when you create an invoice.

If you don’t assign default prices to your customers, Selling Price 1 
will be entered automatically during invoice entry. You can change the 
selling price during invoice entry.

If the item’s selling price is in whole dollars (such as $145), you don’t 
need to enter a decimal point and “00” cents.

Qty on Hand The item’s quantity on hand is increased when you buy the item in 
Item Purchases and reduced when you sell the item in Customer 
Invoices.

Important Any changes made to values on Item Shop do not affect account 
balances in the General Ledger. To change Qty on Hand value for an 
item and adjust the General Ledger balances, use Adjust Inventory. For 
more details, see “Adjust Inventory Window” on page 216. For Items 
that are non-inventory, such as labor or consulting, do not enter values 
for Qty on Hand, Last Unit Cost, or Total Cost, and do not check the 
Inventory Item check box.

Total Cost Enter the total cost for the inventory items on hand. MultiLedger 
divides the value entered in Total Cost by the Qty on Hand to reach.
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Avg Unit Cost When an inventory item is bought in Item Purchases, the Qty on Hand 
and Avg Unit Cost of the item are adjusted to reflect new items added 
to those on hand. The weighted-average inventory pricing method is 
used to calculate the new Avg Unit Cost. The cost of each unit is added 
together, and then the total cost is divided by the total number of units 
to determine the new Avg Unit Cost. This means that the Avg Unit 
Cost of newly purchased inventory items affects the Avg Unit Cost of 
the old inventory.

Last Unit Cost This reflects the last cost paid for an item when it was purchased 
through the Item Purchases window.

If you are setting up a new item on Item Setup and do not assign a Last 
Unit Coast, MultiLedger will use the Avg Unit Cost as the Last Unit 
Cost.

Reorder Quantity When you setup a Reorder Quantity for an item, that quantity will 
automatically fill the quantity field on an Item Purchase when the item 
is selected. This will also show on the Current Inventory report when 
the ‘Qty Only’ checkbox is selected.

Minimum on Hand When you enter a minimum quantity on hand in this field, it will show 
on the Current Inventory report when the ‘Qty Only’ checkbox is 
selected.

Sales Income Acct When you click in this box, a pop-up list of your chart of accounts 
appears. From the list of your chart of accounts, select a Sales Account 
(in the 4000-4999 range) to associate with the item. When the item is 
sold, the cost account associated with that item is automatically 
increased, and the inventory account you’ve selected on Interface 
Accounts is decreased.

Cost/Expense Acct When you click in this box, a pop-up list of your chart of accounts 
appears. From the list of your chart of accounts, select a Cost Account 
(usually in the 5000–5999 range) to associate with the item. When the 
item is sold, the cost account associated with that item is automatically 
increased, and the inventory account you’ve selected on Interface 
Accounts is decreased.

Taxable Rate 1 If checked, the sales tax category and corresponding rate that is entered 
in the first Sales Tax box on Customer Invoices will be calculated for 
the item.

This box is automatically checked for new items. If the item is non-
taxable, you should uncheck the box

Taxable Rate 2 If checked, the sales tax category and corresponding rate that is entered 
in the second Sales Tax box on Customer Invoices will be calculated 
for the item.

This box is automatically checked for new items. If the item is non-
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taxable, you should uncheck the box.

Commissionable If checked, a sales commission for the salesperson selected on 
Customer Invoices will be calculated on the item.

This box is automatically checked for new items. If the item is non-
commissionable, you should uncheck the box.

Inventory Item When this box is checked, the item is costed automatically when the 
item is sold on Customer Invoices, and Qty on Hand is increased or 
reduced when the item is bought or sold.

This box is automatically checked for new items. If the item is a non-
inventory item, such as consulting or labor, you should uncheck the 
box.

Important If an item is marked as an inventory item, an alert appears in Customer 
Invoices if you try to sell more of the item than you have on hand. If an 
item is a non-inventory item, be sure to uncheck the Inventory check 
box when you’re setting up the item to avoid this alert.

Inactive Check this box to designate an item as inactive. Inactive items appear 
at the bottom of an item list with a tilde(~) before their names.

Marking an item as inactive is an alternative to deleting an item. You 
can still view reports for inactive items, and you can make an inactive 
item active again by unchecking the Inactive box. An inactive item, 
however, is deleted when you close the year, as long as there are no 
outstanding transactions associated with that item.

Setting Up Items
There are two ways to set up items in MultiLedger:

• You can set up a new item while you are entering an Item 
Purchase, provided there is at least one other item set up already. 
When you reach the Items pop-up list on Item Purchases, click 
New. you can then set up information for the item. If you set up an 
item using this method, you do not have to enter values for Qty on 
Hand, Total Cost, or Last Unit Cost, because they will be entered 
automatically when you save the Item Purchase.

• You can set up a new Item Setup. Setting up a new item in this 
manner is described below.
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Entering New Items
1 Click Item Setup in the Command Center

2 Enter the item’s name and press TAB.

Note You can use an optional code field to sort or classify items. For details, 
see “Codes for Customers, Vendors, and Items” on page 100.

3 Enter any other relevant item information.

See “Item Setup Field Descriptions” on page 63 for more information 
and tips.

4 Click Save.

The item name is added to the list on the right.

Each item can have up to
three different selling

prices

These fields are updated
when you buy items in

Item Purchases

Choose a sales account
and a cost of sales

account for each item

Use these checkboxes to define options for an item
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Modifying Item Information
To modify existing item information, first select the item name from 
the list, then modify the relevant item information, or your changes 
will be lost.

Important Any changes made to values on the Items window do not affect account 
balances in the General Ledger. To change the Qty on Hand value for an 
item and adjust the General Ledger balances, use Adjust Inventory. For 
more details, see “Adjust Inventory Window” on page 216.

Deleting Items
You can delete items provided no outstanding invoices associated with 
the item exist.

1 Click Item Setup in the Command Center.

2 Select the item from the list.

3 Click the Delete button.

Important After deleting an item, you can no longer obtain any reports for that 
item.

If you try to delete an Item that has outstanding invoices, the following 
message appears:

Important Because of restrictions with the multi-user capabilities of MultiLedger, 
you must be the only user accessing the company files to delete an item.

As an alternative to deleting an item you can mark an item as inactive 
by checking the Inactive box on the item setup window. See see “Item 
Setup Field Descriptions” on page 63.
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Chapter 4
Setup Options
This chapter shows you how to set up various options in MultiLedger. 
The following topics are discussed in detail in this chapter:

• Setting up budgets

• Defining shipping methods

• Using profit centers

• Setting up jobs

• Utilizing sales tax categories

• Setting up salespeople

• Customizing financial statements and formatting fields for 
printing cheques, invoices, customer statements, etc.

• Setting up company preferences and user settings

• Using the Print command

• Setting up MICR Encoding Information

• Setting up codes for customers, vendors, and items.
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Setting Up Budget Amounts
You can set up and edit monthly budget amounts for income and 
expense accounts (account numbers 4000 and greater) for all open 
months.

Note To see budget amounts in a report format, click Income Statement in the 
Command Center, click the Budget Report option or the Income vs. 
Budget option, select a month or range of months, then click View or 
Print.

You can also import or export budget amounts. For more details, see 
“Importing and Exporting Data” on page 222..

1 Click Budget Amounts in the Command Center.

All budget amounts are initially set to 0.00.

2 Select the fiscal year you want from the pull-down menu.

The default selection is the first open year.

You can set up budgets
for accounts 4000 and

higher
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3 Select the appropriate income or expense account from the list on the 
left.

4 Enter the budget amount in the edit box for each month on the right 
and press TAB.

You can also use the down arrow keys on your keyboard to move sown 
to another amount or click any amount to edit it.

To copy the amount in the edit box to all months, click the annualize 
button. After you click, Annualize, you can still modify any month’s 
amount before saving. As you enter budget amounts for the account, 
the total for the year is shown at the bottom of the budget amounts:

5 Click Save after editing the budget amounts for each account.

Be sure to click Save before selecting another account, or else your 
changes will be lost.

The total for the year
is shown here
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Setting Up Shipping Methods
You can set up a list of common shipping methods that will appear as a 
pop-up list on Customer Invoices.

1 Click Ship Via in the Command Center.

2 Enter a name for the Ship Via method in the edit box, then click Save.

The name of the methods appears in the list above. You can set up an 
unlimited number of Ship Via methods.

Note All Ship Via methods appear in alphabetical order regardless of the 
order in which they were entered.

Modifying a Ship Via Method
First, select method from the list. Then, modify the name, and click 
Save.

Deleting a Ship Via Method
First, select the method from the list, then click Delete.

You can set up an
unlimited number of

shipping methods.

Methods appear in
alphabetical order
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Setting Up Profit Centers
If your company has several departments or divisions, you might want 
to individually track their income and expenses - that’s where profit 
centers come in. Each portion of your company (whether it’s a 
department, store, or division) can be assigned a profit center name and 
account numbers.

You can create income statements for your profit centers. For details, 
see “Profit Center Income Statements” on page 290.

To set up profit centers, you need to complete two steps:

• Enter the general profit center names on the Profit Centers 
window under the Setup menu. Profit center names must be 
entered to produce an income statement report for a particular 
profit center.

• Enter specific profit center account numbers and names in your 
company’s chart of accounts.

These two steps are discussed in the following sections.
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Setting Up Profit Centers on the Profit 
Centers Window

1 Choose Profit Centers from the Setup menu.

2 Enter a number for the profit center that is between 1 and 99.

Note Leading zeros for single-digit profit centers are automatically added for 
you.

3 Enter a name for the profit center and press TAB.

4 Click Save.

Repeat this step for up to 99 profit centers. 

Don’t forget to set up the profit centers in your chart of accounts too.

You can have up to
99 Profit Centers for

a company
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Setting Up Profit Centers in the Chart of 
Accounts
You should set up a general account followed by specific profit center 
accounts. For example, you could have a general sales account such as 
the following: 

4000 Sales

You could the use the following profit centers for two stores:

4000.01 Sales - Store 1

4000.02 Sales - Store 2

Notice that each profit center account you enter into your chart of 
accounts has a four digit number followed by a decimal point and the 
appropriate profit center number (01-99). These profit center numbers 
correspond to those set up on the Profit Centers window.

When you create a consolidated income statement, the general account 
“4000 Sales” will be used for the consolidated description. If no 4000 
account has been set up in the chart of accounts, the first profit center 
account description will be used for the consolidated description.

You should follow the same procedure for entering profit center 
accounts into your chart of accounts as you do for entering any other 
account. For details, see “Setting Up the Chart of Accounts” on 
page 22.

What accounts can I set up as profit 
centers?
You can set up profit centers in your chart of accounts for any type of 
account from 4000 and greater including income accounts (such as 
sales) and operating expense accounts (such as advertising).

You cannot set up profit centers for asset (such as inventory, in the 
1000-1999 range), liability (in the 2000 range), or equity accounts (in 
the 3000 range)
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Setting Program Preferences
In MultiLedger you can set both program Preferences and User 
Settings Options set on Preferences apply to all users in a particular set 
of company files. Options set on User Settings, on the other hand, 
apply to each individual user. For more information on User Settings, 
see the next section, “Setting User Settings”

You can use Preferences under the File menu to set various 
MultiLedger options, such as checking for duplicate documents or 
hiding the cash balance on transaction windows.

After choosing Preferences from the File menu, the following window 
appears:

Select each option according to the following guidelines

Check for Duplicate
Documents

If checked, a warning appears when you try to save a document 
number that’s already been used in that journal window. MultiLedger 
looks for duplicate document numbers in the current month, the 
previous month and the future month, all based on the transaction date, 
when this option is checked. This box is automatically checked for new 
companies.

Please note that some journal windows use the same numbering 
system. See “Document Numbers” on page 115 for more details.

Include Tax 1 in Tax 2
Computation (GST)

If checked, Tax 2 calculates a percentage of Tax 1. This accomodates 
the Canadian GST.
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Skip Tax 2 During
Invoice Entry

If Checked, the second Sales Tax field is skipped on Customer Invoices. 
This box is automatically checked for new companies.

Remove Item Code
Field on Invoice

This option will remove the item codes when printing invoices.

Internatioanl Date
Format (dd/mm/yy)

If checked, dates can be entered in the international day/month/year 
format instead of month/day/year format.

Show Code Field on
Reports

If this option is checked at the time you select a report to be viewed or 
printed, the code set up for the Customer, Item, or Vendor will appear. 
This affects most reports printed or viewed from the Customer Reports, 
Vendor Reports, and Item Reports, except mailing labels for customers 
and vendors and Customer Statements.

Hide Unit Cost in
Customer Invoice

If checked, the Unit Cost field for items doesn’t show on Customer 
Invoices.

Print Customer Notes
on Sales Journal

If checked, the Notes and Add’l Notes you’ve set up for a customer print 
on Sales Journal invoices.

Use Cheque Stub
Description in

Payables Journal

If checked, information entered in the Cheque Stub Description field on 
the payables journal will automatically be copied into the Description 
field on the next line

Hide Cash Balance If checked, the cash balance is replaced by asterisks (***) on Customer 
Payments, Vendor Payments, Receipts Journal, and Disbursements 
Journal. This is helpful if you want them to allow users to enter 
transactions in these journals, but do not want them to see the balance 
in the cash account.

Print Cheque Dates in
CPA Format (YYYY)

CPA stands for Canadian Payments Association. Mark this option if 
you are in Canada and must print cheques in accordance to the 
regulations that the CPA sets. See the Canadian Payments Association’s 
website at www.cdnpay.ca for more information.

Item Purchase/PO Tax
Label

You can use thisfield to change the shipping amount label that prints on 
invoices. “Shipping” is automatically assigned. If you are using 
preprinted invoices that already have this label printed in them, you can 
remove this text.

Currency Symbol You can use this field to change from the dollar currency symbol ($) to 
another currency symbol such as £ on cheques. Please note that this 
option simply changes the symbol that appears on cheques, invoices and 
customer statments; it does not convert any currency values.

Default Vendor Due
Days

You can use this field to change the number of due days assigned to new 
vendors. Thirty days is assigned by default.
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Mailing Label Options
Label Left Enter the number of inches from the left hand page edge.

Label Top Enter the number of inches from the top of the page edge.

Label Height Enter the height of each label in inches.

Label Width Enter the width of each label in inches

Across Enter how many labels are across the label sheet

Repeat Factor Enter how many mailing labels should be printed for each selected 
customer or vendor. For example, a Repeat Factor of “3” will cause 
three mailing labels to be printed for each selected customer or vendor.

Note Enter inches to (.01) hundreths of an inch.

Setting User Settings
In MultiLedger you can set both program Preferences and User 
Settings. Options set on Preferences apply to all users in a particular set 
of company files. Options set on User Settings, on the other hand, apply 
to each individual user. For more information on Preferences, see the 
previous section, “Setting Program Preferences.”

You can use User Settings under the File menu to set various 
MultiLedger options, such as automatically launching the last opened 
company and automatically showing scheduled recurring entries when 
you open a company. After choosing User Settings from the File menu, 
the following window appears:
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Select each option according to the following guidelines:

Open Last Company
on Launch

If checked, the last set of company files that was used will open 
automatically when you launch MultiLedger. If you want to open 
another set of company files, simply choose Close Company from the 
File menu, then choose Open Company from the File menu and select a 
set of company files using the dialog box that appears. Or choose Open 
Recent Company and select a company from the list.

Prompt If No Backup
in This Many Days

If checked, MultiLedger will ask you to make a backup of your 
company files when you attempt to close the company or Exit/Quit 
MultiLedger. Enter the number of days you want between backups in 
the edit box.

After the number of days you enter has passed, you will be asked 
whether you want to make a backup of your company files when you 
close the company or Exit MultiLedger. If you click Yes on the alert, a 
Save As dialog appears. You should follow the instructions in Chapter 
12, “Backing Up & Restoring” to make a backup of your company files. 
If you click No on the alert, no backup is made and the company files 
close or MultiLedger quits as normal.

If the “Prompt If No Backup In # Days” check box is checked and you 
enter zero (0) or leave the edit box blank, you will be alerted to make a 
backup every time you close the company or quit MultiLedger.

Show Scheduled
Recurring Entries

If checked, the Schedules Recurring Entries window will appear each 
time you open a set of company files that has recurring entries due. For 
more information on entering and using scheduled recurring entries, see 
“Recurring Entries” on page 124.

Use <Enter> Key to
Move Between Edit

Fields

PC only, if checked, you can use your <Enter> key to go from field to 
field. Otherwise, you must use the <Tab> key.

Sort Customers by
Name

If codes are setup for customers, all lists will sort by the code as the 
default. To change it to sort by Customer name, this preference must be 
checked.

Sort Vendors by Name If codes are setup for vendors, all lists will sort by the code as the 
default. To change it to sort by Vendor name, this preference must be 
checked.

Sort Items by Name If codes are setup for items, all lists will sort by the code as the default. 
To change it to sort by Item name, this preference must be checked.

Save Window
Placement

When checked, if you resize or reposition a window within the 
MultiLedger program, the new sizes and positions are saved.
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Check for Latest
Version on Launch

An internet connection is required. When checked, MultiLedger will 
determine if any patches or updates are available when you open the 
program.

Note When you mark a checkbox to change the sort, the change will take 
effect when the company is re-opened.

Customizing Financial Statements
You can customize the account headings that appear on your balance 
sheet and income statement. You can also group accounts so they will 
appear as one line summaries on financial statements.

1 Click Financial Statements in the Command Center.

Note Balance Sheet and Income Statement titles and footers can be changed 
in the Report window. To customize the headings, ranges, and account 
groupings, see the following sections.
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Customizing Heading Descriptions
1 Click the Heading Description you want to modify.

2 Edit the highlighted Heading Description in the edit box.

3 Click Save. 

Repeat the steps above for all Heading Descriptions you want to 
change. You may need to use the Vertical scroll bar to see the complete 
list of modifiable Heading Descriptions.

Customizing Heading Ranges
Each heading has an associated account number range made up of a 
lower and upper limit. This range determines the account numbers for 
the heading description. For example, the heading “Current Assets” 
has a range from a lower limit of 1000 to an upper limit of 1599.

1 Click the range that you want to modify.

You can change the upper limit only of the following range:

1000-1599 Current Assets

1700–1899 Fixed Assets

2000–2599 Current Liabilities

2 Click in the edit box, then change the upper limit for the range.

3 Click Save.

The lower limit of the next range in the list will automatically be 
adjusted.

Repeat the steps above for all of the ranges that you want to change.

Customizing Account Groupings
You can group accounts to appear as one line summaries on balance 
sheets and income statements. After grouping accounts for a financial 
report, you can still see the individual accounts that make up the one 
line summary by selecting the Show Detail Accounts option on the 
Income Statement or Balance Sheet Reports. Accounts must be 
consecutive and cannot be part of more than one grouping, nor can a 
group span more than one heading.

1 Click in the edit box on the far left above Description.

2 Type in the first account number for the grouping, then press TAB.

3 Type in the last account number for the grouping, then press TAB.

4 Type in the description for the grouping, then click Save.
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Modifying or Deleting Custom Account 
Groupings

1 Click the Group Description so that it appears in the edit box.

2 Modify the Range and/or the Group Description in the edit box, or 
click Delete to remove it.

Jobs Set Up
You can use MultiLedger to set up jobs or projects and track their 
income and expenses. You can have up to 9999 jobs. 

Note You can also use Profit Centers to keep track of different jobs or 
projects. For more information on using Profit Centers, see “Setting Up 
Profit Centers” on page 73.

For details about creating job reports, see “Job Reports” on page 303.

Job Setup Field Descriptions
This section discusses the individual fields on Job Setup.

Job # You can enter up to 9999 jobs. You don’t have to enter leading zeros.

Completed Check this box when a job is complete. Completed jobs are deleted 
when you close the year.

Name Enter a job name up to 30 characters long, including spaces.

Est. Income Enter how much income you expect this project to earn. The amount 
entered here appears on the Job Summary report, so you can compare 
estimated income to actual income for a job.

Est. Expense Enter how much you expect this project to cost. The amount entered 
here appears on the Job Summary report, so you can compare estimated 
expense to actual expense for a job.

Prior Income Enter how much money this project has already earned (from periods 
prior to your current fiscal year).

You can group
accounts to appear

as one line on
financial statements
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Prior Expense Enter how much money this project has already cost (from periods prior 
to your current fiscal year).

Important When you close the year, the current year’s income and expenses for a 
job are automatically added to the job’s Prior Income and Prior 
Expense. Job detail is not maintained after you close the year.

Setting Up Jobs
1 Job Setup in the Command Center.

2 Enter a new job number between 1 and 9999.

When you save the job, leading zeros are automatically added.

3 Enter a job name.

4 Enter any other relevant job information.

For more details, see “Setting Up Jobs” on page 83.
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5 Click Save.

After you click Save, the job number and name are added to the jobs 
list.

When entering transactions, you can quickly associate job numbers 
(through a pop-up list of jobs) with any item line to track income and 
expenses.

Important If you want to make entries without having the job field pop-up each 
time, you can go under the edit menu and select “Skip Job” or hit 
Ctrl K (Windows) or Command K ( a- Macintosh) on the keyboard. Do 
the same thing to return to having the field pop-up.

Modifying a Job
First, select the job from the list on the right. Then, edit the necessary 
job information and click Save.

You cannot modify a job number once it has been saved. Modifying a 
job number and clicking Save will add the new job number to the list 
but will not remove the old one.

Deleting a Job
You can delete a job that has had no activity in the 30 open months. To 
delete a job, first select the job from the list on the right, then select 
Delete from the Edit menu. Jobs that have had activity in any of the 30 
open months cannot be deleted mid-year.

You can also delete a job at year end. To delete a job at the end of the 
year, check the Completed option and the job will be deleted when you 
close the year. 
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Sales Tax Set Up
MultiLedger lets you set up as many as 100 different Sales Tax 
Categories for tracking purposes. You can also get detailed Sales Tax 
reports. For information on these reports, see “Sales Tax Report” on 
page 298.

Sales Tax Setup Field Descriptions
The following section describes the fields on Sales Tax Setup.

Tax Name Enter a name up to 13 characters long, including spaces. 

Note The sales tax categories appear in the pop-up list on Customer Invoices 
in the order that you enter them. You may want to enter the most 
common sales tax categories first. 

Note If you type a minus sign (-) in front of the sales tax name, the sales tax 
name won’t print on invoices.

Tax % Enter the Tax % as a percentage. For example, a tax rate of 3% should 
be entered as 3. You can enter a percentage that is up to two places to 
the left and four places to the right of the decimal point (99.9999).

Note If you try to enter a percentage that is more than two places to the left 
or more than four places to the right of the decimal point, MultiLedger 
will truncate the number, not round it up.

Ledger Account When you click in this box, a pop-up list of your chart of accounts 
appears. From the list of your chart of accounts, select a Liability 
Account (in the 2000 range) to associate with the sales tax category. 
When the sales tax category is used on Customer Invoices, the liability 
account associated with that category is automatically increased.
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Setting Up Sales Tax Categories
1 Click Sales Tax Setup in the Command Center.

2 Type in a name for the sales tax category in the Tax Name edit box.

3 Enter the percentage for the sales tax in the Tax % edit box. 

4 Select a general ledger account (usually a liability account in the 2000 
range) from the Ledger Account pop-up list for this sales tax category, 
then click Save.

Modifying Sales Tax Categories

Important After modifying a sales tax category, any outstanding invoices using the old 
sales tax category will not be changed to the modified sales tax category.

To edit or modify a sales tax category, select the category from the list, 
modify the information, and click Save.

Deleting Sales Tax Categories
You cannot delete sales tax categories. 
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Salesperson Setup
You can track sales of commissionable items by salesperson. If no 
salespeople are set up, the Salesperson field on Customer Invoices will 
be skipped automatically during invoice entry. You can set up as many 
salespeople as you need.

Salesperson Setup Field Descriptions
This section describes the fields on Salesperson Setup. 

Name Enter a name up to nine characters long.

The name you enter appears in the Salesperson pop-up list on Customer 
Invoices in alphabetical order.

Long Name Enter a name up to thirty characters long.

The name you enter appears on the Salesperson report. 

Commission Rate Enter the salesperson’s commission rate as a percentage. For example, 
a commission of 15% should be entered as 15. You can enter a 
percentage that is up to two places to the left and two places to the right 
of the decimal point (99.99).

Commissions are calculated only on items that have been set up as 
commissionable on Item Setup.

Each salesperson can have only one commission rate. If a salesperson 
receives different commissions for different types of sales, you may 
want to set up the salesperson more than once with a slightly different 
name and a different commission rate in order to keep track.

Commission on Gross
Margin

Check this option if the salesperson’s commission should be calculated 
based on sales minus cost of sales.

If not checked, the commission will be calculated based on gross sales.
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Setting Up Salespeople
1 Click Salesperson Setup in the Command Center.

2 Enter the salesperson’s name. 

3 Enter the salesperson’s full name.

4 Enter the salesperson’s commission percentage.

5 If necessary, check the Commission on Gross Margin option.

6 Click Save.

The salesperson's name is added to the salesperson list.

Modifying Salespeople Information
To modify an existing salesperson, select the salesperson’s name from the 
list and edit the relevant information. Click Save when finished.

Important If you modify the salesperson’s commission rate, all existing sales for that 
salesperson will be re-calculated at the new rate.

Important If you change the checkbox for Commission on Gross Margin from its 
original setting, all existing sales for that salesperson will be re-calculated.
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Deleting Salespeople
To delete a salesperson, select the salesperson’s name from the list and 
choose Delete from the Edit menu.

You cannot delete a salesperson if he/she is associated with any 
invoices in the 30 open months.

Selecting the Font for Printing
MultiLedger allows you to select the font used for printing all 
transactions, reports, cheques, and mailing labels. 

1 Choose Print Font from the File menu.

2 Click a font in the list and a point size.

Fonts that appear are the ones that are installed on your particular 
system. You can use point sizes from 9 to 12 with MultiLedger on Mac 
and 8 to 14 with MultiLedger on Windows.

Fonts that appear
here are the ones

installed on your
particular computer

system



90 Chapter 4 Setup Options

Using the Print Screen
With the Print command, you can print cheques, invoices, quotes, 
packing slips, labels, Item Purchases documents, purchase orders and 
deposits.

Printing Options
The following section describes what can be printed with the Print 
command and the available options.

Cheques Cheques created with Vendor Payments and the Disbursements Journal 
for the selected month are shown. 

Laser Stub Check this option to print a second stub at the bottom third of the page 
for use with laser cheques.

Label Fields Check this option to print the “Pay”, “To the Order of”, “Amount”, and 
“Authorized Signature” field labels on blank cheque stock used for 
MICR encoding.

Company Name on
Stub

Check this option to print your Company Name at the top of the cheque 
stub.

Customer Invoices &
Quotes

Invoices and quotes created in Customer Invoices for the selected 
month are shown. 

Packing Slips Invoices created in Customer Invoices for the selected month are 
shown. The packing slip prints information from the invoice excluding 
any dollar amounts. 

Shipping Labels Invoices created in Customer Invoices for the selected month are 
shown. This allows you to print the customer name and Ship To address 
from the Customer invoice. If no Ship To address has been entered on 
the Customer Invoice, the customer’s name and address as it appears on 
Customer Setup prints.

To adjust the printing dimensions for the label, use Preferences under 
the File menu. For details, see “Setting Program Preferences” on 
page 76.

Sales Journal Invoices Invoices created in the Sales Journal for the selected month are shown. 

Sales Journal Labels Invoices and quotes created in the Sales Journal for the selected month 
are shown. This allows you to print the customer name and address from 
the Customer field on the invoice. To adjust the printing dimensions for 
the label, use Preferences under the File menu. For details, see “Setting 
Program Preferences” on page 76.

Item Purchases &
PO’s

Payables and purchase orders created in Item Purchases for the selected 
month are shown. 
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Deposits Deposits created in Customer Payments and Receipts Journal for the 
selected month are shown. This will print a deposit slip with MICR 
information with up to 17 individual invoices. You can include more 
than 17 invoices per deposit slip, but invoices over 17 will appear as one 
lump sum, rather than individual invoices. Be sure Print MICR is 
selected and that you have set up MICR Encoding Specifications. For 
more information, see “Setting Up the MICR Encoding Information” on 
page 93.

Print Metafile
(Windows) or Print

PDF/PICT File
(Macintosh)

Check this option for cheques, invoices, quotes, item purchases and 
purchase orders to have an Open File dialog box appear after clicking 
Print or OK in a Print dialog box. Select the appropriate metafile or 
PDF/PICT file from the list and click OK. (Metafiles and PDF/PICT 
files can be created in a graphics program) Use the same field positions 
as the default. To adjust where the various fields print on forms, use the 
Format command under the File menu. For more details, see 
“Positioning Print Fields for Windows Metafiles or Macintosh PDF or 
PICT Files” on page 98.

Print MICR Check this option to activate the Bank information, routing number and 
account number fields to enable the MICR encoding to print on the 
cheques.

Email Without Prompt Selecting this option will send the emailed document immediately 
without any warning or message when selecting the Email button.

.Sort by Doc # or by
Date

This drop down list will allow you to sort the way you print your 
invoices either by the document number (default) or by the date.



92 Chapter 4 Setup Options

How to Use the Print Command
1 Coose the Print window from the Command Screen

2 Select the correct month from the Period list.

3 Click the appropriate radio button to see a list of documents available 
for printing.

4 Check any appropriate print options such as laser stub, Print Metafile 
(Windows), or Print PDF/PCT File (Macintosh).

5 Select Sort by option.

6 Select the documents for printing.

Select a document by clicking its document number or select more than 
one document by clicking and dragging through the list. You can select 
a non-consecutive series of documents by holding down the Ctrl key 
(Windows) or shift key (Macintosh) while clicking the desired lines.

Important If no single document or group of documents is selected, all documents 
will be printed.

A list of
transactions for the

radio button and
month selected

appears here

If printing cheques or
deposit slips with
MICR encoding,

make sure the Print
MICR box is selected

If necessary, check
the appropriate

print options

View option is
not available on

Mac
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Cheques, Customer Invoices and Quotes, Sales Journal Invoices, and 
Item Purchases and Purchase Orders followed by an asterisk (* - 
Windows) or bullet (• - Macintosh) have already been printed.

You can also use the Find and Find Again commands under the Edit 
menu to find a particular document, customer, or vendor.

7 Select the print options you want, and click Print.

How to use the E-mail Command
You can email Customer Invoices, Sales Journal Invoices/Quotes and 
Item Purchases/PO’s. 

To send an email, follow the same steps as you would to print a 
document which is covered above in How to use the Print 
Command, but instead of clicking the Print button, click on the Email 
button.

Windows: Utilizes Messaging Application Program Interface (MAPI) 
that is a part of the Windows operating system. This feature may 
require additional setup in your email program. This feature does not 
necessarily interface with an internet based email program.

Macintosh: Requires OS X to use this feature. Emailing documents 
will only work with the Apple Mail program.To set Mail as the default 
mail program first launch the Mail program. Under the Mail menu, 
select Preferences. On the General tab, select the Mail program as the 
default. Close the Preferences window.

Setting Up the MICR Encoding Information
1 Open up the Chart of Accounts window from the Command screen.

2 Highlight a Cash Account in your Chart of Accounts list. 

This activates the Save button so you can begin entering the MICR 
information.

3 Enter your bank’s nine digit ACH number.

This is usually the first nine digits at the bottom of a pre-printed 
cheque. 

4 Enter your nine digit deposit routing number.

This will print on Deposit Slips printed from this window and also 
deposit slips directly printed from Customer Payments. For more 
information, see “Recording Customer Payments” on page 154. The 
Routing # and Bank information will print unless you don’t have the 
print option to Print MICR checked in the Print window of the 
Command screen. For information on Printing documents see “How to 
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Use the Print Command” on page 92.

5 Enter your company’s bank account number, up to 15 digits.

Note In most cases, the MICR software automatically prints the symbols. If 
you have to manually enter the symbols:

Enter a “D” (capital D) to type a MICR hyphen: DS

Enter a “C” (capital C) to type this symbol: C

Enter an “A” (capital A) to type this symbol: A

6 Enter your bank’s name and address in the appropriate fields.

7 Enter your bank’s Fractional Routing #.

Some cheques (not all) have a number printed near the bank name or 
near the top of the cheque. This number is also called a Non-MICR 
ACH#.

8 Repeat steps 2-7 for all accounts that you wish to print MICR.

9 Print cheques or deposit slips as you normally would. 

Make sure the Print MICR option is selected in the Print window of the 
Command screen. For information on how to print see “How to Use 
the Print Command” on page 92.

Formatting Cheques, Invoices, Statements & Deposits
The Format window under the File menu is used to position print fields 
for cheques, invoices, purchase orders, quotes, customer statements 
and deposit slips. You can position print fields for any compatible 
printer
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.

Print fields for the Default items have been positioned to fit forms from 
CheckMark’s Forms division. (Forms can be ordered by calling 1-800-
444-9922 or online at www.checkmark.com.)

You might want to customize the position of print fields for the 
following reasons:

• You need to fine tune the preset print fields for your specific 
printer.

• You want to print on pre-printed forms other than those made by 
CheckMark Forms.

• You want to print forms saved as metafiles (Windows) or PDF/
PICT Files (Macintosh). Metafile is a Windows-based format and 
a PICT File is a Macintosh-based format for a graphics document 
created by many graphics programs. PDF files can also be used on 
the Macintosh version of MultiLedger.

Customizing Print Field Positions for Your 
Printer
The initial positions of the print fields for Custom options are based on 
CheckMark Forms. To customize the preset print fields for your printer 
or to create a format other than that used by CheckMark Forms, do the 
following:

1 Click the appropriate “Custom” radio button.

Clicking the Custom 11" Invoice/Quote/PO radio button opens the 
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following formatting window:

2 Drag the print fields to their new positions.

Select a group of print fields by dragging over the fields or by holding 
down the SHIFT key while clicking individual fields. Moving one of the 
fields moves the entire group. 

To restrict movements to vertical positioning, hold down the Alt key 
(Windows) or the OPTION key (Macintosh) while dragging the field or 
fields. 

To restrict movements to horizontal positioning, hold down the Ctrl 
key (Windows) or Command key (a - Macintosh) while dragging the 
field or fields.

You can use the arrow keys to move the fields.

Note Double-click a field to activate or de-activate. If the field label is red, it 
is inactive.

3 When you are finished repositioning the print fields, click the 
window’s close box.

The following dialog appears:
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4 Click Yes to save the changes you made to the print field positions.

Click No to return to the Format window without saving any position 
changes.

Note To return any custom format to its original settings, hold down the Ctrl 
key (Windows) or Command key (a- Macintosh) while clicking the 
appropriate default radio button.
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Positioning Print Fields for Windows 
Metafiles or Macintosh PDF or PICT Files
If you’ve created your own form as a Windows metafile (.wmf) or a 
Macintosh PICT file (.pct) or PDF (.pdf) in a graphics program, or you 
want to use one of the sample metafiles, PDFs or PICTs that came on 
the MultiLedger master disk, MultiLedger can show the metafile, PDF 
or PICT file on your screen to help you position print fields. 
MultiLedger can also print the metafile, PDF, or PICT file along with 
the corresponding transaction information.

1 Create the invoice, cheque, quote, purchase order, or customer 
statement form using any graphics program that can save Windows 
metafiles or Macintosh PDF/PICT files.

2 Save the graphics file (in the graphics program) in the metafile format 
(.wmf) or PDF/PICT format (.pdf/.pct). You can save the metafile or 
PDF/PICT in the same folder that contains your company’s data files. 
Close the metafile or PDF/PICT file.

3 Open your MultiLedger company files.

4 Choose Format from the File menu.

You can align the print fields according to the following directions:

1 Check the Display Metafile option (Windows) or Display PDF/PICT 
File option (Macintosh):

2 Click the appropriate “Custom” radio button.

For example, clicking the Custom 11" Invoice/Quote/PO radio button 
with Display Metafile or Display PDF/PICT File checked causes a 
standard Open File dialog box to appear on your screen.

Note Invoices, quotes, and purchase orders use the same format.

3 Open the appropriate Metafile or PDF/PICT File.

Note On Windows: Several sample forms in the metafile format are included 
in the “Metafile” folder installed in the MultiLedger directory. 
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Note On Macintosh: Several sample forms in the PDF/PICT format are 
included in the “Sample PDF/PICTs” folder installed in the 
MultiLedgerƒ folder. 

Your company name and address from Company Information will 
print on invoices and statements that use these metafiles or PDF/PICT 
Files. For example, if you click “11_Inv.wmf” in the scroll box, and 
then click Open, the following formatting window would appear:

4 Drag the print fields you want to reposition to their new positions.

Note You cannot reposition the background metafile or PDF/PICT File. For 
example, the text “Acct#” is part of the metafile or PDF/PICT file—not 
a print field. To edit the text, graphics, or background for this particular 
metafile or PDF/PICT File, you must use a graphics program that can 
edit Windows metafiles or Macintosh PDF/PICT Files.

5 When you are finished repositioning the print fields, close the window.



100 Chapter 4 Setup Options

6 Click Yes to save the changes you made to the print field positions.

Click No to return to the Format window without saving any position 
changes.

Note To return any custom format to its original settings, hold down the Ctrl 
key (Windows) or Command key (a - Macintosh) while clicking the 
appropriate default radio button.

Codes for Customers, Vendors, and Items
You can use an optional code field to sort or classify customers, 
vendors, and items. Codes can be entered up to 15 alpha-numeric 
characters and are entered in the Customer, Vendor, or Item setup 
windows. 

For example, if you want to sort vendors by an account number, you 
would setup a code in the code field on vendor setup and it will show 
as below on all vendor lists:

C123\ACME Office Supplies

Characters up to and including the backslash (\) won’t automatically 
print on cheques, invoices, mailing labels, or customer, vendor, and 
item reports. The code, however, will appear on transaction journal 
reports. 

Note To have MultiLedger print the codes you’ve set up for customers, 
vendors, and items on reports, check the “Show Code Field on Reports” 
option on Preferences under the File menu.
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Chapter 5
Multi-User MultiLedger

This chapter discusses the following topics:

• Utilizing the multi-user capabilities

• Assigning users and passwords

• Locking and unlocking months
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Using Multi-User MultiLedger
MultiLedger has built-in multi-user capabilities that allow up to 10 
users to access your company’s accounting data over a network 
simultaneously. This means that one or more users can be entering 
invoices or payables while another user might be viewing financial 
reports. All data is stored and updated in one location on your network. 
When information is saved, records are locked to prevent overwriting 
of data. 

To utilize the multi-user capabilities, the volume (hard drive) or folder 
containing your company’s data files must be shareable with other 
users connected to your network. 

Important If you are using all Macintosh computers and use a Mac OSX computer 
as a dedicated server to allow access to your MultiLedger company files 
between Mac OSX, OSX will work fine. HOWEVER, you should not 
open MultiLedger files on the OSX computer that is acting as the host, 
since it is not recognized as a user and corruption problems can occur.

Important OSX Server has a problem handling “byte-range locking” requests from 
Windows (ie., SMB) users and Mac users simultaneously. You’ll need 
a Windows Server. 

Installing MultiLedger for Multi-User
You will need to install MultiLedger on each user’s computer, as 
described in Chapter 1, “Getting Started.” 

Mapping the Drive on Windows
For better data access over a network, you should map your network 
drive to a letter. Each operating system handles this differently. For 
more information, see the documentation the came with your operating 
system.
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Using the Multi-User Capabilities
All that is required to initiate multi-user operation is to place the 
company files on a shared disk.

Note Daily backups are strongly recommended for shared data. For more 
information on backing up company files, read Chapter 12, “Backing 
Up and Restoring Company Files.”

Using MultiLedger in a multi-user environment is very similar to using 
it in a single user environment. The main difference is that 
simultaneous access to the same data must be regulated, either by 
disallowing certain operations at a given time, or by delaying a 
particular operation until requested data is available.

Access Limitations 
Access limitations are indicated by the following messages:

• “Exclusive access required or maximum number of users 
exceeded. Operation not allowed.” 

Only one user may access company files during certain operations, 
e.g., closing the year, deleting a customer. The maximum number 
of users you can have is 10.

• “Operation not allowed if more than one user accessing data.”

Certain operations may be performed by only one user at one time, 
such as Customer Payments, Vendor Payments, Finance Charges, 
Bank Reconciliation, and Chart of Accounts. 

Delays in accessing data occur in two situations, each signaled by 
the appearance of the network cursor ( ):

• When the cursor is blinking, another user is accessing data needed 
for the current operation, so the program is waiting until the 
required data becomes available. When the data is no longer in 
use, the operation will proceed. On Windows, holding down the 
Escape (esc) key will abort the operation. On Mac, hold down the 
command key and period at the same time. This is typified by two 
users trying to simultaneously save a transaction, or a user 
attempting to save a transaction at the same time another user is 
generating a balance sheet. 
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• When the cursor appears without blinking, another user has added 
data, and the program is incorporating this additional data; the 
duration depends on the amount of data involved. Once the data 
has been incorporated, the program will continue. An example of 
this would be selecting the Customer report after customers have 
been added by another user.

Multi-User Restrictions
The fundamental restriction is allowing only one user to access 
transactions at one time. Access occurs whenever transactions are 
saved (including customer/vendor payments, import, backing up, etc.), 
or reports requiring a “balanced” state (Balance Sheet, Trial Balance, 
or General Ledger listing) are being created. If simultaneous 
transaction access is attempted, the blinking network cursor will 
appear until the operation is completed. The delay will be equal to the 
time needed to perform the operation, which in most cases is relatively 
short. 

There are several special cases of restricted access. A receivable/
payable cannot be modified if the Customer/Vendor Payments screen is 
in use. Deletions (accounts, customers, vendors, items, salespeople) 
require that only one user is accessing company files.

The following table shows the access controls for the menus that are 
not multi-user. Operations are classified as single (available to only 
one user at a time), and exclusive (available only if no other user has 
opened the same company).
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All other operations are available to multiple users, subject to the 
restrictions and delays previously described. Note that for certain 
operations, even though multiple users are not prohibited, a 
“reasonable” use of the program is assumed. An instance of this would 
be Account Balances. More than one user can enter balances—if they 
are entering the same month, then the last one saved will overwrite any 
previous values. (While saving, no other user may access transactions.)

Network Considerations
For windows permitting multiple access, if two users access the same 
data and save it, the last one to save will overwrite any previous 
changes. For example, if two users modify the Preferences window, 
one enables the check for duplicate documents and the other disables 
it, the stored value will be that of the user who saves last.

Network timing will determine the data available to a user at any 
particular time. If, for example, a transaction journal report is being 
created while another user adds an entry to the journal, the entry will 
not be included; however, if the report is recreated, the new entry will 
appear. In general, data is made available at the time it is requested; for 
example, the customer list is updated when the customer setup or 
customer reports screens are entered.

Operation Access

Profit Center Single

Chart of Accounts Single

Customer/Vendor Payments Single

Adjust Inventory Single

Finance Charges Single

Bank Reconciliation Single

Close Year Exclusive

Delete (account, vendor, customer,...) Exclusive

Back Up Company Exclusive

Rebuild Files Exclusive

Import chart of accounts Exclusive
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Since more than one user can be entering into the same journal, we 
recommend you check “Check for Duplicate Document Numbers” on 
the Preferences window under the File menu.

Users and Passwords
MultiLedger allows you to set up individual users with unique 
passwords, then assign the menu commands that each user should have 
access to. 

Setting Up Users and Passwords
You can set up as many as 20 users and passwords in MultiLedger.

Note Although you can set up as many as 20 users, the maximum number of 
users that can access your company’s data files 
simultaneously is 10. 

The number of users who currently have the company files open is 
displayed at the bottom of the Command Center.

1 Click Company Information in the Command Center, then click 
Passwords.

The following window appears:
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2 Type in a user’s name (up to 20 characters).

3 Type in a password (up to 10 characters).

The password can be letters, numbers, or a combination of both. 
Passwords are not case-sensitive, meaning entering “SKI” is the same 
as entering “ski”.

4 Click the menu commands from the Accessible Menu Commands list 
that this user should have access to, then click Save. 

To deselect a menu command, simply click it so that the asterisk 
(Windows) or checkmark (Macintosh) is removed. You can select or 
deselect a range of menu commands by clicking on the first one and 
dragging down the list.

You can continue entering new users and passwords, or, if you’re 
finished, click Done. 

When you create a new company with MultiLedger, a user named 
Master is automatically set up for you. The Master initially has no 
password, but has access to all menu commands. If you will be using 
passwords for your company, you need to assign a password to the 
Master before any other users and passwords are activated. Please note 
that you can change the name Master to a user’s name. However, the 
first user’s name in the list is always considered the Master and always 
has access to all menu commands. 

Note The posting category on transaction journal windows and the Bank 
Reconciliation cannot be changed if you do not check Interface 
Accounts. 

Note Renumber Accounts in the File menu will be active or inactive when 
you check or uncheck the Chart of Accounts. 

Note The Cash Flow Statement and Financial Snapshot will be active or 
inactive when you check or uncheck the Balance Sheet.
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Modifying and Deleting Users and 
Passwords
Only the Master can modify or delete users and passwords. Please note 
that while you can change the name Master and the password, you 
cannot change the accessible menu commands or delete the Master.

1 Click Company Information in the Command Center, then click 
Passwords.

2 Highlight a user’s name from the list on the right.

You can change any information for this user. After making changes, 
be sure to click Save before selecting another user or clicking Done, or 
else your changes will be lost. 

To delete the user, click Delete. When you are finished making 
changes in this window, click Done to return to the Company 
Information window.

How Passwords Work
If you’ve set up users and passwords for your company, you’ll be 
prompted to enter a password when you open your company files. 
Highlight a user’s name in the list, type the correct password, then 
press TAB. When you are prompted for the password, you get three 
chances to enter a correct password before you are exited from the 
program.

After opening a company using a password, if a user tries to access a 
window that he/she doesn’t have password access to, the following 
message appears:

Locking and Unlocking Months
MultiLedger has a feature that allows you to lock transactions through 
a specific month-end date, and unlock a month or range of months if 
changes are necessary. This feature can be password protected. For 
more information on setting up passwords, See “Setting Up Users and 
Passwords” on page 106.
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How to Lock a Month
When you are ready to lock a month, the procedure is simple:

1 Click Company Information in the Command Center.

2 Click the month you want to lock entries through in the Lock Entries 
Thru list. 

For example, if you want transactions locked through April 2017, you 
would highlight 04/30/17. Transactions with dates from your first open 
month through April 2017 cannot be entered, modified, imported, or 
deleted, but reports for those months can still be viewed and printed.

How to Unlock a Month
If a month is locked, but you need to make a change in that month, you 
can always unlock the month.

1 Click Company Information in the Command Center.

2 Click the selected month in the Lock Entries Thru list to deselect it, 
which unlocks all months, or highlight a month from the Lock Entries 
Thru list that is before the month you want to make changes in. 

For example, if you need to make a change in April 2017, you could 
highlight 03/31/17 in the list to keep transactions prior to April 2017 
locked.
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Chapter 6
Introduction to Transactions

This chapter discusses the following topics:

• Using MultiLedger’s transaction windows

• Working with pop-up lists

• Using MultiLedger’s Find command for pop-up lists

• Adding or Editing names in a pop-up list

• Valid document numbers and transaction dates

• Adding comment lines to transactions

• Modifying and deleting transactions

• Entering void documents

• Working with recurring entries



112 Chapter 6 Introduction to Transactions

Moving Between Fields
Recording a transaction in MultiLedger is similar to filling out a paper 
form—you enter information under heading or field names. You can 
enter information in any order you want by clicking in each field’s edit 
box. However, the quickest way to move the cursor (a flashing vertical 
bar in the edit box) to the next field is to press TAB or ENTER on 
Windows or TAB or RETURN on Macintosh. To move to a previous 
field, click in that field’s edit box.

Using Pop-Up Lists
Whenever the cursor enters a field that has an asterisk (*) after its 
name, such as the Customer, Vendor, or Item fields, a pop-up list like 
the following one appears:

Pop-up lists consist of customers, vendors, terms, salespeople, items, 
jobs, shipping methods, sales tax categories, or account numbers. 
These lists make data entry fast and easy. For example, by selecting a 
customer name from a pop-up list, the customer’s name, and address 
are all automatically added to the transaction.
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Note You can set up certain defaults for customers, vendors, and items on the 
individual Setup window that will be automatically selected in a pop-up 
list during transaction entry. For example, you can assign default 
Customer Terms for a customer on Customer Setup, then that term will 
be automatically selected in the pop-up list for the customer when you 
create a Customer Invoice. 

Finding a Name in a Pop-Up List
MultiLedger offers you several ways to quickly find a name in a pop-
up list:

•  You can use the Find box to search for names, account numbers, 
jobs, etc. For example, you can type in all or part of a customer’s 
name, and the program will find the first occurrence of those 
letters. You can then use the arrow keys on your keyboard to move 
through the list.

The Find feature is case-sensitive if the “Find Anywhere” box is not 
checked: typing in “ACT” will find “ACT Services” but not “Action 
Services.” It will search on the beginning characters of a name or 
number, and assumes that the first character of a name is capitalized. 
For example, typing in “Action” will find “Action Services” but not 
“Uniform Action” or “action plus.”

If you have the “Find Anywhere” box checked, it is not case-sensitive 
and MultiLedger will search for the first occurrence of the letter 
sequence you enter. For example, typing in “ve” will find “Inventory” 
before it will find “Vehicle.” The Find Anywhere box should be 
checked before you type information to search for. Otherwise, it will 
search on the beginning characters only. 

or

• Press the up arrow or down arrow keys on your keyboard to move 
through the list.

or
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• Use the pop-up list’s scroll bar to scroll the list up or down, and 
click a name when it scrolls into view.

Note You can type the first letter of a name to scroll to that letter group in the 
list, and then use the down arrow key to quickly move to the desired 
name.

Entering Information with a Pop-Up List
You can enter information into a transaction from a pop-up list in one 
of two ways:

• If the name in the list is not already highlighted, click it once to 
highlight it, then click OK or press TAB, RETURN (Macintosh), or 
ENTER (Windows) to enter the information into the transaction.

or

• Double-click a name in the list.

Adding or Editing Names in a Pop-Up List
You can access Customer, Vendor, and Item Setup windows directly 
from a pop-up list. For those pop-up lists that don’t have the option of 
New or Edit, you can access the Setup windows without having to 
close a transaction window by choosing the appropriate option from 
the Command Center or the pull-down menus. 

To add a new customer, vendor, or item through a pop-up list, click New 
(Alt-N on Windows or aN on Macintosh). The appropriate Setup 
window will open. After setting up the new customer, vendor, or item, 
click Save on the Setup window or press ENTER. You return to the 
transaction window and the new customer, vendor, or item is 
highlighted in the pop-up list. Press TAB to add the customer, vendor, or 
item to the transaction.

To edit information for an existing customer, vendor or item through a 
pop-up list, first highlight the name in the list. Then, click Edit (Alt-E 
on Windows or aE on Macintosh). The appropriate Setup window will 
open. After editing the customer, vendor, or item, click Save or press 
ENTER on the Setup window. You return to the transaction window and 
the edited customer, vendor, or item is highlighted in the pop-up list. 
Press TAB or click OK to add the customer, vendor, or item to the 
transaction.
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Skipping a Pop-Up List
A pop-up list will be skipped if no information is set up for it.

If Skip Jobs under the Edit menu is checked(Ctrl-K on Windows or 
Command (a) K on Macintosh), the Job field on all transaction 
windows will be skipped.

Click Cancel (Alt-F4 on Windows or Command (a) period on 
Macintosh) to close a pop-up list without entering any information.

Document Numbers
Each transaction (document) must have a document number that 
identifies it. Depending on the transaction window, these document 
numbers are labeled as Document #, Invoice #, Doc #, Cheque #, 
Deposit #, or Ref #.

Although document numbers can contain up to eight characters, such 
as letters, numbers, or dashes, the last character must be a numeral. For 
example, “INV-1138” would work, but “1138-INV” would not.

If a document number is missing or does not end with a numeral, the 
following message appears when you try to save the document:

Click OK and re-enter the document number.

After you save a transaction, the document number automatically 
increases by one. The next document number is saved for each 
transaction window and will automatically be entered when the 
window is opened again.

Sales Journal and Customer Invoices share the same last document 
(invoice) number. Saving a document number in one will automatically 
increment the next document number in both windows by one. For 
example, after saving the document number “1138” in the Sales 
Journal, the next document number in either the Sales Journal or 
Customer Invoices would be “1139.”

The Payables Journal and Item Purchases also share the same last 
document number, as do the Disbursements Journal and Vendor 
Payments, and the Receipts Journal and Customer Payments.
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Quotes and Purchase Orders use their own unique numbers. For 
example, when you save a Quote, you can assign the quote a document 
number such as “QU 100.” Then, the next time you save a Quote, it 
will automatically be assigned document number “QU 101.” When 
you convert a Quote or Purchase Order to a transaction, it will be 
assigned the next available document number for that transaction.

Checking for duplicate document numbers
MultiLedger allows you to save a transaction in the same journal with 
the same document number (but not also the same date), unless you 
have Check for Duplicate Documents checked on Preferences under 
the File menu. 

Some transaction windows access the same journal in MultiLedger and 
will check for a duplicate document number entered in either 
transaction window. For more information on which journals use the 
same numbering system, see the “Document Numbers” section above.

If you have Check for Duplicate Documents on Preferences checked 
and a duplicate document number is found, the following message 
appears:

Click Yes to assign the next available document number, or click No to 
return to the transaction window, then assign the transaction a new 
document number.

Working with 30 Open Months
MultiLedger allows you to work in any month in the open 30 months. 
For example, if your company operates on a calendar year, you could 
enter and modify transactions for January, 2016, through June, 2018, 
before you would be required to close 2016.

Important Once a year has been closed, it cannot be reopened. 

Important We cannot stress enough the importance of making frequent backups 
of your company files. For more information on backing up, see 
Chapter 12, “Backing Up and Restoring Company Files.”
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Locking and Unlocking Months
Having 30 months open does not mean that you have to compromise 
the security of your company files. MultiLedger has a feature that 
allows you to lock a month when transaction entry should be closed, 
and unlock a month if changes are necessary. For more information on 
locking and unlocking months, see “Locking and Unlocking Months” 
on page 108.

Transaction Dates
You can use the +/- keys on your keyboard to increment/decrement the 
date in any transaction window. You can also type over the date to 
modify it. 

Date Formats
Enter dates in the MM/DD/YY format. For example, to enter February 
15, 2017, you would enter the date like this: 2/15/17. Notice that you 
do not have to enter any leading zeros.

If you want to enter dates in the DD/MM/YY format, check the 
“International Date Format [dd/mm/yy]” option on Preferences under 
the File menu.
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Valid Transaction Dates
The following table shows the dates that are allowed for each 
transaction window:

Note To see what the current fiscal year is, click Company Information in the 
Command Center. 

Date Alert Messages
If you enter an invalid date and try to move the cursor out of the Date 
field on a transaction window, the following message appears:

Click OK and change the highlighted date to a valid one.

TransactionWindow Valid Dates

Item Purchases
Customer Invoices
Vendor Payments
Customer Payments
Disbursements Journal
Receipts Journal
General Journal
Finance Charges
Adjust Inventory

Any date from 30 open months, provided 
the month isn’t locked. No date prior to 
the current fiscal year is allowed.

Payables Journal
Sales Journal

Any date from the 30 open months, 
provided the month isn’t locked. For 
setting up a company’s outstanding 
receivables and payables, you can enter a 
date prior to your current fiscal year.
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If you enter an invoice in the Sales Journal or Payables Journal with a 
date prior to your current fiscal year, the following alert appears:

Click Yes to save the transaction. Saving the transaction adds the detail 
to your Accounts Receivable or Accounts Payable report, but does not 
affect any ledger balances. Invoices entered in the Sales Journal or 
Payables Journal with a date prior to your current fiscal year should be 
invoices that your company has not yet received payment for or that 
your company has not yet paid as of the first day of your current fiscal 
year. 

Click No to not save the transaction.

Adding Comment Lines to Transactions
You can add comment lines to transactions by choosing Insert Line 
(Ctrl-I on Windows or aI on Macintosh) from the Edit menu. A five 
line edit box appears:

Enter the comment, up to five lines long and click OK. The comment 
lines are added to the transaction detail list.

If you try to wrap the text, it may not show up as entered. It is best to 
force the line a line break with the Enter key on your keyboard.

Comment lines appear in transaction journal reports and when you 
print the transaction. You can add as many comment lines as necessary. 
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Note You can add comment lines between detail lines on a transaction. 
Simply select the detail line you want the comment line to appear 
before, choose Insert Line (Ctrl-I on Windows or aI on Macintosh) 
from the Edit menu, then type in the comment line and click OK.

Important You cannot add comment lines to Receipts Journal transactions created 
in Customer Payments or Disbursements Journal transactions created in 
Vendor Payments.

Modifying or Removing Comment Lines
To modify or remove a comment line, click the comment line on the 
transaction window. The Insert Line edit box with the comment line 
highlighted appears. Choose Cut from the Edit menu (or press delete) 
or edit the line and then click OK.You can only edit one line at a time.

Saving a Transaction
After all the necessary information for a transaction has been entered, 
click the Save button on the transaction window or press the ENTER 
(Macintosh only) key on your keyboard. MultiLedger automatically 
posts the transaction to the general ledger.

If you don’t want to save the document, simply close the transaction 
window without clicking Save, the following alert appears:

Click No.

Modifying or Deleting a Transaction
You can modify or delete any transaction within the months that have 
activity, provided the month isn’t locked.

If, while entering a transaction, you decide that you no longer want to 
record it, simply close the transaction window, then click No on the 
alert that appears.
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Note If the invoice or payable you want to modify has a Customer Payment 
or Vendor Payment associated with it, you should delete the Customer 
Payment or Vendor Payment first before modifying the invoice or 
payable.

If the transaction has already been saved, do the following beginning 
with step 1. If the transaction has not yet been saved, start with step 6.

If the transaction has 
been saved, start here.

1 Open the window that was used to create the transaction.

2 Make sure the cursor is in the document number field.

3 Click the Modify button.

When you click Modify, a pop-up list of documents (showing 
numbers, dates, and descriptions) from the month selected in the pull-
down menu appears.

If the transaction you’re looking for does not appear, be sure you have 
the correct month and year selected in the pull-down menu and that 
you are looking in the correct transaction window. If a month appears 
grayed out in the pull-down menu, it is locked.

4 Double-click the desired document, or click the desired document so 
that it’s highlighted, and then click OK. To select multiple documents 
to modify, hold down the SHIFT key while clicking each document or 
click and drag the desired documents.

Initially, this is the
month with the most

recent transaction
date, but you can

change it to any of the
months that have

activity.
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The following choices appear:

5 Click Modify to modify the transaction, Cancel to exit the transaction 
without making changes, Delete to remove the transaction, or Skip to 
move to the next document without cancelling the remaining selected 
transactions.

If you click Delete, you’re done and don’t need to follow steps 6 
through 8.

If you click Modify, the original transaction appears.

Note If you click Cancel while modifying multiple documents, all documents you are 
modifying are closed and you are returned to the transaction window.

Note If you click Skip while modifying multiple documents,it will skip the 
document on the screen and move on to the next one.

If the transaction has 
not been saved yet, 
start here

6 If necessary, click the detail line or field to be modified or deleted.

The information for the detail line appears in the appropriate fields.

7 Modify the necessary information.

To modify a field in a detail line, select the field that you want to 
modify, make the changes, and press TAB to move through the 
remaining fields and replace the old detail line in the list with the new 
information.

To delete a detail line, enter a zero (0) in the highlighted Amount field 
and press TAB to remove the line from the list.

8 Click Save to save the changes.

If you don’t want to save the changes, close the transaction window 
without clicking Save, then click No on the alert that appears to not 
save the changes.
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Entering a Void Document
A void document can be recorded in the Payables, Sales, Receipts, or 
Disbursements Journals. Enter the transaction information as you 
normally would, except don’t enter any ledger account or amount. 
After you click Save, the following message appears:

Click Yes to save the void document. Click No to return to the 
transaction window without saving the void document.

To void a transaction that has already been saved, follow the guidelines 
in “Modifying or Deleting a Transaction” on page 120. If you delete all 
detail lines and then click Save, you will get the message noted above. 
Click Yes to save the void document. Click No to return to the transaction 
window without saving the void document. You could also delete the 
document, and re-enter it as a Void document as described above.

Note If the disbursement was created in Vendor Payments or the receipt was 
created in Customer Payments, you cannot save the document as Void. 
You can, however, save the document with a zero balance. The 
outstanding payable(s) or receivable(s) associated with the payment 
will again appear in Vendor Payments or Customer Payments. 

For more information on modifying Disbursements created in Vendor 
Payments, see “Modifying or Deleting Payments Before Saving a 
Cheque” on page 198. For more information on modifying Receipts 
created in Customer Payments, see “Modifying or Deleting Payments 
After Saving a Deposit” on page 159.

Note If the document you want to void has a comment line inserted using 
Insert Line under the Edit menu (Ctrl-I on Windows or aI on 
Macintosh), you cannot save the document as Void. You can, however, 
save the document with a zero balance.
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Recurring Entries
Transactions entered in the following journals can be saved as 
Recurring entries:

•Customer Invoices

•Sales Journal 

•Item Purchases

•Payables Journal

•Disbursements Journal 

•Receipts Journal 

•General Journal

You can define any transaction as Recurring, with a frequency ranging 
from none to annually. MultiLedger can alert you when Recurring 
entries defined as weekly, bi-weekly, monthly, quarterly, semi-
annually, or annually come due. Some excellent uses for recurring 
entries include rent, 941 payments, and bank charges.

Creating a Recurring Entry
The following procedure for creating a Recurring entry uses the 
Disbursements Journal as an example. You can, however, create a 
Recurring entry in the other journals listed above as well.

1 Click Disbursements Journal in the Command Center.

2 Check the Recurring check box.

3 Enter the cheque as you normally would, then click Save.

A frequency dialog appears. 

4 Choose the desired frequency from the pop-up menu.

The Scheduled Date indicates when the next entry should be created 
and changes depending on the frequency you select.
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5 Click OK

A cheque is created and the transaction is marked to recur based on the 
frequency you selected. Click Cancel to return to the Disbursements 
Journal without saving the recurring information.

Working with Recurring Entries
When a recurring entry comes due, MultiLedger will alert users who 
have Show Scheduled Recurring Entries checked on User Settings 
(under the File menu). You can either create the recurring entry from 
the Recurring Alert dialog, or you can create it from the Recurring 
window.. 

The Recurring Alert Dialog

When recurring entries are due, the Recurring Alert dialog will appear 
when you open the company files in MultiLedger. You can create the 
transaction directly from this window, or you can click Cancel and 
create the transaction later from the Recurring window. For more 
information on the Recurring window, see the next section.

Note If you have scheduled recurring entries and the Recurring Alert dialog 
does not appear when you open your company files, make sure the 
Show Scheduled Recurring Entries option is checked on User Settings 
under the File menu.

To create a transaction directly from the Recurring Alert dialog, do the 
following:
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1 Select the recurring entry you want to save as a transaction.

You can select more than one recurring entry at a time. To select a 
contiguous selection, simply click and drag through the list. To select 
non-contiguous selections, hold the Ctrl key (Windows) or the SHIFT 
key (Macintosh) while clicking each recurring entry.

This window displays the last used date of the recurring transaction, 
the scheduled date, the next available document number that will be 
used for the transaction, the customer/vendor name (if applicable), and 
a description for the transaction.

2 Click Create

All selected recurring entries are created in their appropriate 
transaction journals and the Recurring Alert dialog closes. You can 
modify or delete the transaction as you would any transaction. For 
more information on modifying and deleting transactions, see 
“Modifying or Deleting a Transaction” on page 120.

You can see the created transactions by viewing the appropriate 
Transaction Journal report. For more information on Transaction 
Journal reports, see “Transaction Journals Reports” on page 278.
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The Recurring Window
The Recurring window allows you to do the following:

• Modify the frequency of recurring entries

• Delete a recurring entry

• Convert a recurring entry into a transaction

1 Click Recurring in the Command Center.

2 Select the radio button for the recurring entry you want to work with.

A list of recurring entries for that journal appears.

3 Select the recurring entry you want to create, delete, or edit the 
frequency for.

You can select a continuous range by clicking and dragging. You can 
select a discontinuous range by holding down the Ctrl key (Windows) 
or the SHIFT key (Macintosh) and clicking each desired transaction. 

Select the
appropriate radio
button to see the
Recurring Entries

for that journal
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The following descriptions outline each option:

Create When you click Create, the appropriate transaction journal window 
appears with the details of the transaction automatically filled in for 
you and you have three options, Create, Cancel, or Skip.

If you click Create, you can modify any information, such as 
changing the amount or document number, then click Save. The 
transaction is saved and the schedule date for the next occurrence of 
the recurring entry is advanced based on the frequency you originally 
defined.

If you click Cancel, a blank transaction journal window appears. Click 
the window’s close box to return to the Recurring window and start 
over.

If you click Skip, it will skip the entry on the screen and move on to 
the next entry. When you’re done creating your recurring entries, the 
one(s) you skipped will still show on the list with the same scheduled 
date as it had before you started.

Delete Click Delete to stop the entry from recurring. Transactions already 
created based on the recurring entry will be unaffected. 

Edit Frequency When you click Edit Frequency, the frequency dialog appears. Make 
any necessary changes, then click OK. Click Cancel to close the 
frequency dialog without saving any changes. 

Viewing and Printing Recurring Entries
You can view or print a list of Recurring Entries for a particular 
journal.

1 Click Transaction Journals in the Command Center.

2 Check the Last Used Recurring Entries check box.

3 Click the appropriate radio button.

The last-used recurring entries for the journal appear, regardless of the 
month you select in the Month list.

4 Click View or Print.
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Chapter 7
Customer Transactions

This chapter discusses the following topics:

• Recording sales

• Modifying or deleting sales

• Recording customer payments

• Working with quotes

• Working with customer credits and refunds

• Handling finance charges
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Customer Transactions Flowchart
The following flowchart is designed to give you a basic overview of 
customer-based transactions. The rest of this chapter describes each 
option in detail.

Customer Invoices

Create an invoice for inventory sales.
Track salesperson commissions.

Track sales tax.
Create a quote

Sales Journal

Create an invoice for non-inventory sales.
Create a quote

Finance Charges
(optional)

Customer Payments

Create a deposit from Customer Invoices,
Sales Journal, and Finance Charges

Receipts Journal

Customer Payments are posted here.
Also use for cash sales or other deposits

Bank Reconciliation

Shows deposits from Customer Payments
and Receipts Journal
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Recording Sales
MultiLedger offers great flexibility for recording sales. Depending on 
the type of sale you want to record, the three windows you can use are:

• Customer Invoices

• Sales Journal

• Receipts Journal

These windows are discussed in the following table. 

If you want to.... Use this transaction window

Record a sale of inventory items and 
create an outstanding receivable

Customer Invoices

Record a service sale that creates an 
outstanding receivable

Customer Invoices 
or Sales Journal

Create a recurring transaction Customer Invoices, Sales 
Journal, or Receipts Journal

Create a quote Customer Invoices
or Sales Journal

Record commissionable sales for your 
salespeople

Customer Invoices

Create outstanding receivables that 
are dated prior to your Start Month 
(for setting up your company with 
MultiLedger)

Sales Journal

Record a cash sale or part of a deposit 
that doesn’t involve inventory or 
create an outstanding receivable

Receipts Journal
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If you need to track inventory or salesperson commissions, your choice 
is simple—you should use Customer Invoices.

If you do not need to track inventory and want the sale to create an 
outstanding receivable, you can use either Customer Invoices or the 
Sales Journal. Both windows can record non-inventory sales, such as 
consulting, labor, or some other service.

Customer Invoices Customer Invoices offers more flexibility than the Sales Journal for 
recording a sale that creates an outstanding receivable. It’s the only one 
to use if you want to account for inventory sales, but it also offers many 
convenient features for non-inventory sales as well: 

• You can select up to two sales tax categories and 
MultiLedger will automatically calculate the sales tax on 
taxable items and on shipping if the checkbox is selected.

• Since items (non-inventory as well as inventory) already 
have ledger accounts associated with them, you don’t have 
to worry about picking the right ledger account for each 
item; you just pick the right item. 

• MultiLedger will automatically insert the Selling Price for 
a selected item (non-inventory and inventory). This can 
mean fewer mistakes during transaction entry.

• The Amount for each detail line will automatically be 
calculated based on Quantity times Selling Price. You can 
still modify the calculated amount.

• You can create a Quote which can be modified or 
converted to a Customer Invoice at any time.

• You can track commissionable sales for your salespeople.

• You can utilize the default pricing level you set up for 
customers.

Sales Journal The Sales Journal offers the simplest means for recording a sale that 
creates an outstanding receivable. For many, it’s the quickest way to 
enter a sale when they don’t need to keep tabs on an inventory. 

Although the Sales Journal does not automatically calculate a sales tax 
based on a percentage, you can manually figure the tax and enter it as a 
detail line on the invoice.

The Sales Journal is also used to enter any outstanding invoices that are 
dated prior to your Start Month when you initially start your company 
using MultiLedger.



Customer Invoices 133

Receipts Journal The Receipts Journal gives you a way to a record a cash sale or part of 
a deposit that doesn’t involve inventory or an outstanding receivable.

Customer Invoices 
Use Customer Invoices when you want to create an invoice that 
records inventory sales, track sales commissions, enter tax rates, enter 
a shipping date, and so on. You can also record service sales (such as 
consulting) with Customer Invoices by setting up a service as a non-
inventory Item (for details, see “Setting Up Items” on page 65).

Saving an invoice automatically updates the general ledger and creates 
an outstanding receivable. Use Customer Payments to record the 
amount a customer pays against the invoice.

Note Before an inventory or non-inventory item can be sold in Customer 
Invoices, the item should have been set up on the Items window. For 
more details, see "Setting Up Items" on page 65.

Important Do not use Customer Invoices to enter outstanding receivables dated 
prior to your Current fiscal year. Use the Sales Journal to enter these 
outstanding receivables when setting up your company with 
MultiLedger.

Customer Invoices Field Descriptions
This section discusses the individual fields on Customer Invoices.

Quote When you save a Customer Invoice with Quote checked, the transaction 
does not affect the General Ledger, and can be modified, deleted, or 
converted to a Customer Invoice at any time. For more details on 
working with Quotes, see "Quotes" on page 161.

Recurring If you have Customer Invoices that occur on a regular basis, you can 
save them with Recurring checked. You can define the frequency for a 
recurring entry and have MultiLedger remind you when the transaction 
should be created. For more details on working with recurring entries, 

Print on Save If checked, the Print dialog box appears immediately after an invoice is 
saved.

Modify Item
Description

If checked, when item is selected, you get a text box in which you can 
change description or add to it. This can be selected or de-selected for 
individual line items on the an invoice.The modified item will appear as 
changed on the invoice, in the transaction journal and in the General 
Ledger.
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Invoice # Enter an invoice number up to eight characters long to identify the 
invoice. The last character must be a number. 

After the invoice is saved, the invoice number (or last number of a 
combination of characters) is automatically increased by one.

You can have MultiLedger automatically warn you if you attempt to 
save a transaction with a duplicate document number by checking 
Check for Duplicate Documents on Preferences under the File menu. 
For more details, see "Setting Program Preferences" on page 76.

Customer Select a customer from the pop-up list. The customer’s address, 
Discount Percentage, and notes set up for the customer are entered 
automatically too. Notes appear during transaction entry, but do not 
print on the invoice. If the pop-up list does not appear, customers have 
not yet been set up.

You can add a new customer or edit existing customer information 
without closing the Customers pop-up list by clicking New (Alt-N on 
Windows or aN on Macintosh) or Edit (Alt-E on Windows or aE on 
Macintosh).

Any Discount % set up for a customer will reduce the Selling Price for 
each item sold by the percentage shown.

Ship To Once a customer name is entered, you can select an existing or add a 
new shipping address to this invoice by clicking anywhere in the Ship 
To box. The following edit box appears:

Enter a Ship To address, then click Save. Ship to addresses appear in the 
order in which they are entered. To use a Ship To address on this 
invoice, select the address in the list, then click Use.   
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After you click Use, the information is entered into the invoice, and the 
cursor moves to the Date field. To not enter a Ship To address, click in 
the Ship To box, then click Cancel. To remove a Ship To address from 
an invoice, click in the Ship To box, then click Cancel. 

Important You can modify existing addresses if necessary, but it’s best not to 
Delete Ship To addresses. 

Date Simply type over the highlighted day or use the +/- keys on your 
keyboard to increment/decrement the date. You can enter a date from 
the 30 open months, provided the month isn’t locked, in the form MM/
DD/YY.

The invoice date, along with any selected terms, determine the invoice’s 
due and discount dates.

Statement Description Enter a description up to 25 characters long. You could enter a purchase 
order number or some other reference number. The description will 
print on a customer statement but not on the invoice. If you don’t enter 
a description, the customer name will be automatically copied to this 
field when you save the invoice. 

Sales Tax Select a Sales Tax category from the pop-up list. If the pop-up list does 
not appear, sales tax categories have not yet been set up.

You can have up to two sales tax categories per invoice. The first sales 
tax field could be used for a provincial tax and the second sales tax field 
could be used for harmonized tax. If no tax should be applied, click 
Cancel in the pop-up list. These tax rates only apply to items that have 
been set up with Taxable Rates 1 and 2 checked and to shipping if the 
checkbox is selected.

You can set up default sales tax categories for your customers that will 
be selected automatically when you reach the Sales Tax pop-up list. The 
second Sales Tax field is skipped automatically unless you uncheck the 
“Skip Tax 2 During Invoice Entry” option on Preferences under the File 
menu.

If “Include Tax 1 in Tax 2 Computation” is checked on Preferences, the 
calculated tax value in the second Sales Tax field includes the amount 
in Tax 1, as well the amount of all items on the invoice. 

Taxable If checked, the shipping amount will be included in the sales tax 
calculation.
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Ship Chg If shipping is charged to a customer, enter a dollar amount.

To account for a shipping charge in your chart of accounts, set up the 
account using Chart of Accounts, and then assign it to the Shipping 
Charged on Interface Accounts.

Terms Select the terms from the pop-up list. If the pop-up list does not appear, 
terms have not yet been set up.

You can choose default terms for your customers on Customer Setup 
that will be selected automatically when you select the customer from 
the pop-up list.

Terms determine the discount date and when payment is due for the 
invoice. If terms are not entered, the invoice’s date becomes the due 
date.

Ship Date The Ship Date is filled in automatically with the invoice date. If 
necessary, enter a new date.

Salesperson Select the salesperson from the pop-up list. If the pop-up list does not 
appear, salespeople have not yet been set up.

You can choose a default salesperson for a customer on Customer Setup 
that will be selected automatically when you reach the Salesperson pop-
up list.

Sales of commissionable items appear on Salespeople reports.

Order # Enter a purchase order number up to 13 characters long.

Ship Via Select the Ship Via method from the pop-up list. If the pop-up list does 
not appear, shipping methods have not yet been set up.

You can either enter a name from this pop-up list or click Cancel in the 
pop-up list box and type a 13 character name that’s not in the Ship Via 
list. If you type the Ship Via method in, MultiLedger won’t save the 
Ship Via method for future use. 

Item Select the item from the pop-up list. If the pop-up list does not appear, 
items have not yet been set up.

You can add a new item or edit information for an existing item without 
closing the Items pop-up list by clicking New (Alt-N on Windows or 
aN on Macintosh) or Edit (Alt-E on Windows or aE on Macintosh).

Note By selecting the option to Modify Item Description, you can change or 
enter additional text in the item description line. This text will show on 
an invoice and in the transaction joural reports.
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Important If the item you select does not have a sales account (in the 4000 range) 
assigned to it when you save the invoice, MultiLedger warns you that 
the sale will be incorrectly posted to the first account in your chart of 
accounts (usually the cash account). You should assign the correct sales 
account to the item on Item Setup, then you should modify the invoice 
and resave it in order for it to post to the correct account. 

Job Select a job from the pop-up list. If the Jobs pop-up list does not appear, 
no jobs have been set up, or Skip Jobs (Ctrl-K on Windows or aK on 
Macintosh) under the Edit menu is checked.

Quantity Enter a quantity that is up to seven digits to the left of the decimal point 
and three digits to the right (9999999.999).

MultiLedger warns you if you attempt to sell more of an item than you 
have on hand. If you enter a quantity that is greater than what you have 
on hand for the item, the following alert appears:

Click Yes to accept the quantity entered or click No to return to the 
invoice so that you can change the amount.

Selling Price When the cursor enters the Selling Price field, the selected item’s 
Selling Price, as defined on Item Setup, is entered and highlighted 
automatically. You can have up to three different selling prices per item. 
You can also assign a default pricing level to your customers. That way, 
the correct pricing level is entered automatically for the selected 
customer. If the customer on this invoice does not have a default pricing 
level assigned, Selling Price 1 is used. 

You can change the Selling Price for a particular invoice by editing the 
highlighted amount. If you want to permanently change the Selling 
Price associated with a particular item, you should change the Selling 
Price on Item Setup.
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Unit Cost When the cursor enters the Unit Cost field, the selected inventory item’s 
Average Unit Cost, as defined on Item Setup, is entered and highlighted 
automatically. You can enter a unit cost up to six places to the left and 
four places to the right of the decimal point (999999.9999). 

The Unit Cost shown here is used to cost the inventory item when the 
invoice is saved. The cost of the item is a calculation based on Quantity 
times Unit Cost. When you save the invoice, the Cost Account assigned 
on Item Setup is increased (debited) and the Inventory account is 
decreased (credited).

If you change the Unit Cost on Customer Invoices, the Average Unit 
Cost for the inventory item is automatically adjusted for future invoices. 

If the item’s quantity on hand is greater than zero, then the Avg Unit 
Cost is used as the Unit Cost to cost the item. 

If the item’s quantity on hand is less than or equal to zero, then the Last 
Unit Cost is used as the Unit Cost to cost the item. 

Note Please note that you can hide the Unit Cost field on customer invoices 
by checking Hide Unit Cost in Customer Invoice on Preferences under 
the File menu. For more details on this option, please see "Setting 
Program Preferences" on page 76.

Amount When the cursor enters the Amount field, the amount will be calculated 
automatically based on Quantity times Selling Price. 

New Line
(Windows Only)

To enter another detail line to the invoice, click New Line or press 
ENTER.

Invoice Total This shows the total for the invoice as you add items to the invoice. 
When you save the invoice, the Invoice Total amount increases the 
Accounts Receivable account assigned on Interface Accounts.
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Recording a Sale with Customer Invoices
1 Click Customer Invoices in the Command Center.

Invoice number must
end in a number

Click in the Ship To field
to add a ship to address
or select an existing one

 Press TAB or RETURN

(Macintosh) or Press
New Line or ENTER

(Windows)after the
Amount field to add

another detail line to the
invoice

Information entered here prints on a
customer statement, but not on the invoice

Check Taxable to have
sales tax calculate on

the shipping amount
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2 If necessary, enter or change the invoice number, press TAB.

The Customers pop-up list appears:

3 Select a customer from the pop-up list, and press TAB.

For details about using pop-up lists, see "Using Pop-Up Lists" on page 
112.

Note After selecting a customer, you can see the customer’s transaction 
history by clicking on the History button at the top of the window. The 
current date is used as the Cutoff Date for the report. 

Click the window’s close box to close it and return to Customer 
Invoices.
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4 Continue filling in the rest of the fields with the appropriate 
information.

For field explanations, see "Customer Invoices Field Descriptions" on 
page 133.

Note You can add comment lines to the invoice at any time by choosing Insert 
Line from the Edit menu (Ctrl-I on Windows or aI on Macintosh). You 
can also add additional description to the Item description line. For 
more details, see "Adding Comment Lines to Transactions" on page 
119.

5 After you have entered an item, quantity, selling price, and amount, 
press TAB to add the item to the invoice.

As you add items to the invoice, the Invoice Total field is updated:

After the first item is added, the Save button is enabled.

Important If the item you select does not have a sales account (in the 4000 range) 
assigned to it when you save the invoice, MultiLedger warns you that 
the sale will be incorrectly posted to the first account in your chart of 
accounts (usually the cash account). You should assign the correct sales 
account to the item on Item Setup, then you should modify the invoice 
and resave it in order for it to post to the correct account.

6 On Windows, if necessary, click New Line or press ENTER to begin 
entering another item.

On Macintosh, if necessary, press TAB or RETURN again to begin 
entering another item.

7 When you are finished entering all the information for the document, 
click Save.

If the Invoice Total exceeds the customer’s credit limit, an alert 
appears allowing you to continue to save or cancel.

After the invoice is saved, the transaction is automatically posted to the 
general ledger, and the invoice number is increased by one.
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Printing a Customer Invoice
MultiLedger offers you two ways to print an invoice:

• Check “Print on Save” on the Customer Invoice window. 
When you save an invoice, a standard Print dialog box 
appears. Select your print options and click OK or Print.
or

• Use the Print on the Command Center. After saving a 
Customer Invoice, do the following:

1 Click Print from the Command Center. 

2 Select the correct month.

3 Click the Customer Invoices & Quotes radio button.

4 From the list of documents, select the invoices that you want to print. 

If no invoices are highlighted, all invoices and quotes for the selected 
month will be printed. 

5 If necessary, check Print Metafile (Windows) or Print PDF/PICT File 
(Macintosh).

For more information on using Metafiles or PDF/PICT Files, see 
“Using the Print Screen” on page 90.

6 Click Print.

7 Select your print options and click OK or Print.

For more details about the Print command, see "Using the Print 
Screen" on page 90.

Note MultiLedger’s flexibility allows you to adjust where the Customer 
Invoice fields print on an invoice form. For more information, see 
"Customizing Print Field Positions for Your Printer" on page 95.

Note MultiLedger also prints packing slips based on Customer Invoices. 
Packing slips contain most customer invoice information except dollar 
amounts. For more information on printing packing slips, see "Using 
the Print Screen" on page 90.

Modifying or Deleting an Invoice
When the cursor is in the Invoice # field, the Modify button is enabled. 
Click Modify to see a list of Customer Invoices that you can modify or 
delete. If the Customer Invoice you’re looking for doesn’t appear, you 
may have to select another month from the pull-down menu.
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Sales Journal
Use the Sales Journal when you want to create an invoice that records 
sales that do not involve inventory, such as service sales or consulting, 
and creates an outstanding receivable. If you need to record inventory 
sales, use Customer Invoices. Sales tax and shipping amounts are not 
automatically calculated in the Sales Journal, but can be added as detail 
lines.

Saving a Sales Journal invoice automatically updates the general 
ledger and creates an outstanding receivable. You can use Customer 
Payments to record the amount a customer pays against the invoice.

Note When setting up your company with MultiLedger, you should use the 
Sales Journal to enter outstanding receivables that are dated prior to 
your Start Month. An outstanding receivable will be created without 
affecting the general ledger account balances. For more information, 
see "Setting Up Prior Outstanding Receivables" on page 30.

Sales Journal Field Descriptions
This section discusses the individual fields on the Sales Journal. 

Quote When you save a Sales Journal invoice with the Quote option checked, 
the transaction does not affect the General Ledger, and can be modified, 
deleted, or converted to a Sales Journal invoice at any time. For more 
details on working with Quotes, see "Quotes" on page 161.

Recurring If you have Sales Journal invoices that occur on a regular basis, you can 
save them with Recurring checked. You can define the frequency for a 
recurring entry and have MultiLedger remind you when the transaction 
should be created. For more details on working with recurring entries, 
see "Recurring Entries" on page 124.

Invoice # Enter an invoice number up to eight characters long to identify the 
invoice. The last character must be a number. 

After the invoice is saved, the invoice number (or last number of a 
combination of characters) is automatically increased by one.

Customer Select a customer from the pop-up list. The customer’s name, address, 
and any notes set up for the customer are entered automatically too. 
Notes appear during transaction entry, but do not print automatically on 
the invoice.

You can add a new customer or edit existing customer information 
without closing the Customers pop-up list by clicking New (Alt-N on 
Windows or aN on Macintosh) or Edit (Alt-E on Windows or aE on 
Macintosh).
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You can have the Notes and Add’l Notes you’ve set up for a customer 
print on Sales Journal invoices by selecting “Print Customer Notes on 
Sales Journal” on Preferences under the File menu.

Date Simply type over the highlighted day or use the +/- keys on your 
keyboard to increment/decrement the date. You can enter a date from 
the 30 open months, provided the month isn’t locked, in the form MM/
DD/YY.

The invoice date, along with any selected terms, determine the invoice’s 
due and discount dates.

Statement Description Enter a description up to 25 characters long. You could enter a purchase 
order number or some other reference number. The description will 
print on a customer statement but not on the invoice. If you don’t enter 
a description, the customer name will be automatically copied to this 
field when you save the invoice.

Terms Select the terms from the pop-up list. If the pop-up list does not appear, 
terms have not yet been set up.

You can choose default terms for your customers on Customer Setup 
that will be selected automatically when you reach the Terms pop-up 
list.

Terms determine the discount date and when payment is due for the 
invoice. If terms are not entered, the invoice’s date becomes the due 
date.

Ledger Account Select the ledger account from the pop-up list. For more information on 
using pop-up lists, see "Using Pop-Up Lists" on page 112.

When you save the invoice, the account entered here is increased by the 
amount for the detail line. Usually, this is an income account in the 
4000–4999 range.

Job Select the job for this detail line from the pop-up list. If the Jobs pop-up 
list does not appear, no jobs have been set up, or Skip Jobs (Ctrl-K on 
Windows or aK on Macintosh) under the Edit menu is checked.

Description When the cursor enters this field, the customer’s name is automatically 
copied to it and highlighted.

You can enter up to 25 characters of descriptive text for a particular 
detail line in the invoice. The text entered in the Description field prints 
on invoices along with the amount (unlike the Statement Description 
field, which prints just on customer statements).

Amount Enter an amount for the detail line. If the amount has zero cents, you 
don’t have to enter .00.
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New Line
(Windows Only)

To enter another detail line to the invoice, click New Line or press 
ENTER.

Invoice Total This shows the total for the invoice as you add detail lines to the 
invoice’s detail list. When you save the invoice, the Invoice Total 
amount increases the Accounts Receivable account in the General 
Ledger.

Recording a Sale with the Sales Journal
1 Click Sales Journal in the Command Center.

Invoice number must
end in a number

Information entered here prints on a customer
statement, but does not print on the invoice

 Press TAB or RETURN

(Macintosh), Press New
Line or ENTER

(Windows)after the
Amount field to add

another detail line to the
invoice
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2 If necessary, enter or change the invoice number.

The Customers pop-up list appears:

3 Select a customer from the pop-up list and press TAB.

For details about using pop-up lists, see "Using Pop-Up Lists" on page 
112.
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Note After selecting a customer, you can see the customer’s transaction 
history by clicking the History button at the top of the window. The 
current date is used as the Cutoff Date for the report. 

Click the window’s close box to close it and return to the Sales Journal.

4 Continue filling in the rest of the fields with the appropriate 
information.

For field explanations, see "Sales Journal Field Descriptions" on page 
143.

Note You can add comment lines to the invoice at any time by choosing 
Insert Line from the Edit menu (Ctrl-I on Windows or aI on 
Macintosh). For more information, see "Adding Comment Lines to 
Transactions" on page 119.

5 After you have entered a ledger account (usually an income account in 
the 4000-4999 range) and amount (Job and Description are optional), 
press TAB to add the detail line to the invoice.

As you add detail lines to the invoice, the Invoice Total field is 
updated:

6 On Windows, if necessary, click New Line or press ENTER to begin 
entering another item.

On Macintosh, if necessary, press TAB or RETURN again to begin 
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entering another item.

7 When you’re finished entering all the information for the invoice, click 
Save.

If the Invoice Total exceeds the customer’s credit limit, an alert 
appears allowing you to continue to save or cancel.

When the invoice is saved, the transaction is posted automatically to 
the general ledger, and the invoice number is increased by one.

Printing a Sales Journal Invoice
Use Print on the Command Center to print Sales Journal invoices. 
After saving an invoice, do the following:

1 Click Print in the Command Center. 

2 Select the correct month from the list on the right.

3 Click the Sales Journal Invoices radio button.

4 From the list of documents, select the invoices that you want to print. 

If no invoices are highlighted, all invoices will be printed.

5 If necessary, check Print Metafile (Windows) or Print PDF/PICT File 
(Macintosh).

For more information on using Metafiles or PICT Files, see "Using 
Pop-Up Lists" on page 112.

6 Click Print.

7 Select your print options and click OK or Print.

For more details about the Print command, see "Using the Print 
Screen" on page 90.

Note MultiLedger’s flexibility allows you to adjust where the invoice fields 
print on an invoice form. For more information, see "Customizing Print 
Field Positions for Your Printer" on page 95.
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Modifying or Deleting Sales Journal 
Invoices
When the cursor is in the Invoice # field, the Modify button is enabled. 
Click Modify to see a list of Sales Journal invoices that you can modify or 
delete. If the Sales Journal invoice you’re looking for doesn’t appear, you 
may have to select another month from the pull-down menu. 

Receipts Journal
You can use the Receipts Journal to record a deposit that is the result of 
income not associated with an accounts receivable transaction. You 
can also record miscellaneous deposits, such as bank interest or a 
refund that you’ve received. Please note that because you can’t 
associate a Receipts Journal deposit with a customer name, deposits 
entered with the Receipts Journal do not affect customer transaction 
history.

Note Customer payments against outstanding invoices should be recorded in 
Customer Payments.

Receipts Journal Field Descriptions
The following section discusses the individual fields in Receipts 
Journal. 

Recurring If you have Receipts Journal transactions that occur on a regular basis, 
you can save them with the Recurring option checked. You can define 
the frequency for a recurring entry and have MultiLedger remind you 
when the transaction should be created. For more details on working 
with recurring entries, see "Recurring Entries" on page 124.

Print on Save If checked, the program will print a deposit slip with the total amount of 
the receipt. For more information on printing deposit slips, see “Using 
the Print Screen” on page 90.

Cash Account The account shown will be increased by the Deposit Total when you 
save the document. This account is initially the account number that was 
assigned to the Cash Account on Interface Accounts. To change 
accounts, click the account shown and select another cash account from 
the pop-up list of accounts. 

Deposit # Enter a document number up to eight characters long to identify the 
receipt. The last character must be a number. 

After the deposit is saved, the deposit number (or last number of a 
combination of characters) is automatically increased by one.

Description Enter a description up to 25 characters long. A description must be 
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entered before the transaction can be saved.

Date Simply type over the highlighted day or use the +/- keys on your 
keyboard to increment/decrement the date. You can enter a date from 
the 30 open months, provided the month isn’t locked, in the form MM/
DD/YY.

Ledger Account Select a ledger account from the pop-up list. For more information on 
using pop-up lists, see "Using Pop-Up Lists" on page 112.

When you save the receipt, the account entered here is increased by the 
amount for the detail line. Usually, this is an income account in the 
4000–4999 range.

Job Select a job for this detail line from the pop-up list. If the Jobs pop-up 
list does not appear, no jobs have been set up, or Skip Jobs (CTRL - K on 
Windows or aK on Macintosh) under the Edit menu is checked.

Description When the cursor enters this field, the description for the deposit is 
automatically copied to it and highlighted.

You can enter up to 25 characters of descriptive text for a particular 
detail line on the deposit. 

Amount Enter an amount for the detail line. If the amount has zero cents, you 
don’t have to enter .00.

New Line
(Windows Only)

To enter another detail line to the deposit, click New Line or press 
ENTER.

Cash Balance This shows the current balance (from the general ledger) for the account 
listed for Cash Acct.

You can hide the Cash Balance on this window by choosing Hide Cash 
Balance on Preferences (under the File menu).

Deposit Total This shows the total for the deposit as you add detail lines to the deposit. 
When you save the deposit, the Deposit Total amount increases the 
account selected for Cash Acct.
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Recording a Deposit with the Receipts 
Journal

1 Click Receipts Journal in the Command Center.

2 If necessary, enter or change the deposit number.

The cursor moves to the Description field.

3 Type in a description for this deposit.

4 Verify that the date for the deposit is correct.

5 Select a cash account for the deposit.

When you open the Receipts journal, the default cash account assigned 
on Interface Accounts is shown.

To change cash accounts, click in the box and select an account from 
the pop-up list.

For details about using pop-up lists, see "Using Pop-Up Lists" on page 
112.

Click in the box to
change cash accounts

Press New Line or
ENTER (Windows) or TAB

or RETURN (Macintosh)
after the Amount field to

add another detail line to
the invoice
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6 Continue filling in the rest of the fields with the appropriate 
information.

For field explanations, see "Receipts Journal Field Descriptions" on 
page 149.

Note You can add comment lines to the transaction at any time by choosing 
Insert Line from the Edit menu (CTRL - I on Windows or aI on 
Macintosh). For more information, see "Adding Comment Lines to 
Transactions" on page 119.

7 After you’ve entered a ledger account (usually this is an income 
account in the 4000-4999 range) and amount (Job and Description are 
optional), press TAB to add the detail line to the deposit.

As you add detail lines to the deposit, the Deposit Total field is 
updated.

8 On Windows, if necessary, click New Line or press ENTER to begin 
entering another item.

On Macintosh, if necessary, press TAB or RETURN again to begin 
entering another item.

9 When you are finished entering all the information for the transaction, 
click Save.

When the transaction is saved, it is posted automatically to the general 
ledger, and the deposit number is increased by one.

Modifying or Deleting Receipts Journal 
Documents
When the cursor is in the Deposit # field, the Modify button is enabled. 
Click Modify to see a list of Receipts Journal transactions that you can 
modify or delete. If the transaction you’re looking for doesn’t appear, 
you may have to select another month from the pull-down menu. 
Please note that the transactions that appear here also include deposits 
recorded in Customer Payments. For more details, see "Modifying or 
Deleting a Transaction" on page 120.



The Customer Payments Window 153

The Customer Payments Window
You can use Customer Payments for any of the following situations:

• You need to record a deposit consisting of payments for 
outstanding receivables, such as invoices or finance charges.

• A customer fails to pay an invoice or finance charge, and you want 
to record this as a bad debt or reverse the original sale.

• A customer overpays an invoice and you want to record the 
overpayment and keep the credit balance to apply to future 
invoices.

• You need to apply the amount of an advance deposit to an 
outstanding invoice.

• An outstanding receivable dated prior to your current open months 
was entered incorrectly when your company was set up with 
MultiLedger.

• You need to write a refund cheque for a customer credit.

Customer Payments Field Descriptions
This section describes the fields on Customer Payments.

Cash Acct The cash account assigned on Interface Accounts is shown. You can 
change the cash account by clicking the account number or name and 
selecting a new account from the pop-up list.

Disc/Adj Acct You can change the discount or adjustment account by clicking the 
account number or name and selecting a new account from the pop-up 
list.

This account can be used to record customer discounts or to reverse an 
original sale, and is typically not the Accounts Receivable account. 
Once you’ve selected an account as the Disc/Adj Acct, you can change 
the account, but you cannot remove it.

Deposit # Enter a document number up to eight characters long to identify the 
invoice. The last character must be a number. 

After the deposit is saved, the invoice number (or last number of a 
combination of characters) is increased automatically by one.

Date Simply type over the highlighted day or use the +/- keys on your 
keyboard to increment/decrement the date. You can enter a date from 
the 30 open months, provided the month isn’t locked, in the form MM/
DD/YY.
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Statement Desc The information that appears here is the text that was entered for 
Statement Description on Customer Invoices or the Sales Journal . The 
text appears for reference purposes only; you cannot modify the text on 
this window. To change the information that appears here, you should 
modify the original invoice using Customer Invoices or the Sales 
Journal.

Total Paid As you apply payments, the Total Paid field shows the total for the 
deposit.

Total Discount As you apply discounts, the Total Discount field shows the total 
discounted for the deposit. This will be the total amount recorded to the 
account you selected in the Disc/Adj Acct field.

Cash Balance This field shows the general ledger balance for the selected Cash Acct.

Print Deposit Slip on
Save

If checked, it will print a deposit slip with up to 18 individual invoices 
when you click Save. You can include more than 18 invoices per 
deposit slip, but invoices over 17 will appear as one lump sum, rather 
than individual invoices. For more information on printing deposit slips, 
see “Using the Print Screen” on page 90.

Refund When you select a credit amount in the list, the Refund button is 
enabled. For more information on writing a refund cheque to a 
customer, see "Writing a Refund Cheque for the Customer Credit" on 
page 167.

Recording Customer Payments
When you save customer payments as a deposit, MultiLedger increases 
the selected cash account and decreases your accounts receivable 
account (as assigned on Interface Accounts) by the amount of the 
deposit. While an individual deposit can have only one cash account 
and one discount/adjustment account, you can choose different cash 
accounts and different accounts for any discounts or adjustments for 
separate deposits.
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1 Click Customer Payments in the Command Center.

For field explanations, see "Customer Payments Field Descriptions" on 
page 153.

2 Select a cash account for the deposit.

When you open Customer Payments, the default cash account assigned on 
Interface Accounts is shown.You can change the cash account by clicking the 
account number or name and selecting a new account from the pop-up list.

3 If necessary, select an account for any discounts or adjustments.

You can add or change the discount or adjustment account by clicking 
the account number or name and selecting a new account from the pop-
up list (if no account is shown, click just to the right of the Disc/Adj 
Acct label). Once you’ve selected an account as the Disc/Adj Acct, you 
can change the account, but you cannot remove it.

List of outstanding
receivables and

credits

Choose to sort the
list by due date,

name, document
number or term

Click in the boxes to change accounts for
the deposit or adjustment

This column shows
terms. You can sort
by term to pay all of

the same type of
invoices together
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4 If necessary, enter or change the deposit number.

After the deposit is saved, the deposit number (or last number of a 
combination of characters) is increased automatically by one.

5 Verify that the deposit date is correct.

6 Select the invoice that’s been paid.

You can sort the receivables by date, name, document number or term 
by clicking the appropriate option in the drop down menu.

When you select an outstanding receivable, the customer name, due 
date, discount date, invoice total, and discount or adjustment (if any) 
automatically fill in the appropriate fields above the outstanding 
receivables list.

7 If you want to print a deposit slip with MICR information, be sure you 
have “Print Deposit Slip on Save” checked. 

When you click Save, you will get a print dialog to print the deposit 
slip. For information on setting up the Deposit Slip with MICR 
information, see “Using the Print Screen” on page 90.

Note A deposit slip will print and total up to 17 individual invoices. If there 
are more than 17 invoices on a deposit, invoices over 17 will appear as 
one lump sum, rather than individual invoices. For more information, 
see “Using the Print Screen” on page 90.

If the deposit date is later than the invoice’s discount date, the 
following dialog appears:

Click Yes to still apply the discount to the invoice.

Click No to not apply the discount.
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Note To apply full payment quickly without any discount or adjustment, hold 
down the Control key (Ctrl) on Windows or the Command key (a) on 
Macintosh while you click the outstanding receivable. The amount due 
will be listed automatically as the amount paid. You could then go to 
step 9, skipping steps 7 and 8.

8 If necessary, edit the highlighted amount in the Amt Paid edit box to 
match the actual customer payment and press TAB.

The cursor moves to the Disc/Adjust edit box:

9 If necessary, change or enter any discount amount or adjustment and 
press TAB.

After the payment and discount are applied, the payment is added to 
the Total Paid field for the deposit, the discount is added to “Total 
Discount” field and the Save button is enabled.

Note If you find that you’ve made a mistake, you can easily correct it before 
saving the deposit. See “Modifying or Deleting Payments Before 
Saving a Deposit” on page 159

After entering any
adjustment or discount,
press TAB to apply the

payment
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10 Continue recording the payments for the deposit. After the amount 
shown for Total Paid matches the amount of the deposit that you are 
making, click Save.

When you save the deposit, the Total Paid amount and any discounts or 
adjustments increase the accounts that you selected.

Note If you discover a payment error after saving the deposit, see "Modifying 
or Deleting Payments After Saving a Deposit" on page 159.
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Modifying or Deleting Payments Before 
Saving a Deposit
If you’ve made a mistake (such as entering a payment incorrectly or 
entering a payment for the wrong invoice), you can quickly fix the 
problem before saving the deposit: 

1 Select the appropriate outstanding receivable.

2 Change the highlighted amount paid (or press DELETE or BACKSPACE 
to remove it), then press TAB.

3 If necessary, modify the amount in the Disc/Adjust edit box.

4 Press TAB to re-enter the modified payment (or remove the old one) on 
the line.

Modifying or Deleting Payments After 
Saving a Deposit
When you save a deposit using Customer Payments, MultiLedger uses 
the Receipts Journal to post the transaction to the general ledger. You 
can use the Receipts Journal to modify or delete the deposit that 
contains the incorrect customer payment. Customer Payments and the 
general ledger will automatically be updated to reflect the change.

To modify or remove a payment from a saved deposit:

1 Click Receipts Journal in the Command Center, and click Modify.

Please note that the list of deposits that appears also contains any 
deposits made in the Receipts Journal. 

2 Select the deposit from the transactions list. 

If the transaction you’re looking for doesn’t appear, you may have to 
select another month from the pull-down menu. 

3 Modify the payment amount for a detail line or enter 0.00 in the 
Amount edit box to remove a payment from the deposit. 

4 Press TAB to replace the detail line in the list, then click Save. 

The invoice associated with the payment will again appear as 
outstanding on Customer Payments.

If you delete a deposit that was made in Customer Payments from the 
Receipts Journal, all the customer payments that made up the deposit 
will again appear as outstanding on Customer Payments.

For more details about modifying transactions, see "Modifying or 
Deleting Receipts Journal Documents" on page 152.
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When a Customer Fails to Pay an Invoice
If a customer fails to pay an invoice, you can remove the receivable in 
a way that records it as a bad debt or reverses the original sale. 

Using the Disc/Adjust account on Customer Payments to reverse a 
receivable or record the receivable as a bad debt gives you a complete 
audit trail. 

You can also delete the original receivable using Customer Invoices or 
the Sales Journal. Deleting the original invoice leaves no record of the 
transaction. For more information on deleting invoices, see 
“Modifying or Deleting an Invoice” on page 142 or see "Modifying or 
Deleting Sales Journal Invoices" on page 149.

1 Click Customer Payments in the Command Center.

2 Click just to the right of Disc/Adj Acct* and select an account for the 
bad debt (usually in the 6000-8999 range) or select the original sales 
account for the invoice from the pop-up list.

If a bad debt account is not listed, you can create one by following the 
steps in “Setting Up the Chart of Accounts” on page 22.

3 Select the unpaid invoice.

After selecting the invoice, the invoice’s amount appears in the Amt 
Paid edit box.

4 Press DELETE or enter zero in the Amt Paid edit box and press TAB.

This removes the amount from the Amt Paid edit box and moves the 
cursor to the Disc/Adjust edit box. With no amount or a zero amount 
entered for the Amt Paid field, saving the deposit will not affect your 
cash account.

5 Enter the amount of the receivable in the Disc/Adjust edit box and 
press TAB.

6 You could change the deposit number to an appropriate document 
number, such as “VD [date],” to indicate a void deposit.

7 Click Save.

Here’s how this procedure affects your books:

• MultiLedger increases the account selected for the Disc/Adj Acct 
field by the amount shown for the Disc/Adjust amount.

• MultiLedger decreases your accounts receivable account by the 
Disc/Adjust amount.

• The cash account selected for the “Cash Acct” field is not affected 
because a zero amount was entered for the “Amt Paid” field.
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Quotes
For quotes involving inventory, you should use Customer Invoices. For 
other quotes, you can use the Sales Journal. Saving an invoice as a 
Quote does not create an outstanding receivable and does not affect the 
general ledger until the quote is converted to an invoice. A quote can 
be modified, deleted, or converted to an invoice at any time.

Creating Quotes
1 Click Customer Invoices or Sales Journal in the Command Center.

2 Check the Quote check box.

3 Enter the Quote information as you normally would enter an invoice.

For detailed information on entering a Customer Invoice, see 
“Recording a Sale with Customer Invoices” on page 139. For detailed 
information on entering a Sales Journal invoice, see "Recording a Sale 
with the Sales Journal" on page 145. 

Note You may want to change the document number for Quotes, so as not to 
confuse them with actual Customer Invoices or Sales Journal invoices. 
For example, you could use “QU [document number],” to indicate a 
quote. The document number you enter the first time for a quote will 
automatically be incremented by one for each new quote you save.

4 Click Save. 

Working with Quotes
You can modify, delete, or convert a Quote to an invoice at any time.

1 Click Customer Invoices or Sales Journal in the Command Center.

2 Check the Quote check box.

3 Click Modify.

A list of Quotes entered with that journal appears. If the Quote you are 
looking for does not appear in the list, you may have to select a 
different month from the pull-down menu.

4 Select the Quote from the list, then click OK.

You have four options: Modify, Cancel, Delete, and Create Invoice/
Item Purchase.

Modify If you click Modify, you can change any information for the Quote. 
After you modify information, click Save to save the Quote with 
changes.
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Cancel If you click Cancel, you return to Customer Invoices or the Sales 
Journal.

Delete If you click Delete, the Quote is deleted, and you are returned to 
Customer Invoices or the Sales Journal.

Create Invoice/Item
Purchase

If you click Create Invoice/Item Purchase, an invoice is created using 
the information from the Quote and the following happens:

• The document number changes from the Quote document number 
to an invoice document number. The new invoice is one greater 
than the last invoice saved. 

• The date for the new invoice defaults to the last date saved. 

• The quote itself is deleted when you create an invoice from it. 

• You can modify anything on the new invoice before saving it. 

Printing Quotes
1 Click Print from the Command Center.

2 Select the month.

3 Select the Customer Invoices/Quotes or the Sales Journal Invoices/
Quotes radio button.

A list of available invoices and quotes appears. 

4 Select the quote(s) you wish to print.

If no quotes are highlighted, then all invoices and quotes will print.

5 If necessary, select Print Metafile (Windows) or Print PDF/PICT File 
(Macintosh).

6 Click Print.

A standard Print dialog appears.

For more details on using the Print command, see "Using the Print 
Screen" on page 90.

Note Quotes use the same format as Customer Invoices. You can, however, 
have a separate Metafile (Windows) or PDF/PICT File (Macintosh) for 
quotes. For information on using Metafiles or PDF/PICT Files, see 
"Positioning Print Fields for Windows Metafiles or Macintosh PDF or 
PICT Files" on page 98.
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Viewing Quotes
1 Click Transaction Journals in the Command Center.

2 Select a month from the month list box on the right.

3 Click the Quotes radio button.

4 Select the quote(s) you want to view, then click View.

If the quote you are looking for does not appear, you may need to 
select another month from the list.

Special Customer Situations

Recording Advance Deposits
Advance deposits are recorded in the Sales Journal. This section 
briefly shows you how to enter the minimal information for the 
advance deposit. For more details about entering information in the 
Sales Journal, see "Recording a Sale with the Sales Journal" on page 
145.

1 Click Sales Journal in the Command Center.

2 If necessary, enter or change the highlighted document number and 
press TAB.

3 Select a customer from the Customer pop-up list.

4 If necessary, change the date.

5 Select a cash account (in the 1000-1999 range) for the advance deposit 
from the Ledger Accounts pop-up list.

6 Enter a negative amount for the advance deposit.

The minus sign debits (increases) the selected cash account.

7 Click Save.

The advance deposit will appear on the Customer Payments window as 
a credit and can be applied as payment toward a future invoice.

Enter a negative amount for
an advance deposit



164 Chapter 7 Customer Transactions

Reversing a Receivable
If you want a complete audit trail, you can use the Disc/Adjust Acct on 
Customer Payments to reverse a receivable. 

Important If there is a payment associated with the receivable you want to reverse, 
you should delete the payment in the Receipts Journal before deleting 
or modifying the receivable.

You can also delete the original Customer Invoice or Sales Journal 
invoice. Deleting the original invoice leaves no record of the 
transaction. For more information on deleting invoices, see 
“Modifying or Deleting an Invoice” on page 142 or see "Modifying or 
Deleting Sales Journal Invoices" on page 149.

1 Click Customer Payments in the Command Center.

2 Select the Disc/Adj account.

Usually, this is the same sales account (4000–4999) that was used in 
the original sale, not the Accounts Receivable account.

3 Select the outstanding invoice.

4 Enter zero in the Amt Paid edit box and press TAB.

5 Enter the amount of the receivable in the Disc/Adjust edit box and 
press TAB.

6 You could change the deposit number to an appropriate document 
number, such as “VD [invoice #],” to indicate a void sale.

7 Click Save.

Recording Customer Credit Memos

Recording Customer Credit for Returned 
Inventory

1 Click Customer Invoices in the Command Center.

2 Enter the credit memo information.

You could enter an invoice number, such as CM[date], to help identify 
the credit memo. Follow the guidelines in “Recording a Sale with 
Customer Invoices” on page 139, except for the following fields:

Item Select the returned item from the Item pop-up list.
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Quantity Enter a negative quantity for the returned inventory:

Amount The Amount of the credit will show automatically as negative amount:

3 Press TAB to add the credit memo to the detail list, and then click Save.

The customer credit will appear on Customer Payments as a credit and 
can be applied as payment toward a current or future invoice.

Recording Other Customer Credit
1 Click Sales Journal in the Command Center.

2 Enter the credit memo information.

You could enter an invoice number, such as CM[date], to help identify 
the credit memo. Follow the guidelines in “Recording a Sale with the 
Sales Journal” on page 145, except for the following fields:

Ledger Account Select the sales account (in the 4000–4999 range) that was used to 
originally record the sale.

Amount Enter the credit as a negative amount like this:

3 Click Save.

The customer credit will appear on Customer Payments as a credit and 
can be applied as payment toward a current or future invoice, or you 
can write a refund cheque to the customer. For more information on 
these options, see the following section.

Applying Customer Credits

The credit amount is equal to the 
outstanding receivable amount

1 Click Customer Payments in the Command Center.
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2 Select the outstanding receivable and press TAB twice.

3 Select the customer’s credit memo (with a minus (-) sign) and press 
TAB twice.

The amount shown for Total Paid should be zero. 

4 Change the deposit number to an appropriate description.

5 Click Save.

Both the outstanding receivable and the credit memo are removed from 
Customer Payments. 

The credit amount is larger than the 
outstanding receivable amount

1 Click Customer Payments in the Command Center.

2 Select the outstanding receivable, and press TAB twice.

3 Select the customer’s credit memo (with a minus (-) sign), change the 
amount shown in the Amt Paid edit box to the amount of the 
outstanding receivable with a minus (-) sign, and press TAB twice.

For example, if the outstanding receivable amount is $250, you would 
enter “-250” in the Amt Paid edit box for the credit memo. The amount 
shown for Total Paid should be zero. 

4 Change the deposit number to an appropriate description.

5 Click Save.

The remaining credit amount appears on Customer Payments to be 
applied toward another outstanding receivable or refunded to the 
customer.

The credit amount is less than the 
outstanding receivable amount

1 Click Customer Payments in the Command Center.

2 Select the customer’s credit memo (with a minus (-) sign) and press 
TAB twice.

3 Select the outstanding receivable.

If the customer is paying the remainder of the outstanding 
receivable, simply press TAB twice. The Total Paid amount should 
equal the outstanding receivable amount minus the credit amount.
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If the customer is not paying the remainder of the outstanding 
receivable, and you just want to apply the credit amount, change 
the amount in the Amt Paid edit box to match the amount of the credit 
amount with no minus (-) sign. For example, if the credit amount is “-
100,” you would change the Amt Paid for the outstanding receivable to 
“100.” The Total Paid amount should be zero.

4 Change the deposit number to an appropriate description.

5 Click Save.

If the customer paid the remainder of the outstanding receivable, 
both the outstanding receivable amount and the credit amount are 
removed from Customer Payments.

If the customer did not pay the remainder of the outstanding 
receivable, the remaining outstanding receivable amount remains on 
Customer Payments to be paid later.

Writing a Refund Cheque for the Customer 
Credit

1 Click Customer Payments in the Center.

2 Select the customer’s credit memo (with a minus (-) sign) and press the 
Refund Button.

3 Verify that the cheque number and date are correct.
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4 If necessary, select the credit amount you want to refund. 

If the customer has more than one credit memo, all credit amounts 
appear in this window. You can write one cheque for all credit amounts 
listed by holding down the SHIFT key while clicking on each credit 
amount. The Refund Amount will show the total for all selected credits 
amounts. 

5 Click Create Cheque to write the refund cheque.

Click Cancel to return to Customer Payments without creating a refund 
cheque.

Refund cheques cannot be modified, but they can be deleted in the 
Disbursements Journal. For more information, see “Modifying or 
Deleting Disbursements Journal Documents” on page 193.

You can print the refund cheque using the Print command on the 
Command Center. For more information, see “Using the Print Screen” 
on page 90.

Calculating Finance Charges
You can calculate finance charges on outstanding customer invoices by 
using Finance Charges. You should create a new finance charge each 
month for past due invoices.

Note You could print out an aged accounts receivable report (on Customer 
Reports) to help identify outstanding receivables past their due dates.

Finance Charges Field Descriptions
The following section discusses the individual fields on Finance 
Charges.

Finance Charge Acct Select an account from the pop-up list of your chart of accounts. 
Usually, an income account in the 4000–4999 range is used for finance 
charges.

If you don’t find an appropriate income account for the finance charge, 
you can add one in Chart of Accounts. Make it an income account 
number in the 4000–4999 range and name the account “FC Income” or 
“Miscellaneous Income” or something similar. See “Setting Up the 
Chart of Accounts” on page 22 for more details on entering new 
accounts.

Ref # Enter a reference number up to eight characters long, including letters, 
numbers, spaces, and other symbols to identify the transaction (such as 
FC 1). Finance charge document numbers automatically increment by 
one.
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Description Enter a description up to 20 characters long, including letters, numbers, 
spaces, and other symbols.

Date Simply type over the highlighted day or use the +/- keys on your 
keyboard to increment/decrement the date. You can enter a date from 
the 30 open months, provided the month isn’t locked, in the form MM/
DD/YY.

% Rate % Rate is multiplied by the invoice’s Due Amt to determine the Charge. 
A new percentage rate should be entered before selecting an invoice, so 
the calculated finance charge correctly reflects the new % Rate.

Charge After an invoice is selected, the calculated finance charge (% Rate times 
Due Amt) is put into the Charge edit box.
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Recording Finance Charges
1 Click Finance Charges in the Command Center.

2 If necessary, click just to the right of “Finance Charge Acct” and select 
an income account for the finance charge (usually in the 4000–4999 
range) from the pop-up list.

If a finance charge income account is not listed, you can create one by 
following the steps in “Setting Up the Chart of Accounts” on page 22.

The income account selected will be increased when payment of the 
finance charge is recorded in Customer Payments.

3 If necessary, change or enter information for Ref#, Date, Description, 
and % Rate.

For field explanations, see "Finance Charges Field Descriptions" on 
page 168.

Note % Rate should be entered before selecting an invoice so that the 
calculated charge correctly reflects the % Rate. If the invoice is selected 
before entering a percentage rate, the amount of the charge will not 
reflect the new rate correctly.

Click in the box to
select an account

An asterisk means the
transaction previously
had a finance charge

applied
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4 Select the desired invoice from the outstanding receivable list.

You can sort the invoices by date or customer by clicking the appropriate Sort 
by radio button. 

After you’ve selected the invoice, the finance charge is automatically 
calculated (% Rate times Amount Due) and put in the Charge edit box. You 
can manually override the amount for the finance charge by typing an amount 
in the Charge edit box.

Entries that previously have had a charge applied are marked with an asterisk 
(*).

5 Press TAB to apply the finance charge to the selected invoice.

6 Repeat steps 4 through 5 for each finance charge.

7 After all the finance charges have been calculated and listed, click 
Save.

Finance charges appear on Customer Payments and Finance Charges as 
outstanding receivables, but do not affect the general ledger balance for the 
cash account or the finance charge income account until they are paid in 
Customer Payments.

After saving, receivables that have just had a finance charge applied are 
marked with a plus (+).

Select an invoice
line to

automatically
calculate the

finance charge

Finance charge = %Rate times Due Amt
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Recording Finance Charge Payments
When a customer pays a finance charge, you record it like any other 
customer payment in Customer Payments. See “Recording Customer 
Payments” on page 154 for more details. 

When you save the customer payment, the transaction increases the 
cash account that is chosen on Customer Payments and increases the 
account that was selected when the finance charge was created on 
Finance Charges. MultiLedger automatically uses the Receipts Journal 
to post the payment to the general ledger.

Deleting Finance Charges
If the finance charge hasn’t been saved yet on Finance Charges, you 
can select the finance charge, press the DELETE or BACKSPACE key on 
your keyboard (or choose Cut from the Edit menu), and then press TAB 
to remove the finance charge.

Once a finance charge has been saved, you can delete it, if necessary, 
on Customer Payments by selecting the appropriate finance charge line 
and click Delete. The following warning appears:

Click Yes to delete the finance charge. Click No to leave the finance 
charge on Customer Payments. Since the finance charge did not affect 
any general ledger balances when it was entered, it should not affect 
any general ledger balances when it is deleted. 

Important Deleting a finance charge from Customer Payments leaves no record of 
the deletion.
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Chapter 8
Vendor Transactions

This chapter discusses the following topics:

• Recording purchases

• Recording vendor payments, vendor credits, and refunds

• Writing cheques

• Handling special vendor situations
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Vendor Transactions Flowchart
The following flowchart is designed to give you a basic overview of 
vendor-based transactions. The rest of this chapter describes each 
option in detail.

Item Purchases

Create a payable for inventory items.
Create a purchase order.

Payables Journal

Create a payable for non-inventory items.

Vendor Payments

Create a check for Item Purchases or
Payables Journal.

Disbursements Journal

Vendor Payments are posted here.
Also use to record miscellaneous disburse-

ments or manual checks.

Bank Reconciliation

Shows checks from Vendor Payments and
Disbursements Journal.
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Recording Purchases
MultiLedger offers great flexibility for recording purchases. 
Depending on the type of purchase you want to record, the three 
windows you can use are:

• Item Purchases

• Payables Journal

• Disbursements Journal

These windows are discussed in the following table.

If you want to.... Use this transaction window

Record an inventory purchase for 
resale that creates an outstanding 
payable

Item Purchases

Record a purchase order Item Purchases

Record a non-inventory purchase that 
creates an outstanding payable

Payables Journal

Create outstanding payables that are 
dated prior to your Start Month (for 
setting up your company with 
MultiLedger)

Payables Journal

Record a cheque written for purchases 
not involving inventory or 
outstanding payables

Disbursements Journal



176 Chapter 8 Vendor Transactions

Item Purchases
Use Item Purchases when you want to record the purchase of inventory 
items for resale.

Saving an Item Purchase automatically updates your inventory, the 
general ledger, and creates an outstanding payable.

After item purchases are recorded, use Vendor Payments to create the 
cheque to pay the vendor.

Note Before an item can be purchased in Item Purchases window, the item 
should have been set up on Item Setup. For more details, see “Setting 
Up Items” on page 65.

Important Do not use Item Purchases to enter outstanding payables dated prior to 
your Current fiscal year. Use the Payables Journal to enter these 
outstanding payables when setting up your company with MultiLedger.

Item Purchases Field Descriptions
The following section discusses the individual fields on Item 
Purchases. 

Purchase Order When you save an Item Purchase with Purchase Order checked, the 
transaction does not affect the General Ledger, and can be modified, 
deleted, or converted to an Item Purchase at any time. For more details 
on working with Purchase Orders, see “Purchase Orders” on page 199.

Recurring If you have Item Purchases that occur on a regular basis, you can save 
them with the Recurring option checked. You can define the frequency 
for a recurring entry and have MultiLedger remind you when the 
transaction should be created. For more details on working with 
recurring entries, see “Recurring Entries” on page 124.

Modify Item
Description

If checked, when item is selected, you get a text box in which you can 
change description or add to it. This can be selected or de-selected for 
individual line items on the invoice.The modified item will appear as 
changed on the invoice, in the transaction journal and in the General 
Ledger.
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Document # Enter a document number up to eight characters long to identify the 
purchase. The last character must be a number. 

After the Item Purchase is saved, the document number (or last number 
of a combination of characters) is automatically increased by one.

You can have MultiLedger automatically warn you if you attempt to 
save a transaction with a duplicate document number by checking 
Check for Duplicate Documents on Preferences under the File menu. 
For more details, see “Setting Program Preferences” on page 76.

Vendor Select a vendor from the pop-up list. The vendor’s name, address, and 
notes (as saved on Vendor Setup) are automatically entered. If the pop-
up list does not appear, vendors have not yet been set up.

You can add a new vendor or edit existing vendor information without 
closing the Vendors pop-up list by clicking New (Alt-N on Windows or 
aN on Macintosh) or Edit (Alt-E on Windows or aE on Macintosh).

Date Simply type over the highlighted day or use the +/- keys on your 
keyboard to increment/decrement the date. You can enter a date from 
the 30 open months, provided the month isn’t locked, in the form MM/
DD/YY.

The invoice date, along with any selected terms, determine the 
payable’s due and discount dates.

Due Date Due Date, Discount Date, and Discount %, as defined on Vendor Setup, 
are shown under the Due Date label.

To change any of these values for a particular transaction, click the due 
date shown. The following dialog box appears:

Edit any of the entries and click OK. Click Cancel to keep the original 
values. You can also use Vendor Setup to change the terms for the 
Vendor.

Important Note: You cannot enter a Due Date more that 240 days from the date of 
the invoice.



178 Chapter 8 Vendor Transactions

Cheque Stub
Description

Enter a 25 character description that will print on a cheque stub when 
you pay for this purchase in Vendor Payments.

You could enter a vendor’s reference (invoice) number or other 
information to help the vendor identify the transaction when your 
payment is processed.

Tax Paid Enter any tax paid for the items purchased. 

To account for tax paid in your chart of accounts, set up an account for 
the tax on Chart of Accounts, and then assign it to Sales Tax Paid on 
Interface Accounts.

Shipping Enter the amount of shipping charged by the vendor.

To account for shipping paid in your chart of accounts, set up the 
account on Chart of Accounts, and then assign it to Shipping Paid on 
Interface Accounts.

Item Select the item from the pop-up list. If the pop-up list does not appear, 
items have not yet been set up.

You can add a new item or edit information for an existing item without 
closing the Items pop-up list by clicking New (Alt-N on Windows or 
aN on Macintosh) or Edit (Alt-E on Windows or aE on Macintosh).

Note By selecting the option to Modify Item Description, you can change or 
enter additional text in the item description line. This text will show on 
an invoice and in the transaction joural reports.

Job Select a specific job from the pop-up list for the detail line. If the Jobs 
pop-up list does not appear, no jobs have been set up, or Skip Jobs (Ctrl-
K on Windows or aK on Macintosh) under the Edit menu is checked.

Quantity Enter a quantity that is up to seven digits to the left and two digits to the 
right of the decimal point (9999999.99). If you have a Reorder Quantity 
setup for an item, that quantity will automatically fill this field when the 
item is selected.

Unit Cost When the cursor enters the Unit Cost field, the selected item’s Unit Cost 
as defined on Item Setup is entered and highlighted automatically.

You can change the Unit Cost for a particular purchase by editing the 
highlighted amount. You can enter a unit cost up to six places to the left 
and four places to the right of the decimal point (999999.9999).

When an inventory item is bought in Item Purchases, the Qty on Hand 
and Average Unit Cost of the item in inventory are adjusted to reflect 
new items added to those on hand. For more details, see “Item Setup 
Field Descriptions” on page 63.
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Amount When the cursor enters the Amount field, the amount will be 
automatically calculated based on Quantity times Unit Cost. Clicking in 
the Amount edit box will not automatically calculate the amount. You 
can change the amount by editing the highlighted value.

New Line
(Windows Only)

To enter another detail line to the Item Purchase, click New Line or 
press ENTER.

Total This shows the total for the Item Purchase as you add detail lines. When 
you save the document, the Total amount increases the Accounts 
Payable account and Inventory account assigned on Interface Accounts.

Recording a Purchase with Item 
Purchases 

1 Click Item Purchases in the Command Center.
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2 If necessary, enter or change the Document # and press TAB.

The Vendors pop-up list appears:

3 Select a vendor from the pop-up list and press TAB.

For details about using pop-up lists, see “Using Pop-Up Lists” on 
page 112.
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Note After selecting a vendor, you can see the vendor’s transaction history by 
clicking the History button at the top of the Item Purchase window.

The current date is used as the Cutoff Date for the report. Click the 
window’s close box to close it and return to the Item Purchases window.

4 Continue filling in the rest of the fields with the appropriate 
information.

For field explanations, see “Item Purchases Field Descriptions” on 
page 176.

Note You can add comment lines to the Item Purchases document at any time 
by choosing Insert Line from the Edit menu (Ctrl-I on Windows or aI 
on Macintosh). By selecting the option to Modify Item Description, 
you can also change or enter additional text in the item description line. 
This text will show on an invoice and in the transaction joural reports. 
For more details, see “Adding Comment Lines to Transactions” on 
page 119.

5 After you have entered an item, quantity, unit cost, and amount (Job is 
optional), press TAB to add the item to the document.

As you add detail lines to the document, the Total field is updated:

After the first detail line is added, the Save button is enabled.
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6 On Windows, if necessary, press New Line or click ENTER to begin 
entering another item to this document.

On Macintosh, if necessary, press TAB or RETURN to begin entering 
another item to this document.

7 When you are finished entering all the information for the document, 
click Save.

If the Total exceeds the vendor’s credit limit, an alert appears allowing 
you to continue to save or cancel.

After the document is saved, the transaction is automatically posted to 
the general ledger, and the Document # is increased by 
one.

Printing an Item Purchase
After saving an Item Purchase, do the following:

1 Click Print on the Command Center. 

2 Select the correct period.

3 Click the Item Purchases/PO’s radio button.

4 From the list of documents, select the purchases that you want to print. 

If no purchases are selected, then all purchases will print.

5 If necessary, check Print Metafile (Windows) or Print PDF/PICT File 
(Macintosh).

For more information on using metafiles or PICT Files, see “Using the 
Print Screen” on page 90.

6 Click Print.

7 Select your print options and click OK or Print.

For more details about the Print command, see “Using the Print 
Screen” on page 90.

Modifying or Deleting an Item Purchase
When the cursor is in the Document # field, the Modify button is 
enabled. Click Modify to see a list of Item Purchases that you can 
modify or delete. If the Item Purchase you’re looking for doesn’t 
appear, you may have to select another month from the pull-down 
menu. 
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Payables Journal
Use the Payables Journal to record a purchase that creates an 
outstanding payable that does not involve inventory. If you need to 
record inventory purchases, use Item Purchases. 

Saving a Payables Journal document automatically updates the general 
ledger and creates an outstanding payable.

After the payable is created, you can use Vendor Payments to create a 
cheque to pay the vendor.

Note When setting up your company with MultiLedger, you should use the 
Payables Journal to enter outstanding payables that are dated prior to 
your current open months. An outstanding payable will be created 
without affecting the general ledger account balances. For more 
information, see “Setting Up Outstanding Payables” on page 38.

Payables Journal Field Descriptions
This section discusses the individual fields on the Payables Journal. 

Recurring If you have Payables Journal transactions that occur on a regular basis, 
you can save them with Recurring checked. You can define the 
frequency for a recurring entry and have MultiLedger remind you when 
the transaction should be created. For more details on working with 
recurring entries, see “Recurring Entries” on page 124.

Document # Enter a document number up to eight characters long to identify the 
transaction. The last character must be a number. 

After the document is saved, the document number (or last number of a 
combination of characters) is automatically increased by one.

Vendor Select a vendor from the pop-up list. The vendor's name, address, and 
any notes set up for the vendor are entered automatically, too. If the 
pop-up list does not appear, vendors have not yet been set up.

You can add a new vendor or edit existing vendor information without 
closing the Vendors pop-up list by clicking New (Alt-N on Windows or 
aN on Macintosh) or Edit (Alt-E on Windows or aE on Macintosh).

Date Simply type over the highlighted day or use the +/- keys on your 
keyboard to increment/decrement the date. You can enter a date from 
the 30 open months, provided the month isn’t locked, in the form MM/
DD/YY.

The date, along with any selected terms, determine the payable’s due 
and discount dates.
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Due Date Due Date, Discount Date, and Discount %, as defined on Vendor Setup, 
are shown under the Due Date label.

To change any of these values for a particular transaction, click the due 
date shown. The following dialog box appears:

Edit any of the entries and click OK. Click Cancel to keep the original 
values. You can also use Vendor Setup to change the terms for the 
Vendor.

Important Note: You cannot enter a Due Date more that 240 days from the date of 
the invoice.

Cheque Stub
Description

Enter a 25 character description that will print on a cheque stub when 
you pay for this purchase in Vendor Payments.

You could enter a vendor’s reference (invoice) number or other 
information to help the vendor identify the transaction when your 
payment is processed.

Ledger Account Select the ledger account from the pop-up list. For more information on 
using pop-up lists, see “Using Pop-Up Lists” on page 112.

When you save the payable, the account entered here is increased by the 
amount for the detail line. Usually, this is an expense account in the 
6000–8999 range.

Job Select the job for this detail line from the pop-up list. If the Jobs pop-up 
list does not appear, no jobs have been set up, or Skip Jobs (Ctrl-K on 
Windows or aK on Macintosh) under the Edit menu is checked.

Description The vendor's name is automatically copied and entered here, unless you 
have the preference selected to “Use Cheque Stub Description in 
Payables Journal”. If you have the preference selected, the information 
you entered in the Cheque Stub Description field will automatically be 
entered in this field. Or you can enter up to 25 characters of descriptive 
text for specific detail in the invoice, see “Setting Program Preferences” 
on page 76.

Amount Enter an amount for the detail line. If the amount has zero cents, you 
don’t have to enter .00.
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New Line
(Windows Only)

To enter another detail line to the payable, click New Line or press 
ENTER.

Total This shows the total for the payable as you add detail lines to it. When 
you save the payable, the Total amount increases the account assigned 
to Accounts Payable on Interface Accounts.

Recording a Purchase with the Payables 
Journal

1 Click Payables Journal in the Command Center.

Document # must end
in a number

Comment line added
with Insert Line

command (Ctrl-I on
Windows or aI on

Macintosh)

Click in the Due Date field to
change the Due Date, Discount

Date, or Percentage.
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2 If necessary, enter or change the Document # and press TAB.

The Vendors pop-up list appears:

3 Select a vendor from the pop-up list and press TAB.

For details about using pop-up lists, see “Using Pop-Up Lists” on 
page 112.

Note After selecting a vendor, you can see the vendor’s transaction history by 
clicking the History button at the top of the Payables Journal window.
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The current date is used as the Cutoff Date for the report. Click the 
window’s close box to close it and return to the Payables Journal.

4 Continue filling in the rest of the fields with the appropriate 
information.

For field explanations, see “Payables Journal Field Descriptions” on 
page 183.

Note You can add comment lines to the payable at any time by choosing 
Insert Line from the Edit menu (Ctrl-I on Windows or aI on 
Macintosh). For more details, see “Adding Comment Lines to 
Transactions” on page 119.

5 After you have entered a ledger account (usually an expense account in 
the 6000-8999 range) and amount (Job and Description are optional), 
press TAB to add the detail line to the transaction.

As you add detail lines to the transaction, the Total field is updated:

After the first detail line is added, the Save button is enabled.

6 On Windows, if necessary, click New Line or press ENTER to begin 
entering another detail line. On Macintosh, if necessary, press TAB or 
RETURN again to begin entering another detail line.

7 When you’re finished entering all the information for the invoice, click 
Save.

If the Total exceeds the vendor's credit limit, an alert appears allowing 
you to continue to save or cancel.

When the payable is saved, the transaction is posted automatically to 
the general ledger, and the Document # is increased by 
one.

Modifying or Deleting Payables Journal 
Transactions
When the cursor is in the Document # field, the Modify button is 
enabled. Click Modify to see a list of Payables Journal transactions that 
you can modify or delete. If the Payables Journal transaction you’re 
looking for doesn’t appear, you may have to select another month from 
the pull-down menu.
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Disbursements Journal
With the Disbursements Journal you can create cheques for purchases 
that don’t involve inventory or accounts payable transactions. You can 
also record cheques that were written manually.

Saving a Disbursements Journal cheque automatically updates the 
general ledger.

Important Vendor Payments against outstanding payables should be recorded in 
Vendor Payments, not the Disbursements Journal.

Disbursements Journal Field Descriptions
The following section discusses the individual fields on the 
Disbursements Journal. 

Recurring If you have Disbursements Journal cheques that occur on a regular 
basis, you can save them with Recurring checked. You can define the 
frequency for a recurring entry and have MultiLedger remind you when 
the transaction should be created. For more details on working with 
recurring entries, see “Recurring Entries” on page 124.

Print on Save If checked, the Print dialog box appears immediately after a cheque is 
saved in the Disbursements Journal.

Cash Acct The account shown will be decreased by the Cheque Total when you 
save the cheque. This account is initially the account that was assigned 
to Cash Account on Interface Accounts. To change accounts, click the 
account shown and select another cash account from the pop-up list. 

Cheque # Enter a cheque number up to eight characters long to identify the 
disbursement. The last character must be a number. 

After the disbursement is saved, the cheque number is automatically 
increased by one.

Paid To A pop-up list of vendors appears. If the pop-up list does not appear, 
vendors have not yet been set up.

On Windows, you can either enter a name from this pop-up list or type a 25 
character name that’s not in the Vendor list and click “1 Time”. If the vendor name 
is typed in, MultiLedger won’t save the vendor name or track payments made to that 
vendor. To keep track of payments by vendor name, you must add the vendor on 
Vendor Setup.

On Macintosh, you can either enter a name from this pop-up list or click Cancel in 
the pop-up list box and enter a 25 character name that’s not in the Vendor list. If the 
vendor name is typed in, MultiLedger won’t save the vendor name or track payments 
made to that vendor. To keep track of payments by vendor name, you must add the 
vendor on Vendor Setup.



Disbursements Journal 189

Important You should not use the Disbursements Journal to pay outstanding 
payables you’ve entered in Item Purchases or the Payables Journal. 
Those payments should be made in Vendor Payments.

Date Simply type over the highlighted day or use the +/- keys on your 
keyboard to increment/decrement the date. You can enter a date from 
the 30 open months, provided the month isn’t locked, in the form MM/
DD/YY.

Ledger Account Select a ledger account from the pop-up list. For more information on 
using pop-up lists, see “Using Pop-Up Lists” on page 112.

When you save the cheque, the account entered here is increased by the 
amount for the detail line. Usually, this is an expense account in the 
6000–8999 range.

Job Select a job for this detail line from the pop-up list. If the Jobs pop-up 
list does not appear, no jobs have been set up, or Skip Jobs (Ctrl-K on 
Windows or aK on Macintosh) under the Edit menu is checked.

Description When the cursor enters this field, the name entered for Paid To is 
automatically copied to it and highlighted.

You can enter up to 25 characters of descriptive text for a particular 
detail line on the disbursement. The text entered here appears on the 
cheque stub and on reports.

Amount Enter an amount for the detail line. If the amount has zero cents, you 
don’t have to enter .00.

New Line
(Windows Only)

To enter another detail line to the cheque, click New Line or press 
ENTER.

Cash Balance This shows the current balance (from the general ledger) for the account 
listed for Cash Acct.

Cheque Total This shows the total for the cheque as you add detail lines to it. When 
you save the cheque, the Cheque Total amount decreases the account 
selected for Cash Acct.
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Recording a Cheque with the 
Disbursements Journal

1 Click Disbursements Journal in the Command Center.

2 If necessary, change the cash account for the cheque by clicking in the 
Cash Acct edit box and selecting another cash account from the pop-up 
list.

3 If necessary, enter or change the Cheque # and press TAB.

The cursor moves to the Paid To field.

Choose a ledger
account to record the

expense for cheque

Click in the box to
change cash accounts

Comment line added
with Insert Line

command (Ctrl-I on
Windows or aI on

Macintosh)
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4 On Windows, select a vendor from the pop-up list then press TAB, or 
type a name then click 1 Time.

If you select a vendor who owes any outstanding payables, an alert 
appears to remind you to pay outstanding payables in Vendor 
Payments.

If the 1 Time vendor is used, MultiLedger won’t save the vendor name 
or track payments made to that vendor. To keep track of payments by 
vendor name, you must add the vendor in Vendor Setup.

OR

On Macintosh, select a vendor from the pop-up list then press TAB, 
or click Cancel then enter a name manually.

If you select a vendor who owes any outstanding payables, an alert 
appears to remind you to pay outstanding payables in Vendor 
Payments.

If the vendor name is typed in manually, MultiLedger won’t save the 
vendor name or track payments made to that vendor. To keep track of 
payments by vendor name, you must add the vendor in Vendor Setup.

5 Verify that the date for the cheque is correct.

6 Select a ledger account for the cheque, enter an amount for the detail 
line, then press TAB to add the detail line to the cheque.

The Ledger Account is usually an expense account in the 6000–8999 
range. Entering a Job and Description are optional. As you add detail 
lines to the cheque, the Cheque Total field is updated.

After the first detail line is added, the Save button is enabled.

7 On Windows, if necessary, click New Line or press ENTER to begin 
entering another item.

On Macintosh, if necessary, press TAB or RETURN again to begin 
entering another item.

For field explanations, see “Disbursements Journal Field Descriptions” 
on page 188.

Note You can add comment lines to the transaction at any time by choosing 
Insert Line from the Edit menu (Ctrl-I on Windows or aI on 
Macintosh). For more details, see “Adding Comment Lines to 
Transactions” on page 119.
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8 When you are finished entering all the information for the cheque, 
click Save.

When the cheque is saved, it is automatically posted to the general 
ledger, and the cheque number is increased by one.

Printing Disbursements Journal Cheques
MultiLedger offers you two ways to print a Disbursements Journal 
cheque:

• Check “Print on Save” in the Disbursements Journal window. 
Whenever you save a cheque in the Disbursements Journal, a 
standard Print dialog box will appear. Select your print options 
and click OK or Print.

OR

• Use Print on the Command Center. After closing the 
Disbursements Journal window, do the following:

1 Click Print in the Command Center. 

2 Select the correct period.

3 Click the cheques radio button.

4 If necessary, check Print Metafile (Windows) or Print PDF/PICT File 
(Macintosh).

For more information on using Metafiles or PICT Files, see “Using the 
Print Screen” on page 90.

5 Select the cheques that you want to print. 

If no cheques are selected, then all cheques will print.

6 Click Print.

7 Select your print options and click OK or Print.

For more details about the Print command, see “Using the Print 
Screen” on page 90.

If you need to adjust where the fields print on a cheque, see 
“Customizing Print Field Positions for Your Printer” on page 95.
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Modifying or Deleting Disbursements 
Journal Documents
When the cursor is in the Cheque # field, the Modify button is enabled. 
Click Modify to see a list of Disbursements Journal cheques that you 
can modify or delete. If the cheque you’re looking for doesn’t appear, 
you may have to select another month from the pull-down menu.

Please note that the cheques that appear here also include cheques 
recorded in Vendor Payments. 
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Using the Vendor Payments Window
You can use Vendor Payments for any of the following situations:

• You need to write a cheque for an outstanding payable.

• You need to delete an outstanding payable dated prior to your 
current open months that was entered incorrectly when your 
company was set up with MultiLedger.

• You need to make an adjustment or write off an outstanding 
payable.

Vendor Payments Field Descriptions
This section describes the fields on Vendor Payments.

Cash Acct The default cash account assigned on Interface Accounts is shown. You 
can change the cash account by clicking the account number or name 
and selecting a new account from the pop-up list.

Disc/Adj Acct You can change the discount or adjustment account by clicking the 
account number or name and selecting a new account from the pop-up 
list. If no account is shown, click to the right of the Disc/Adj Acct label 
and select an account from the pop-up list.

This account can be used to record vendor discounts or to reverse an 
original payable, and is typically not the Accounts Payable account. 
Once you’ve selected an account as the Disc/Adj Acct, you can change 
the account, but you cannot remove it.

Cheque # Enter a document number up to eight characters long to identify the 
cheque. The last character must be a number. 

After the cheque is saved, the cheque number (or last number of a 
combination of characters) is increased automatically by one.

Cheque Date Simply type over the highlighted day or use the +/- keys on your 
keyboard to increment/decrement the date. You can enter a date from 
the 30 open months, provided the month isn’t locked, in the form MM/
DD/YY.

Total Paid As you apply payments, the Total Paid field shows the total for the 
cheque. When you save the cheque, the Total Paid amount decreases the 
account selected for Cash Acct.

Total Discount As you apply discounts, the Total Discount field shows the total 
discounted for the deposit. This will be the total amount recorded to the 
account you selected in the Disc/Adj Acct field.

Cash Balance This field shows the current general ledger balance for the selected Cash Acct.
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Recording Vendor Payments
When you save vendor payments as a cheque, MultiLedger decreases 
the selected cash account and decreases your accounts payable account 
(as assigned on Interface Accounts) by the amount of the cheque. 
While an individual cheque can have only one cash account and one 
discount/adjustment account, you can choose different cash accounts 
and different accounts for any discounts or adjustments for separate 
cheques.

1 Click Vendor Payments in the Command Center.

For field explanations, see “Vendor Payments Field Descriptions” on 
page 194.

2 Select a cash account for the cheque.

When you open Vendor Payments, the default cash account assigned 
on Interface Accounts is shown.

You can change the cash account by clicking the account number or 
name and selecting a new account from the pop-up list.

List of outstanding
payables

Choose to sort the
list by due date,

name, or document
number

Click in the boxes to change accounts for
the cheque or adjustment
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3 If necessary, select an account for any discounts or adjustments.

You can add or change the discount or adjustment account by clicking 
the account number or name and selecting a new account from the pop-
up list (if no account is shown, click just to the right of the Disc/Adj 
Acct label). Once you’ve selected an account as the Disc/Adj Acct, you 
can change the account, but you cannot remove it.

4 If necessary, enter or change the cheque number.

After the cheque is saved, the cheque number is increased 
automatically by one.

5 Verify that the cheque date is correct.

6 Select the outstanding payable.

You can select an outstanding payable by clicking it or by using the 
Find command under the Edit menu.

You can sort the outstanding payables by date, name, or document 
number by clicking the appropriate Sort by drop down option

When you select an outstanding payable, the vendor name, due date, 
discount date, payable total, discount or adjustment (if any), and the 
cheque stub description (from the original payable) automatically fill 
in the appropriate fields above the outstanding payables list.
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If the cheque date is later than the payable’s discount date, the 
following dialog appears:

Click Yes to still apply the discount to the amount due.

Click No to not apply the discount.

Note To apply full payment quickly without any discount or adjustment, hold 
down the Control key (Ctrl) on Windows or the Command key (a) on 
Macintosh while you click the outstanding payable. The amount due 
will be listed automatically as the amount paid. You thus go to step 9, 
skipping steps 7 and 8.

7 If necessary, edit the highlighted amount in the Amt Paid edit box to 
match the actual vendor payment and press TAB.

The cursor moves to the Disc/Adjust edit box:

8 If necessary, change or enter any discount amount or adjustment and 
press TAB.

After the payment and discount are applied, the payment is added to 
the Total Paid field for the cheque, the discount is added to Total 
Discount field, and the Save button is enabled.

After entering any
discount or adjustment,
press TAB to apply the
payment and discount
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Note If you find that you’ve made a mistake, you can correct it easily before 
saving the cheque. See “Modifying or Deleting Payments Before 
Saving a Cheque” on page 198.

9 After repeating steps 6–8 for each outstanding payable that you’re 
paying, click Save.

A cheque is created for each vendor that you’re paying. For example, if 
you selected two payables for Office Mart and three payables for Bats 
Distribution and Saved, two cheques are created; one for Office Mart 
for the total of their two payables and one for Bats Distribution for the 
total of their three payables. 

When you save the cheque, the Total Paid amount and any discounts or 
adjustments decrease the accounts you selected.

Note If you discover a payment error after saving the cheque, see “Modifying 
or Deleting Payments Before Saving a Cheque” on page 198

Modifying or Deleting Payments Before 
Saving a Cheque
If you’ve made a mistake (such as entering a payment incorrectly or 
entering a payment for the wrong payable), you can quickly fix the 
problem before saving the cheque: 

1 Select the appropriate outstanding payable.

2 Change the highlighted amount paid (or press DELETE or BACKSPACE 
to remove it), then press TAB.

3 If necessary, change the amount in the Disc/Adjust field (or press 
DELETE or BACKSPACE to remove it), and press TAB to re-enter the 
modified payment (or remove the old one) on the line.

Modifying or Deleting Payments After 
Saving a Cheque
When you create a cheque in Vendor Payments, MultiLedger uses the 
Disbursements Journal to post the cheque to the general ledger. You 
can use the Disbursements Journal to modify or delete the cheque that 
contains the incorrect vendor payment. Vendor Payments and the 
general ledger will be updated automatically to reflect the change.

To modify or remove a payment from a saved cheque:

1 Click Disbursements Journal in the Command Center, then click 
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Modify.

A list of cheques for the month selected in the pull-down menu 
appears. Please note that the list of cheques also contains any cheques 
created in the Disbursements Journal. Select the cheque from the 
transactions list. If the cheque you’re looking for doesn’t appear, you 
may have to select another month from the pull-down menu. 

2 Modify the payment amount for a detail line or enter 0.00 in the 
Amount edit box to remove a payment from the cheque. 

3 Press TAB to replace the detail line in the list. 

4 Click Save. 

The outstanding payable associated with the payment will again appear 
in Vendor Payments.

If you delete a cheque that was made using Vendor Payments from the 
Disbursements Journal, all the vendor payments that made up the 
cheque will again appear in the Vendor Payments.

For more details about modifying transactions, see “Modifying or 
Deleting Payments Before Saving a Cheque” on page 198.

Purchase Orders
You can enter a Purchase Order in Item Purchases. Saving an Item 
Purchase as a Purchase Order does not create an outstanding payable 
and does not affect the general ledger until it is converted to an Item 
Purchase. A Purchase Order can be modified, deleted, or converted to 
an Item Purchase at any time.

Creating Purchase Orders
1 Click Item Purchases in the Command Center.

2 Check the Purchase Order check box.

3 Enter the purchase order information as you normally would enter an 
Item Purchase.

For detailed information on entering an Item Purchase, see “Recording 
a Purchase with Item Purchases” on page 179.

Note You may want to change the document number for purchase orders, so 
as not to confuse them with Item Purchases. For example, you could use 
“PO [document number],” to indicate a purchase order. The document 
number you enter the first time for a purchase order will automatically 
be increased by one for each new purchase order you save.

4 Click Save. 
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Working with Purchase Orders
You can modify, delete, or convert a purchase order to an Item 
Purchase at any time.

1 Click Item Purchases in the Command Center.

2 Check the Purchase Order check box.

3 Click Modify.

A list of purchase orders appears. If the purchase order you are looking 
for does not appear in the list, you may have to select a different month 
from the pull-down menu.

4 Select the purchase order from the list, then click OK.

You have four options: Modify, Cancel, Delete, and Create.

Modify If you click Modify, you can change any information for the purchase 
order. After you modify information, click Save to save the purchase 
order with changes.

Cancel If you click Cancel, you return to Item Purchases.

Delete If you click Delete, the purchase order is deleted, and you are returned 
to Item Purchases.

Create If you click Create, an Item Purchase is created using the information 
from the purchase order, and the following happens:

• The document number assigned to the new Item Purchase is one 
greater than the last Item Purchase saved. 

• The date for the new Item Purchase defaults to the current date. 

• The purchase order itself is deleted when you create an Item 
Purchase from it. 

• You can modify anything on the new Item Purchase before saving 
it. 

Printing Purchase Orders
1 Click Print on the Command Center.

2 Select the period.

3 Select the Item Purchases/PO’s radio button.

A list of available Item Purchases and purchase orders appears. 

4 Select the purchase order(s) you wish to print, and Print Metafile 
(Windows) or Print PDF/PICT File (Macintosh), if necessary.
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5 Click Print.

Note Purchase orders use the same format as Customer Invoices. You can, 
however, have a separate Metafile or PDF/PICT File for purchase 
orders. For information on using Metafiles, see “Positioning Print 
Fields for Windows Metafiles or Macintosh PDF or PICT Files” on 
page 98.

Viewing Purchase Orders
1 Click Transaction Journals in the Command Center.

2 Select a month from the list box on the right.

3 Click the Purchase Orders radio button.

4 Select the purchase order(s) you want to view, then click View.

If the purchase order you are looking for does not appear in the list, 
you may need to select another month from the list.

Note You can select all months in the list by clicking and dragging or using 
the SHIFT key to select more than one month.

Special Vendor Situations

Reversing a Payable
If you want a complete audit trail, you can use the Disc/Adjust account 
in Vendor Payments to reverse a payable. 

You can also delete the original Item Purchase or Payables Journal 
transaction. Deleting the original payable leaves no record of the 
transaction. For more information on deleting payables, see 
“Modifying or Deleting Payables Journal Transactions” on page 187 or 
see “Modifying or Deleting an Item Purchase” on page 182.

Important If there is a cheque associated with the payable you want to reverse or 
delete, you should delete the cheque in the Disbursements Journal 
before deleting or modifying the payable.
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Reversing a Payable on the Vendor Payments Window

1 Click Vendor Payments in the Command Center.

2 Select the Disc/Adj account.

Usually, this is the same expense account that was used in the original 
payable, not the Accounts Payable account.

3 Select the outstanding payable.

4 Enter zero in the Amt Paid edit box and press TAB.

5 Enter the amount of the payable in the Disc/Adjust edit box and press 
TAB.

6 You could change the cheque number to an appropriate document 
number, such as “VD [Document #],” to indicate a void payable.

7 Click Save.

Recording Vendor Credit

Recording Vendor Credit for Returned 
Inventory

1 Click Item Purchases in the Command Center.

2 Enter the credit memo information.

Follow the guidelines in “Recording a Purchase with Item Purchases” 
on page 179, except for the following fields:

Item Select the returned item from the Item pop-up list.

Quantity Enter a negative quantity for the returned inventory:

Amount The amount of the credit will show automatically as a negative amount:

3 Press TAB to add the credit memo to the detail list, and then click Save.

The vendor credit will appear in Vendor Payments as a credit and can 
be applied as payment toward a current or future payable. The returned 
inventory items will be subtracted from your inventory.



Applying Vendor Credits 203

Recording Other Vendor Credit
1 Click Payables Journal in the Command Center.

2 Enter the credit memo information.

Follow the guidelines in “Recording a Purchase with the Payables 
Journal” on page 185, except for the following fields:

Ledger Account Select the account that was used to originally record the purchase.

Amount Enter the credit as a negative amount like this:

3 Click Save.

The vendor credit will appear in Vendor Payments as a credit and can 
be applied as payment toward a current or future payable.

Applying Vendor Credits

The credit amount is equal to the 
outstanding payable amount

1 Click Vendor Payments in the Command Center.

2 Select the outstanding payable, and press TAB twice.

3 Select the vendor’s credit amount (with a minus (-) sign) and press TAB 
twice.

The amount shown for Total Paid should be zero. 

4 Change the cheque number to an appropriate description.

5 Click Save.

Both the outstanding payable and the credit amount are removed from 
Vendor Payments. 
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The credit amount is larger than the 
outstanding payable amount

1 Click Vendor Payments in the Command Center.

2 Select the outstanding payable, and press TAB twice.

3 Select the vendor’s credit amount (with a minus (-) sign), change the 
amount shown in the Amt Paid edit box to the amount of the 
outstanding payable with a minus (-) sign, and press TAB twice.

For example, if the outstanding payable amount is $250, you would 
enter “-250” in the Amt Paid edit box for the credit memo. The amount 
shown for Total Paid should be zero. 

4 Change the cheque number to an appropriate description.

5 Click Save.

The remaining credit amount appears in Vendor Payments to be 
applied toward another outstanding payable.

The credit amount is less than the 
outstanding payable amount

1 Click Vendor Payments in the Command Center.

2 Select the vendor’s credit amount and press TAB twice.

3 Select the outstanding payable.

If you are paying the remainder of the outstanding payable, simply 
press TAB twice. The Total Paid amount should equal the outstanding 
payable amount minus the credit amount.

If you are not paying the remainder of the outstanding payable, 
and you just want to apply the credit amount, change the amount in 
the Amt Paid edit box to match the amount of the credit amount with 
no minus (-) sign. For example, if the credit amount is “-100,” you 
would change the Amt Paid for the outstanding payable to “100.” The 
Total Paid amount should be zero.

4 Change the cheque number to an appropriate description.

5 Click Save.

If you paid the remainder of the outstanding payable, both the 
outstanding payable amount and the credit amount are removed from 
Vendor Payments.

If you did not pay the remainder of the outstanding payable, the 
remaining outstanding payable amount remains in Vendor Payments to 
be paid later.
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Chapter 9
Other Activities

This chapter discusses the following topics:

• Using the General Journal

• Reconciling bank accounts

• Using the Adjust Inventory window, including how to build or 
manufacture items

• Using the import and export capabilities

• Closing the year

• Rebuilding Company Files

• Renaming Company Files

• Find Company Files

• Renumbering Accounts
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Using the General Journal
You can use the General Journal to record transactions, such as the 
following:

• Depreciation or amortization adjustments

• Bank charges or fees

• Interest earned

General Journal Field Descriptions
This section discusses the individual fields on the General Journal.

Recurring If you have General Journal entries that occur on a regular basis, you 
can save them with Recurring checked. You can define the frequency 
for a recurring entry and have MultiLedger remind you when the 
transaction should be created. For more details on working with 
recurring entries, see “Recurring Entries” on page 124.

Reference # Enter a reference number up to eight characters long to identify the 
transaction. The last character must be a number. 

After the transaction is saved, the reference number is automatically 
increased by one.

Description Enter a description up to 25 characters long.

Date Simply type over the highlighted day or use the +/- keys on your 
keyboard to increment/decrement the date. You can enter a date from 
any open month, provided the month isn’t locked, in the form MM/DD/
YY.

Ledger Account Select a ledger account from the pop-up list. For more information, see 
“Using Pop-Up Lists” on page 112.

Because you have to enter both the debit (+) and the credit (-) of a 
General Journal transaction, each General Journal entry will have at 
least two ledger accounts.

Job Select the job for this detail line from the pop-up list. If the Jobs pop-up 
list does not appear, no jobs have been set up, or Skip Jobs 
(Ctrl-K on Windows or aK on Macintosh) under the Edit menu is 
checked.

Description The description you entered above is copied and highlighted 
automatically.

You can enter up to 25 characters of descriptive text for a particular 
detail line on the transaction.
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Amount Enter an amount (no dollar signs). If the amount has zero cents, you 
don’t have to enter .00. 

Credits should be entered with a minus sign (-) before the amount like 
this: -42.50

After at least one transaction line has been added, MultiLedger 
automatically calculates the necessary balancing amount and puts it in 
the Amount edit box. You can override the anticipated amount if more 
than one transaction line needs to be added. 

New Line
(Windows Only)

To enter another detail line to the entry, click New Line or press ENTER.

Entry Total
(Calculated)

This shows the total for the transaction as you add detail lines to the 
transaction. The Entry Total must equal zero before you can save the 
transaction.

Important When using the General Journal, you must enter both the debit and 
credit amounts for each transaction. An unbalanced entry (when credits 
plus debits do not equal zero) cannot be saved. After entering both sides 
of an entry, the amount shown for Entry Total should be 0.00.

Recording a General Journal Transaction
1 Click General Journal in the Command Center.

Reference # must
end in a number

Debits and credits
must be equal before

you can save the
transaction
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2 If necessary, enter or change the reference number and press TAB.

The cursor moves to the Description field.

3 Enter a description for the transaction.

4 Continue filling in the rest of the fields with the appropriate 
information.

For field explanations, see “General Journal Field Descriptions” on 
page 206.

Note You can add comment lines to the transaction at any time by choosing 
Insert Line (Ctrl-I on Windows or aI on Macintosh) from the Edit 
menu. For more information on adding comment lines see “Adding 
Comment Lines to Transactions” on page 119

5 After you’ve entered a ledger account and amount (Job and detail line 
Description are optional), press TAB to add the line to the transaction.

Note Credits should be prefaced with a minus (–) sign. 

As you add detail lines to the transaction, the Entry Total amount is 
updated.

After selecting another ledger account for the next detail line, 
MultiLedger automatically calculates the necessary balancing amount 
and puts it in the Amount edit box.

6 On Windows, if necessary, click New Line or press ENTER to begin 
entering another item to this entry.

On Macintosh, if necessary, press TAB or RETURN to begin entering 
another item to this entry.

7 When you are finished entering all the information for the document, 
click Save.

After the transaction is saved, it is posted automatically to the general 
ledger, and the Reference # is increased by one.

Modifying or Deleting General Journal 
Documents
When the cursor is in the Reference # field, the Modify button is 
enabled. Click Modify to see a list of General Journal transactions that 
you can modify or delete. If the General Journal transaction you’re 
looking for doesn’t appear, you may have to select another month from 
the pull-down menu. 
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Balancing Your Chequebook
Each month when you receive a bank statement you should reconcile 
or account for the difference between a cash account’s current balance 
(as shown in the general ledger) and the ending balance shown on the 
bank statement. This provides a way for you to ensure that your record 
of transactions matches what the bank has recorded for the same 
account.

Bank Reconciliation Field Descriptions
The following section describes the fields on the Bank Reconciliation.

Cash Acct The default cash account assigned on Interface Accounts is initially 
shown. To change accounts, click the account shown and choose 
another account from the pop-up list. The account selected will print at 
the top of the Bank Reconciliation report.

Note If you do not have access to the Interface Accounts, you cannot change 
this account in the bank reconciliation.

Show Cleared Items If Show Cleared Items is checked when you click Get Transactions, the 
transactions list will include transactions that have already been 
finalized (in the currently open month/year) along with those that have 
been cleared but not finalized and those that haven’t yet been marked as 
cleared. This is useful for finding a transaction that was mistakenly 
marked as cleared.

Sort by Ref # If Sort by Reference # is checked when you click Get Transactions, the 
unfinalized transactions will be listed from the lowest to the highest 
reference number. Otherwise, the unfinalized transactions are listed 
from the earliest to the most recent transaction date. 

Print Cleared Items Check this option to have finalized and unfinalized transactions print on 
the report. The dates for finalized and unfinalized transactions are 
determined by the Cutoff Date.

Cutoff Date The date entered here determines the last date that will be reported. For 
example, by entering the last date of a previous month and clicking Get 
Transactions, all unfinalized transactions as of that date will be 
reported. The Ledger Balance will also be as of the Cutoff Date. 
Initially, MultiLedger enters the current date as the Cutoff Date. 

Bank Statement
Balance

Enter the amount that your bank statement shows as an ending balance 
for the account.

-Outstanding Not
Entered

Enter a value here if cheques and/or deposits that were created prior to 
your Current Fiscal Year have not yet cleared the bank. Cheques and 
deposits from a date prior to your Current Fiscal Year will not appear in 
the transactions list since they were not created with MultiLedger.
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If you have outstanding cheques and/or deposits written prior to your 
Current Fiscal Year that have not yet cleared the bank, you should total 
the outstanding cheques and deposit amounts, then do one of the 
following:

• If the cheques are more than the deposits, enter a positive total for 
-Outstanding Not Entered.

• If the deposits are more than the cheques, enter a negative amount 
for -Outstanding Not Entered.

As the cheques and deposits that comprise the -Outstanding Not 
Entered value clear the bank, you should reduce the value in this field. 
Eventually, when all cheques and deposits that were written prior to 
your Current Fiscal Year have cleared, the -Outstanding Not Entered 
field should be zero.

-Current Outstanding
(Calculated)

This calculated value shows the total of uncleared (unchecked) 
transactions in the list. Since -Current Outstanding is subtracted from 
the Bank Statement Balance entered, a negative value means your 
uncleared deposits are more than your uncleared cheques.

=Revised Bank
Balance (Calculated)

This is your current bank balance based on Bank Statement Balance 
minus Outstanding Not Entered minus Current Outstanding.

-Ledger Balance
(Calculated)

This is the general ledger balance for the account selected for Cash 
Account as of the Cutoff Date.

=Difference
(Calculated)

After all transactions have been marked as cleared according to the bank 
statement, this amount should be 0.00.

Cleared Withdrawals This field keeps a running total of all credits (cheques, withdrawals, 
bank charges, etc.) for the selected account as you mark them as cleared. 
This field is cleared when you click Finalize.

Cleared Deposits This field keeps a running total of all debits (deposits, interest earned, 
etc.) for the selected account as you mark them as cleared. This field is 
cleared when you click Finalize.

Get Transactions Click this button to see a list of transactions, cleared and uncleared, that 
have not been finalized. If Show Cleared Items is checked, transactions 
cleared in previously finalized bank reconciliations will also be 
included in the list.

If you need to add a transaction or modify an existing transaction during 
bank reconciliation, simply access the correct transaction journal 
window, enter or modify the transaction, then return to Bank 
Reconciliation and click Get Transactions. The new/modified 
transaction appears as uncleared.
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Print If you click this button before a list of transactions is shown, the 
reconciliation report will show only current reconciliation balances. If 
you click Print after a list of transactions is shown, the report will 
include all uncleared transactions as well as reconciliation balances. To 
include cleared transactions on the report, make sure Print Cleared 
Items is checked.

Finalize Use Finalize only when you have completed the bank reconciliation for 
a month and your Difference is 0.00. After clicking Finalize, cleared 
transactions will no longer appear when you click Get Transactions 
(unless you have Show Cleared Items checked).

Reconciling Your Bank Balances
Use the following steps to reconcile your bank balances.

1 Click Bank Reconciliation in the Command Center.

2 If necessary, select the Cash Account that corresponds to the bank 
statement.

The default cash account is the one assigned on Interface Accounts. 
You can change accounts by clicking on the current cash account and 
selecting a new account from the pop-up list.

When you click Get
Transactions a list of

uncleared
transactions, as well

as cleared
transactions that

have not been
finalized, appears
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For more information about the Cash Account field, see “Bank 
Reconciliation Field Descriptions” on page 209.

3 If necessary, edit the Cutoff Date.

The Cutoff Date is filled in automatically with the current date.

The Cutoff Date determines the last date that will be reported. For 
example, by entering the last date of a previous month and clicking Get 
Transactions, all outstanding cheques and deposits as of that date will 
be reported. The Ledger Balance will also be as of the Cutoff Date. 

The Cutoff Date must be a valid transaction date from the any open 
month.

4 Enter the ending balance from your bank statement into the Bank 
Statement Balance field.

5 If desired, check Sort by Ref #.

If Sort by Ref # is checked when you click Get Transactions, the 
transactions will be listed from the lowest to the highest reference 
number. Otherwise, the transactions are listed from the earliest to the 
most recent transaction date.

Note If Sort by Ref # is checked, numeric reference numbers are sorted first 
before alpha reference numbers. For example, cheque number “5500” 
would come before document number “Dep138.”

6 Click Get Transactions.

The list includes uncleared transactions, as well as cleared transactions 
that have not been finalized.

7 For each transaction shown on your bank statement, find the 
corresponding transaction in the list and click it to mark it as cleared.

Disbursements or cheques are shown as negative amounts. Deposits 
are shown as positive amounts.

A checkmark (√- Macintosh) or an asterisk (* - Windows) appears to 
the left of transactions that you have marked as cleared and the item 
will change color. If you accidentally mark a transaction as cleared, 
click it again to un-clear it and remove the mark.

You can mark multiple lines as cleared by dragging on the appropriate 
transactions.

MultiLedger keeps a running total for cheques and deposits you’ve 
marked as cleared in the Cleared Withdrawals and the Cleared 
Deposits fields.
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Note Attention CheckMark Payroll Users: Employee cheques imported 
from CheckMark Payroll to MultiLedger show “PR[posting date]” 
under the Ref # heading, and cheque numbers under the Description 
heading. Employer cheques use the cheque number assigned in 
CheckMark Payroll as the Ref #. 

8 When you are finished checking off cleared transactions, =Difference 
should be 0.00.

If =Difference is 0.00, you have successfully reconciled your bank 
balance.

If =Difference is not 0.00, see “Bank Reconciliation Tips” on page 214 
and “Bank Reconciliation Problems” on page 215

9 When you’re finished reconciling the bank account, click Finalize.

If the bank reconciliation is in balance, you will get the following 
message:

If the bank reconciliation is not in balance, you will get the following 
message:

Click No to not save the bank reconciliation data.

Click Yes to save the bank reconciliation data. Once finalized, cleared 
transactions no longer appear when you click Get Transactions (unless 
Show Cleared Items is checked). 
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Bank Reconciliation Tips
If you’re having trouble reconciling your bank statement in 
MultiLedger, read the following tips. If you’re still having trouble, 
read the next section, “Bank Reconciliation Problems.”

• Compare the Cleared Withdrawals total to your bank 
statement. The amount in the Cleared Withdrawals field should 
match the bank statement’s total for withdrawals. (This may be 
called cheques paid, withdrawals, or something similar on your 
bank statement). If they don’t match, you may have mistakenly 
cleared an item that hasn’t cleared the bank or you may have 
missed checking off a cleared item in Bank Reconciliation.

• Compare the Cleared Deposits total to your bank statement. 
The amount in the Cleared Deposits field should match the bank 
statement’s total for deposits. (This may be called total deposits or 
something similar on your bank statement). If they don’t match, 
you may have mistakenly cleared an item that hasn’t cleared the 
bank or you may have missed checking off a cleared item in Bank 
Reconciliation.

• Double-check the amount entered for Bank Statement 
Balance. This should be the ending balance from your bank 
statement. When you open Bank Reconciliation, the amount in the 
Bank Statement Balance field is the amount that was last saved, so 
it may be the ending balance from last month’s bank statement.

• Make sure all miscellaneous items, such as bank interest or 
fees/charges, have been entered in MultiLedger. You can add 
missing transactions while doing the bank reconciliation. When 
you are finished adding missing transactions, simply click Get 
Transactions on Bank Reconciliation to add the new transactions 
to the list.
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Bank Reconciliation Problems
If you’ve finished marking transactions as cleared and =Difference is 
not zero, you should find the problem and correct it. The rest of this 
section will help you find the problem and suggest what you can do 
about it.

• A transaction was mistakenly marked as cleared

To un-clear a transaction, click it to remove the mark.

If you haven’t finalized the bank reconciliation yet, make sure that 
all transactions that have just been marked as cleared in 
MultiLedger are also shown on the bank statement.

If you’ve already finalized the bank reconciliation, check Show 
Cleared Items before you click Get Transactions. The transactions 
list will include transactions that have already been finalized based 
on the Cutoff Date.

• A transaction listed on the bank statement was not marked as 
cleared in MultiLedger

Make sure that all transactions listed on the bank statement have a 
corresponding transaction marked as cleared in MultiLedger. As 
you mark a transaction as cleared in MultiLedger, sometimes 
putting a checkmark next to the corresponding transaction on the 
bank statement helps.

• A transaction listed on the bank statement was not recorded in 
MultiLedger

Look at the bank statement to see what sort of transactions might 
be missing from your MultiLedger records.

• Bank charges (such as a monthly service charge) or dividends 
have probably not been entered in MultiLedger yet. Record these 
types of transactions in the General Journal, then return to the 
Bank Reconciliation and click Get Transactions. The new 
transaction will appear in the list.

• A deposit might have been made to your cash account that 
wasn’t recorded in MultiLedger. You should record this deposit in 
Customer Payments or the Receipts Journal, then return to the 
Bank Reconciliation and click Get Transactions. The new 
transaction will appear in the list.
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• A cheque might have been hand written without recording it in 
MultiLedger. You should record the cheque in Vendor Payments or 
the Disbursements Journal, then return to the Bank Reconciliation 
and click Get Transactions. The new transaction will appear in the 
list.

• A transaction was marked as cleared in MultiLedger, but the 
amount is different than on the bank statement.

A cheque or deposit might have been entered incorrectly. You can 
modify or delete the transaction. For more details, “Modifying or 
Deleting a Transaction” on page 120

• A prior outstanding total was not entered 

You need to enter a prior outstanding total if cheques or deposits 
were created before you started using MultiLedger but haven’t yet 
cleared the bank. The total amount for these cheques and deposits 
needs to be entered in the -Outstanding Not Entered field, so you 
can reconcile the bank balance.

For details about the -Outstanding Not Entered field, see “Bank 
Reconciliation Field Descriptions” on page 209.

• A cheque or deposit was already marked as cleared, then the 
transaction amount was modified after the bank reconciliation 
was finalized.

If you modify a transaction that was cleared and then finalized, 
then modify the transaction amount, the transaction is 
automatically uncleared. You should mark the transaction with the 
modified amount as cleared on the Bank Reconciliation.

Adjust Inventory Window 
Adjust Inventory provides a simple way to adjust the values in your 
inventory account to reflect current inventory values. You can use this 
window to:

• Adjust inventory levels after taking a physical inventory count to 
reflect what you actually have on hand.

• Remove an item from inventory that didn’t involve a sale, such as 
an inventory transfer from one location to another. 
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• “Build” an inventory item from existing inventory items. This is 
handy if you do some light manufacturing or bundling of 
inventory. For more information, see “Building Inventory” on 
page 220.

Adjust Inventory Field Descriptions
Reuse When you click this instead of Modify, you can select a previous entry 

to “Reuse” without changing or deleting the original entry. For more 
information, see “Reusing Adjust Inventory Transactions” on page 219.

Inventory Account The default account assigned to Inventory on Interface Accounts is 
shown.

The account shown for Inventory cannot be changed here.

Adjust Account This account will be increased (debited) or decreased (credited) when 
you save the transaction. If no account appears here or to change the 
account, click just to the right of the Adjust Account label and select an 
account (usually in the 5000 range) in the pop-up list that appears. 

Ref # Since MultiLedger uses the General Journal to post an Adjust Inventory 
transaction to the general ledger, the same reference number system is 
used in both windows. 

Description Enter a description for the transaction up to 25 characters long. The 
description entered here appears in Transaction Journal reports and in 
General Ledger reports.

Date Simply type over the highlighted day. You can enter a date from the any 
open month, provided the month isn’t locked, in the form MM/DD/YY.

G/L Account Balance The current general ledger balance, as of the last transaction date, for the 
Inventory account is shown.

Total Cost of Items A calculated value based on the quantity on hand multiplied by the 
average unit cost for all items in your inventory.

Entry Total The calculated total based on the Adjust Qty (+ or -) multiplied by the 
Unit Cost for all items you are adjusting.

Adjust Qty +/- The quantity you want to adjust an item’s quantity on hand by. You can 
enter either a positive or a negative quantity.
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Using the Adjust Inventory Window
1 Click Adjust Inventory in the Command Center.

2 Select an account for the adjustment. 

You can change the Adjust Acct by clicking the account number or 
name and selecting a new account from the pop-up list. If no account is 
shown, click to the right of the Adjust Acct label and select an account 
from the pop-up list that appears.

3 If necessary, enter or change the reference number. 

4 Type in a description for the transaction.

5 Verify that the date is correct.

6 Select an item you want to adjust from the list.

Choose a cost of sales
account, usually in the

5000 range

Click Reuse to use a previous
entry without modifying or

changing the original entry.

Current inventory
values appear here

The inventory account is the
one you selected on

Interface Accounts
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7 Enter a quantity, positive or negative, in the Adjust Qty +/– edit box, 
then press TAB.

Entering a positive quantity adds to the existing inventory and entering 
a negative (-) quantity subtracts from the existing inventory. 

The Total Cost edit box shows the calculation of the Adjust Qty +/– 
multiplied by the Unit Cost. If you change the amount in the Total Cost 
field, the Unit Cost for the item will be updated accordingly.

8 Repeat steps 6 and 7 for all items you want to adjust.

9 When you are finished, click Save.

Modifying or Deleting Adjust Inventory 
Transactions
You can modify or delete a transaction made in Adjust Inventory.

1 Click Adjust Inventory in the Command Center.

2 Click Modify.

3 Select the transaction from the list, then click OK.

If the transaction you are looking for does not appear, you may have to 
select another month from the pull-down menu.

To delete the transaction, click each line in the entry, enter zero in the 
Adjust Qty +/– edit box, then press TAB twice. When all items have a 
zero in the Adjust Qty column, click Save.

To modify the transaction, change the appropriate items, then click 
Save.

Reusing Adjust Inventory Transactions
You can reuse a transaction created in Adjust Inventory without 
changing the original entry.

1 Click Adjust Inventory in the Command Center.

2 Click Reuse.

3 Select the transaction from the list, then click OK.

If the transaction you are looking for does not appear, you may have to 
select another month from the pull-down menu.

You can modify any information, then click Save.
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Building Inventory
Adjust Inventory can be used for light manufacturing or bundling of 
items. The following example shows you how to use Adjust Inventory 
for light manufacturing to make a fictitious whizbat from existing 
inventory of dingbats and dingwings. The dingbats and the dingwings 
are the components and the whizbat is the finished good.

1 Make sure you have the components of the finished good on hand and 
an item name set up for the finished good.

Note Components should be purchased in the quantity they will be sold. For 
example, if the dingbats you use to make whizbats come in 25 foot rolls, 
but each whizbat uses only 4 inches of dingbat, you should purchase the 
dingbat in inches.

2 Click Adjust Inventory in the Command Center.

3 Select an Adjust Acct.

Usually this is the inventory account.

4 Select a component in the list.

5 Enter a negative quantity in the Adjust Qty +/– edit box.

The Total Cost for the component will show as a negative amount.

6 Repeat steps 4 and 5 for each component.

7 Highlight the finished good item in the list and enter a positive quantity 
for the finished good in the Adjust Qty +/– edit box. 

Enter a negative
adjust quantity for the

components
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8 Take the amount that appears as a negative in the Entry Total field 
and enter this amount as a positive in the Total Cost edit box for the 
finished good. 

This will make the Entry Total zero. 

For example, if it takes 5 inches of Dingbats and 5 units of Dingwings 
to make 1 Whizbat, your entry would look similar to the one above.

9 Click Save.

Saving this transaction transfers the components into the finished good 
and will reflect the true unit cost of the finished good based on the cost 
of each of the components. To view the entry that was made, click 
Transaction Journals in the Command Center, select the correct month 
from the list, the click the General radio button. Highlight the 
transaction, then click View.

Viewing Adjust Inventory Transactions
1 Click Transaction Journals in the Command Center.

2 Select a month from the list.

3 Click the General radio button.

4 Highlight the document(s) you wish to view, then click View or Print.

Enter the total that
appears as a negative
for the components as

a positive amount for
the finished good
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Importing and Exporting Data
MultiLedger’s ability to import and export data is one of its most 
powerful features and gives it a great deal of flexibility to work with 
other programs. You can send data back and forth between different 
MultiLedger companies or even to other programs. Some ideas for 
using these features include:

• Export your customers from MultiLedger to a word processor to 
use its mail-merge capabilities.

• Use a database to create specialized invoices, and then import 
them into MultiLedger to track your accounts receivable 
information.

• Import your customers and vendors into MultiLedger from a 
database or address book program.

• Create a new set of company files because of a change in the fiscal 
year-end date. This way, you can export much of the data from the 
old company and import it into the company with the new fiscal 
year-end date.

The Basics of Importing and Exporting
First, here are a few key terms to remember about importing and 
exporting.

Record The information about one vendor, customer, item or transaction. For 
instance, consider these items to import:

The item called Widget and its associated quantity and price are one 
record. Poster and its associated information are another record.

Field One piece of information from a record. In the example above, name 
and quantity are each one field.

ASCII file Same as a text file.

Text file The most basic file format. A text file doesn’t contain any information 
about fonts or formats. It only contains the words and numbers that 
make up your data. This is the kind of file that most programs (including 
MultiLedger) use when they import and export data.

Name Qty Price
Widget 41 4.25
Poster 13 12.00
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Tab-delimited file A special kind of text file. Each field is separated by a tab character, and 
each record is separated by a carriage return. For example, a tab-
delimited text file, using the above example, might look like this:

Wiget<tab>41<tab>4.25 <CR> Poster<tab>13<tab>12.00<CR>

MultiLedger uses tab-delimited text files to import or export 
information. Text files are a common file format that many applications 
understand. “Tab-delimited” simply means that a tab character 
separates each field in the text file.

Here are a few important things to remember about a tab-delimited text 
file:

• There are no titles for the data in the text file.

• <tab> is just a symbol for the TAB character on your keyboard. 
(Don’t use the letters “t a b.”)

• The <CR> character is the ENTER key (Windows) or the RETURN 
key (Macintosh) on your keyboard.

• A word processing program can be used to view a text file. It 
might display characters like Î for <tab> and ¶ for <CR>.

When data is imported, MultiLedger opens the text file and reads the 
information into your company files. When data is exported, 
MultiLedger copies the selected information from your company and 
saves it to a text file. The exported information can then be read by 
many applications including, of course, MultiLedger. Every time you 
export information, you can save it to a different text file. For instance, 
you could export your customers to one file, your vendors to a second 
file, and your items to a third file.
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Exporting from MultiLedger
1 Choose Export from the File menu.

2 If necessary, make sure you have the month that contains the data you 
wish to export selected in the pull-down menu.

3 Select the type of data that you want to export from the pull-down 
menu.

Choose the type of
data you wish to

export from the pull-
down menu
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After selecting the appropriate option from the pull-down menu, a list 
of records for the month selected in the Month menu appears on the left 
and the Field List shows the fields that you can export. For example, if 
you clicked the Customers option, a list of customers appears:

Note If Customers or Vendors is selected and you want the City, Province, 
and Postal Code exported in separate fields, make sure you select the 
Separate City/Province/Postal Code checkbox.

4 Click Copy All to copy all the fields from the Field List to the Export 
List in the same order they appear in the Field List. 

You can also select a field then click Copy, or you can double-click 
each field you want to export in the order you want it to appear in the 
text file.

Since there are no field names in a text file, you should carefully 
determine the order you want data to appear in the text file.

Make sure you have
the correct month

selected

If you need to have the
City, Province, &

Postal code in
separate fields for

Customers or Vendors
when exporting, make

sure this box is
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As you double-click each field in the Field List, the field name appears 
in the Export List:

To remove a field from the Export List, double-click it or click it once 
then click Remove. Fields below the removed field will automatically 
move up in the Export List.

5 From the list on the left, select the records that you want to export.

If no records are highlighted, all the listed records will be exported.

To select a consecutive series of records, drag on a range of records 
so that all desired selections are highlighted.

To select a non-consecutive series of records, hold down the Ctrl key 
(Windows) or the Command(a) key (Macintosh) while clicking each 
desired record. All desired records should be highlighted.
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6 Click Export.

A Save As dialog appears:

7 A file name based on the category you have selected is automatically 
entered. 

This can be changed if you want to rename the file.

8 Determine where you want to save the file.

If necessary, use the folder pop-up menu to change folders or disks.

9 Click Save.

You have created a new tab-delimited text file that can be imported 
into another program or another MultiLedger company.

Importing into MultiLedger
If you import an account, customer, vendor, or item with the exact 
same name as one that already exists in your company, the original 
data associated with that name will be replaced by the new information 
you are importing.

If you attempt to import a transaction with the same document number 
as one that already exists in your company, and Check for Duplicate 
Documents is selected on Preferences under the File menu, the 
transaction with the duplicate document number will not be imported. 
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If you attempt to import a transaction with the same document number 
as one that already exists in your company, and you do not have Check 
for Duplicate Documents selected on Preferences under the File menu, 
the duplicate transaction will be imported, unless it also has the same 
date as the existing transaction.

If you import a transaction that has an item, customer, or vendor that 
does not exist in your company, MultiLedger will ask you if you want 
to add the new item, customer, or vendor to your company files. If you 
don’t add the new data, MultiLedger will skip that transaction. If you 
do add the new data, you should go to the appropriate set up window 
later to add address or payment information. 

Important You can import invoices and payables along with their associated 
customer or vendor payments, provided you use the field “Amount 
Paid” in both the Export List and the Import List. Please note that using 
the “Amount Paid” field does not import the associated receipt or 
disbursement transaction (you still need to import the receipt or 
disbursement) but it does reduce the amount of the outstanding 
receivable or payable.

If you don’t use the “Amount Paid” field, imported customer or vendor 
payments do not automatically apply to invoices as they would if they 
had been entered through Customer or Vendor Payments. Invoices 
associated with the imported customer or vendor payments will still 
appear as unpaid and your Accounts Receivable or Accounts Payable 
reports will be out of balance.

Repeating Fields

Many imported text files use repeating fields. For instance, a text file 
containing an invoice might have the following repeating fields: item, 
quantity, price, and amount. A text file containing an invoice that sold 
two inventory items and a service contract might look like this:

3/30/01<tab>INV 1010<tab>Leona Helmsley Prop Mgmt.   <tab>Net 
30<tab>3/30/01<tab>CMS Deluxe Model 
#7785<tab>10<tab>64.84<tab>648.40<tab>CMS Deluxe Model 
#9975<tab>1<tab>451.25<tab>451.25<tab>CMS Service 
Contract<tab>1<tab>475.00<tab>475.00 <CR>

The corresponding Import List in MultiLedger would look like this:
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.

On the Import window, repeating fields are indicated with an asterisk 
(*). These fields should appear at the bottom of the Import List. 

Required Fields

MultiLedger requires certain fields for importing, depending on the 
type of data you are importing. Required fields are marked with a plus 
sign (+). 

To get an idea of how a text file for a transaction might look, try 
exporting some sample data out of MultiLedger, and then open it up in 
another application such as Microsoft Word or Excel.
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Match Name & Code

The program will search for existing names and codes when importing 
Customers, Vendors, or Items.

This searches for existing records with the same name and code, same 
name, or same code depending on which option you choose from the 
pull-down list. If it finds an exact match, it will update the existing 
record. If there isn’t an exact match, it will add a new record. 

To Import Data into MultiLedger
1 Choose Import from the File menu.

The following window appears:
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2 Select the type of data that you want to import from the pull-down 
menu.

After selecting the appropriate option from the pull-down menu, the 
Field List shows the fields that you can import. For example, if you 
select Customers from the pull-down menu, the following fields appear 
in the Field List:

3 Click Copy All to copy all the fields from the Field List to the Import 
List in the same order they appear in the Field List. 

You can also select a field then click Copy, or you can double-click 
each field you want to import in the order you want it to appear in the 
text file.

Since there are no field names in a text file, you should carefully 
determine the order that you want to import the data.

A plus sign (+) before a field name indicates that it is a required field 
for importing. An asterisk next to a field name indicates a repeating 
field. For more information on repeating fields, see “Repeating Fields” 
on page 228.
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To remove a field from the Import List, double-click it or click it once, 
then click Remove. Fields below the field will automatically move up 
in the Import List.

4 After selecting the appropriate fields for the Import List, click Import.

An Open File dialog appears:

Locate the text file
you want to import

using the dialog box
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5 Select the appropriate text file to import and click Open.

In this example, you would select Invoices and click Open.

The Import Preview window appears:

This window allows you to see the Import List with the contents of the 
selected text file by record. This can help you find any errors before 
you actually import the data.

You can use the scroll bar to see more data for the record. You can also 
click the appropriate button to move through the text file.

6 When you’re finished previewing the text file, click Import to read the 
information into your company or click Cancel to return to the Import 
window.

The Import Preview
window allows you to

spot any problems
before you import
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Closing the Year

Before Closing the Year

• As a precaution, make two backups of your company files.

Before closing the year, you should make two backup copies of 
your company data files to protect your data from being lost. Use 
the Backup Company command under the File menu. For details, 
read Chapter 12, “Backing Up and Restoring Company Files.” 
Restore and open each backup company to ensure that each 
copy is usable.

Close Year Command
To close the year, simply choose Close Year from the File menu, 
then follow the on-screen instructions. The progress bar will give you 
an indication of how long this process will take.

Once you have closed a year, there is no way to open the previous year 
unless you revert to a backup.

After closing the year, asset, liability, and equity accounts (1000–3999 
range) carry over to the new year. Income and Expense accounts (4000 
and higher) zero out to the Retained Earnings (profit and loss) account 
assigned on the Interface Accounts window.

Making Adjusting Entries to the Previous 
Year
If, after closing the year, you need to make adjusting entries to the 
closed fiscal year, do the following:

1 Open one of the backup companies and enter the transactions.

2 After all adjusting entries have been made, print a Trial Balance 
report for the last month of your fiscal year.

3 Close the backup company and open the new year company.
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4 On Account Balances, enter or adjust the balances from the Trial 
Balance you printed from the backup.

You will need to total the income and expense accounts and either add 
them to or subtract them from the Retained Earnings account.

5 After entering the new account balances, verify that the Ledger 
Balance is zero, then click Save.

The new balances will carry forward and update balances and reports 
for all months in the new year.

Renaming Company Files
You can use the Rename Files command to rename all the data files 
associated with an open company. MultiLedger data files are named 
when you create your company and can include up to 13 files ending in 
a designated MultiLedger suffix, such as .ml0, .ml1, .mld, etc. 

1 Choose Rename Files from the File menu.

2 Type in the new name for your company files, then click OK or click 
Cancel to not rename the company files.

Use a short name, such as CMS, instead of a longer name, as it will be 
easier to find in a dialog or window. 

Note This does not rename the company folder that contains the data files—
only the data file names. Also, renaming doesn’t affect the company 
name that prints on reports.

Important You should never rename your files using any other method, as you may 
be unable to access the files.
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Using the Rebuild Files Command
MultiLedger has a built-in command for rebuilding company data files. 
We recommend that you use this command if you have deleted a large 
number of customers, vendors, items, or transactions, since doing so 
compacts the files. 

Under some circumstances, the Rebuild Files command can repair 
other problems with your company files. If you are experiencing a 
problem with your company files, please contact technical support to 
ask if the Rebuild Files command can help correct the problem. To see 
how to contact technical support, see “How to reach us” on page 3.

To rebuild your company files, do the following:

1 If you don’t have a current backup of your company files, you should 
make one now.

For more information on backing up, read Chapter 12, “Backing Up & 
Restoring.”

2 In your MultiLedger company files, choose Rebuild Files from the File 
menu.

An alert appears to remind you to make a backup of your files.

3 Click Yes to perform the rebuild.

The progress bar will give you an indication of how long this process 
will take.
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Finding Company Files
MultiLedger includes a command to search your local drives, as well as 
any network drives, for sets of company files. The results window displays 
the physical location of all found company files, and you can open any 
company directly from the results window. 

To use the Find feature, choose Find Company from the File menu. When 
the search is complete, the results window appears. To see what periods 
are open in a company, click the path for that company in the results 
window and you can see the open periods in the upper left corner of the 
Find Files window. To open a found company, choose the path in the 
results window and click Open.

Note If Find Company is dimmed, a company is already open. Choose Close 
Company from the File menu first, then try again. The Find Company 
command can take some time to complete, depending on the number and 
size of the drives being searched.

Renumbering Accounts
The Renumber Accounts feature is invaluable if you need to transfer 
account balances, including all activity for the account, to another account, 
with the option to delete the old account. To use the Renumber Accounts, do 
the following:

1 Choose Renumber Accounts from the File menu.

2 Highlight the account you want to transfer activity from in the list on the 
left. 

The account number and name appear in the ‘Change To:’ edit boxes on the 
right.

3 Type in the number of the account you want to transfer the activity to, then 
press TAB.

If the account number is one that already exists in the chart of accounts, the 
name of that account number will automatically be entered into the edit box, 
and you can skip to step 5. If it is a new account that does not exist in the 
chart of accounts, go to step 4.

4 Type in the name of the new account you want to transfer the activity to.

5 If you want to delete the old account you are transferring account activity 
from, check the Delete box.

6 Click Save. 

When you click Save, all activity is transferred to the designated account. If 
you checked the Delete box, the old account is removed from the Chart of 
Accounts.

7 Repeat steps 2-6 to transfer activity for other accounts, if necessary.
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Chapter 10
Customer, Vendor & Item Reports

This chapter explains how to use MultiLedger’s report windows, as 
well as the various customer, vendor, and item reports and information 
you can get from MultiLedger.
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Using the Report Windows
MultiLedger offers a variety of reporting options. Most reports can be 
viewed on screen, printed, or saved as a text file to be opened in 
another application (such as a word processor). You can also print 
several different reports with one command on the Print Multiple ... 
under the reports drop down menu. Individual reports are discussed in 
detail later in this manual.

If you save a report as a text file (tab-delimited), you can open it from 
within a word processor to further customize the format and font 
characteristics of the report.

Using the Find Command with Reports
Most report windows allow you to use the Find (Ctrl-F on Windows or 
aF on Macintosh) and Find Again (Ctrl-G on Windows or aG on 
Macintosh) commands (under the Edit menu) to find specific 
characters in a report on screen. You can also use these commands to 
select customer names, vendor names, and items for a report.

You can search for anything that can be entered from your keyboard, 
such as account numbers, cheque numbers, names, amounts, and other 
parts of a list or report.

1 Choose Find from the Edit menu.

Or press Ctrl-F on Windows or aF on Macintosh. The Find dialog box 
appears:

If the Find command has already been used since starting MultiLedger, 
the edit box will show the last characters entered.

2 Enter the characters that you want to search for.

Let’s say that you’re looking for the name “Kelley Hair & Net.” You 
could enter “kell”:
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Notice that you don’t have to enter all of the name that you’re looking 
for. You can enter just enough to distinguish the name from another 
name.

You don’t have to enter upper case letters such as “K” because the 
search does not distinguish between upper case (“K”) and lower case 
(“k”) characters.

3 Click Find.

Or press ENTER (Windows) or RETURN (Macintosh). MultiLedger starts 
at the beginning of the list and looks for the first occurrence of the 
characters “kell”. When the characters are found, MultiLedger scrolls 
the list and selects (highlights) the first occurrence of the characters 
“kell”:

If you were searching for the line containing “kell” on a report, such as 
an accounts receivable report, the first line that contains “kell” would 
be highlighted:

If the name you are looking for is not selected as the first occurrence, 
select Find Again (Ctrl-G on Windows or aG on Macintosh) from the 
Edit menu. You can continue to select Find Again from the Edit menu 
until the name you are looking for is selected or until there are no more 
matching selections.

If the characters you entered aren’t found, no line is selected. Choose 
Find and enter a different name to search for.
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Making Selections in a Reports List
Most report windows allow you to select a consecutive series of 
accounts, names, or periods from a list box for a report:

Many reports also allow non-consecutive selections:

If no names are highlighted in a list, all the names will be reported.

Selecting a consecutive series on Windows or Macintosh

• Drag on a range of lines so that all desired selections are 
highlighted.

or

• Click the first desired line so that it’s highlighted. Then, while 
holding down the SHIFT key, click the last line desired. All desired 
selections should be highlighted.

Selecting a non-consecutive series on Windows

Click the first desired line so that it’s highlighted. Then, while holding 
down the Ctrl key, click the next desired line.

Whenever you can select a non-consecutive series, you can also select 
a consecutive series by dragging through all desired lines in the list 
box.

Selecting a non-consecutive series on Macintosh

Click the first desired line so that it’s highlighted. Then, while holding 
down the a key, click the next desired line.

You can select a
consecutive series

by clicking and
dragging.

You can also select a
non-consecutive series

by holding down the Ctrl
key (Windows), the ??

key (Mac OS X) or SHIFT

key (Mac OS 9)while
clicking each item
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Whenever you can select a non-consecutive series, you can also select 
a consecutive series by dragging through all desired lines in the list 
box.

Printing Multiple Reports
You can print more than one report with just one Print command by 
using the Print Multiple window under the Reports menu.

Choose Print Multiple from the Reports menu.

The following window appears:

 

The following types of financial reports can be printed with a single 
Print command:

Prints the selected month’s trial balance.

Prints a general ledger listing for the selected month.

Prints a balance sheet for the selected month.

Prints a period and year-to-date income statement for the selected 
month.

Prints the selected month’s accounts receivable report, sorted by Due 
Date. (Not available for Macintosh)

Prints the selected month’s accounts payable report, sorted by Due Date. (Not 
available for Macintosh)
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1 Click the appropriate checkboxes to select or deselect reports for 
printing.

For details, see the previous descriptions of the types of reports 
available.

Any combination of reports can be printed.

2 Select the period for the reports.

3 Click Print.

A standard Print dialog box appears. Select the print options that you 
want, and click OK or Print.

Reporting Options
Most reports can be viewed, printed, or saved as a text or .xls file.

If you click View, the report appears on your screen.

You can use the Find command under the Edit menu to find a specific 
line in the report (for details, see “Using the Find Command with 
Reports” on page 240).

If you click Print, a standard Print dialog box appears. Select the print 
options that you want, and click OK or Print.

If you click Text File, a save as dialog appears. If necessary, change 
the name of the text file, choose where you want to save it, then click 
Save.

If you click .XLS, a save as dialog appears. If necessary, change the 
name of the .xls file and choose where you want to save it. Then click 
Save. If you choose to open the .xls file in Microsoft Excel, it is 
recommended you use the import feature in Excel vs opening the file 
directly for better formatting options.
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Customer Reports
Click Customer Reports in the Command Center.

Types of Customer Reports
MultiLedger has many different customer reports options. Each report 
is described in detail below.

Accounts Receivable Reports

Accounts Receivable Shows all outstanding invoices and finance charges as of the Cutoff 
Date entered. You can sort this report by due date, customer name, or 
document number by making the appropriate selection from the pop-up 
menu.

Accounts Receivable-
Aged

Shows outstanding receivables (including any finance charges) in terms 
of how long they have been outstanding as of the Cutoff Date entered. 
Aging periods can be modified. You can sort this report by due date, 
name, or document number by making the appropriate selection from 
the pop-up menu.

You can see the Statement Description field, the customer’s phone 
number, contact name, and salesperson on this report by checking this 
option.

Select the type of
report you want from
the pull-down menu.

The available options
change, depending

on the report type
you select
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Accounts Receivable-
Summary Aged

Shows the total amount owed (including any finance charges) by each 
customer in terms of how long the receivable has been outstanding as of 
the Cutoff Date entered. Aging periods can be modified.

Note If you select the Accounts Receivable, Aged Accounts Receivable, or 
Summary Aged Accounts Receivable report for all of your customers, 
MultiLedger will show your accounts receivable detail balance and the 
general ledger balance for the Accounts Receivable account that is 
selected on the Interface Accounts window as of the Cutoff Date. These 
balances appear at the end of the report.

Customer History Reports
Transaction Detail Shows a list of sales and payments for any open month. You can select 

one month or a range of months for this report. Payments made against 
invoices using the Customer Payments window show the deposit 
number along with the invoice number that was paid.

Transaction Summary Shows a summary of the total sales and total receipts for each selected 
customer for the selected month or range of months.

Invoice Item Detail Shows a list of items bought by a customer. This report shows the 
customer name, the date, invoice number, the item name, the quantity 
purchased, and the amount. You can select one month or a range of 
months for this report.

Customer Information and Mailing Labels
Customer Information Shows the customer name, address information, phone, fax, email 

address, website, Business ID, ship to addresses, and any notes set up 
for the customer.

Mailing Labels For printing customer mailing labels. Mailing label dimensions are 
defined on the Preferences window under the File menu.

Customer Statements
Customer Statements-

Open Invoices
Shows all of the outstanding invoices and finance charges that a 
customer owes in chronological order as of the Cutoff Date entered. 
Initially, the Cutoff Date is the current date. Any partial payments 
applied to invoices are also shown. 

Customer Statements-
Activity Based

Shows all of the outstanding invoices and finance charges that a 
customer owes, with a running balance for all outstanding amounts. 
Payments from the 30 days prior to the Cutoff Date are also shown.
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Options for Customer Statements

Print metafile
(Windows) or Print

PDF/PICT File
(Macintosh)

If this option is checked, an Open File dialog box appears after clicking 
Print or OK in a Print dialog box for customer statements. This allows 
you to select the Metafile or PDF/PICT File for printing.

Note Use the Format command under the File menu to position where the 
customer statement information prints on a page (for details, see 
“Customizing Print Field Positions for Your Printer” on page 95). 

If a Metafile (Windows) or a PDF/PICT File (Macintosh) is being used 
for the customer statement graphics, check the Print Metafile or Print 
PDF/PICT File option. To adjust where the various fields print on 
customer statements, use the Format command under the File menu. For 
more details, see “Positioning Print Fields for Windows Metafiles or 
Macintosh PDF or PICT Files” on page 98

Zero-Balance
Statements

(Activity Based statements only) If this option is checked, Activity 
Based Customer Statements that show activity in the 30 days preceding 
the Cutoff Date but have zero balances due are printed.

Working with Accounts Receivable 
Reports

1 Select the customer or customers for the report.

If necessary, scroll the list box to find the name of the customer you 
want. You can also use the Find command under the Edit menu to 
select a customer from a long list (for details, see “Using the Find 
Command with Reports” on page 240).

You can select a consecutive or non-consecutive series of customers 
from the list (see “Making Selections in a Reports List” on page 242).

If no customer names are highlighted, all customers will be reported.

If you have set up codes for your customers and would like those codes 
to appear on reports, check the Show Code Field on Reports option on 
the Preferences window under the File menu.

2 Select a report type from the pop-up menu.

For details, see the previous descriptions of the types of accounts 
receivable reports available.
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3 Change the Cutoff Date if necessary.

When you open the Customers window, the Cutoff Date is 
automatically filled in with the current date:

The Cutoff Date determines the last date that will be reported for 
Accounts Receivable, Aged Accounts Receivable, and Summary Aged 
Accounts Receivable reports. By changing this date, you can create a 
report that shows what invoices were outstanding up until an earlier 
date. For example, if you want a report that shows outstanding 
receivables at the end of last month, change the Cutoff Date to the last 
day of that month.

Aging Periods
4 If you are creating an aged accounts receivable report (Aged or 

Summary Aged), do the following. Otherwise, skip this step.

To help you identify possible bad debts, you can specify how 
MultiLedger will age your receivables by editing the following 
numbers of days:

 

Double-click an edit box, change the number, and press TAB to see the 
date change. (If you don’t press TAB after changing an aging period, 
the aging date will not change. However, the report will reflect the 
change in the number of days.)

If you do not have zero as your first aging period, there will be no 
“Current” column on the report.

The aging reports show invoices as past due beginning one day after 
the due date. This due date is determined by the invoice date plus the 
number entered for Days til Due for that particular term as set up on 
the Customer Terms window under the Setup menu. For details about 
terms, see “Customer Terms” on page 50

5 Click View, Print, or Text File.

If necessary, change
the number of days in

these edit boxes
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Accounts Receivable report example:

The Due Dates are
based on Customer

Terms you set up

Report totalThe report total and the total for the
Accounts Receivable account plus

any Finance Charges should agree

Accounts Receivable
account plus Finance

Charges
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Accounts Receivable-Aged report example:

 

Each invoice is
categorized based on how

many days it is past due

Report totalThe report total and the total for the
Accounts Receivable account plus

any Finance Charges should agree

Accounts Receivable
account plus Finance

Charges
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Accounts Receivable-Summary Aged report example:

Note Finance charges listed on the report can cause the balances to disagree 
because finance charges are included in the report total, but not in the 
G/L accounts receivable balance. The total for finance charges is shown 
below the accounts receivable balance. The finance charges total plus 
the accounts receivable balance should equal the report total.

Working with Customer History Reports
1 Select the customer or customers.

If necessary, scroll the list box to find the name of the customer you 
want. You can also use the Find command under the Edit menu to 
select a customer from a long list (for details, see “Using the Find 
Command with Reports” on page 240).

You can select a consecutive or non-consecutive series of customers 
from the list (see “Making Selections in a Reports List” on page 242).

If no customer names are highlighted, all customers will be reported.

If you have set up codes for your customers and would like those codes 
to appear on reports, check the Show Code Field on Reports option on 
the Preferences window under the File menu.

Outstanding amounts for each customer are
shown based on the defined aging periods

Report totalThe report total and the total for the
Accounts Receivable account plus

any Finance Charges should agree

Accounts Receivable
account plus Finance

Charges
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2 Select Transaction Detail, Transaction Summary, or Invoice Item 
Detail.

For details, see the previous descriptions of the types of customer 
history reports available.

3 Select a month or range of months.

4 Click View, Print, or Text File.

Transaction Detail report example:

Transaction Summary report example:

Total sales and total
receipts for the

selected month(s) are
shown for each

customer

Total sales and receipts for all customers
are shown at the bottom of the report.

Total sales and
receipts are shown as one-line summaries

per customer for the selected month(s)
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Invoice Item Detail report example:

Working with the Customer Information 
Report

1 Select the customer or customers.

If necessary, scroll the list box to find the name of the customer you 
want. You can also use the Find command under the Edit menu to 
select a customer from a long list (for details, see “Using the Find 
Command with Reports” on page 240).

You can select a consecutive or non-consecutive series of customers 
from the list (see “Making Selections in a Reports List” on page 242).

If no customer names are highlighted, all customers will be reported.

If you have set up codes for your customers and would like those codes 
to appear on reports, check the Show Code Field on Reports option on 
the Preferences window under the File menu.

2 Select Customer Information.

For details, see the previous description of the Customer Information 
report.

3 Click View, Print, or Text File.

Item name, quantity,
and purchase

amount are shown
by invoice for the

selected customers
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Customer Information report example:

Working with Customer Statements

1 Select the customer or customers.

If necessary, scroll the list box to find the name of the customer you 
want. You can also use the Find command under the Edit menu to 
select a customer from a long list (for details, see “Using the Find 
Command with Reports” on page 240).

You can select a consecutive or non-consecutive series of customers 
from the list (see “Making Selections in a Reports List” on page 242).

If no customer names are highlighted, statements for all customers will 
be reported.

If you have set up codes for your customers and would like those codes 
to appear on reports, check the Show Code Field on Reports option on 
the Preferences window under the File menu.

2 Select either Customer Statements-Open Invoices or Customer 
Statements-Activity Based.

For details, see the previous descriptions of the Customer Statements.

3 Click View, Print, or Text File.

This information
comes from the

Customer Setup
window

This information
comes from Ship To
addresses set up on

the Customer
Invoices window
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Customer Statement-Open Invoices example:

All outstanding
invoices prior to the

Cutoff Date are
shown, as well as

any partial payments
to invoices
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Customer Statement-Activity Based example:

All outstanding
invoices and finance
charges are shown,

with a running balance
for all outstanding

amounts. Payments
from the 30 days prior
to the Cutoff Date are

also shown.

If the customer has had
activity in the 30 days

preceding the Cutoff
Date but has a zero

balance due, no
statement will print

unless the Zero-
Balance Statements

option is checked.
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Vendor Reports
Click Vendor Reports in the Command Center.

Types of Vendor Reports
MultiLedger has many different vendor reports options. Each report is 
described in detail below.

Accounts Payable Reports
Accounts Payable Shows all outstanding payables as of the Cutoff Date entered. You can 

sort this report by due date, vendor name, or document number by 
making the appropriate selection from the pop-up menu.

Accounts Payable-
Aged

Shows outstanding payables by invoice in terms of how long they have 
been outstanding as of the Cutoff Date entered. Aging periods can be 
modified. You can sort this report by due date, name, or document 
number by making the appropriate selection from the pop-up menu.

Accounts Payable-
Summary Aged

Shows the total amount owed to each vendor in terms of how long the 
payable has been outstanding as of the Cutoff Date entered. Aging 
periods can be modified.

Select the type of
report you want from
the pull-down menu.

The available options
change, depending

on the report type
you select
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Note If you select the Accounts Payable, Aged Accounts Payable, or 
Summary Aged Accounts Payable report for all of your vendors, 
MultiLedger will show your accounts payable detail balance and the 
general ledger balance for the Accounts Payable account that is selected 
on the Interface Accounts window as of the Cutoff Date. These balances 
appear at the end of the report.

Vendor History Reports
Transaction Detail Shows a list of payables and payments in the 30 open months. You can 

select one month or a range of months for this report. Payments made 
against invoices using the Vendor Payments window show the cheque 
number along with the document number that was paid.

Transaction Summary Shows a list of the total payables and total disbursements for each 
selected vendor for the selected month or range of months. 

Item Purchase Detail Shows a list of items bought from a vendor. This report shows the 
vendor name, the date, document number, the item name, the quantity 
purchased, and the amount. You can select one month or a range of 
months for this report.

Vendor Information and Mailing Labels
Vendor Information Shows the vendor name, address information, phone, fax, email 

address, website, Business ID, and any notes set up for the vendor.

Mailing Labels For printing vendor mailing labels. Mailing label dimensions are 
defined on Preferences under the File menu.

Working with Accounts Payable Reports
1 Select the vendor or vendors.

If necessary, scroll the list box to find the name of the vendor you 
want. You can also use the Find command under the Edit menu to 
select a specific vendor name from list (for details, see “Using the Find 
Command with Reports” on page 240).

You can select a consecutive or non-consecutive series of vendors 
from the list (see “Making Selections in a Reports List” on page 242).

If no vendor names are selected (highlighted), all vendors will be 
reported.

If you have set up codes for your vendors and would like those codes 
to appear on reports, check the Show Code Field on Reports option on 
Preferences under the File menu.

2 Select Accounts Payable, Accounts Payable-Aged or Accounts Payable-
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Summary Aged from the pull-down menu.

For details, see the previous descriptions of the types of accounts 
payable reports available.

3 Change the Cutoff Date if necessary.

When you open the Vendors window, the Cutoff Date is automatically 
filled in with the current date.

The Cutoff Date determines the last date that will be reported. By 
changing this date, you can create a report that shows what invoices 
were outstanding up until an earlier date. For example, if you want a 
report that shows outstanding payables at the end of last month, change 
the Cutoff Date to the last day of that month.

Aging Periods
4 If you are creating an aged accounts payable report (Aged or 

Summary Aged), do the following. Otherwise, skip this step.

You can specify how MultiLedger will age your payables by editing 
the following numbers of days:

Double-click an edit box, change the number of days, and press TAB to 
see the date change. (If you don’t press TAB after changing an aging 
period, the aging date will not change. However, the report will reflect 
the change in the number of days.)

 If you do not have zero as your first aging period, there will be no 
“Current” column on the report.

5 Click View, Print, or Text File.

If necessary, change
the number of days in

these edit boxes
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Accounts Payable report example:

Accounts Payable-Aged report example

:

Report totalThe report total and the total for the
Accounts Payable account should agree

Each invoice is
categorized based on how

many days it is past due

Report totalThe report total and the total for the
Accounts Payable account should agree
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Accounts Payable-Summary Aged report example:

Working with Vendor History Reports
1 Select the vendor or vendors.

If necessary, scroll the list box to find the name of the vendor you 
want. You can also use the Find command under the Edit menu to 
select a vendor from a long list (for details, see “Using the Find 
Command with Reports” on page 240).

You can select a consecutive or non-consecutive series of vendors 
from the list (see “Making Selections in a Reports List” on page 242).

If no customer names are highlighted, all vendors will be reported.

If you have set up codes for your vendors and would like those codes 
to appear on reports, check the Show Code Field on Reports option on 
Preferences under the File menu.

2 Select Transaction Detail, Transaction Summary, or Item Purchase 
Detail from the pull-down menu.

For details, see the previous descriptions of the types of vendor history 
reports available. 

3 Select a month or range of months.

Outstanding amounts for each vendor are
shown based on the defined aging periods

Report totalThe report total and the total for the
Accounts Payable account should agree
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4 Click View, Print, or Text File.

Transaction Detail report example:

Transaction Summary report example:

Total payables and
total disbursements for
the selected month(s)

are shown for each
vendor

Total payables and disbursements for all
selected vendors are shown at the

bottom of the report.

Total payables
and disbursements are shown as one-line

summaries per vendor for the selected
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Item Purchase Detail report example:

 

Working with the Vendor Information 
Report

1 Select the vendor or vendors.

If necessary, scroll the list box to find the name of the vendor you 
want. You can also use the Find command under the Edit menu to 
select a vendor from a long list (for details, see “Using the Find 
Command with Reports” on page 240).

You can select a consecutive or non-consecutive series of vendors 
from the list (see “Making Selections in a Reports List” on page 242).

If no vendor names are highlighted, all vendors will be reported.

If you have set up codes for your vendors and would like those codes 
to appear on reports, check the Show Code Field on Reports option on 
Preferences under the File menu.

2 Select Vendor Information from the pull-down menu.

For details, see the previous description of the Vendor Information 
report.

Item name, quantity,
and amount are

shown by invoice for
the selected vendors
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3 Click View, Print, or Text File.

Vendor Information report example:

 MultiLedger calculates the year-to-date payments to a vendor for the 

The information for
this report comes
from the Vendor

Setup window
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Item Reports
MultiLedger provides the following types of item reports:

Sales Summary This report shows the item name, quantity sold, total sales price, total 
cost, and the margin, with combined totals for all reported items. You 
can select one month or a range of months for this report.

Sales Detail This report shows the invoice date, document number, customer name, 
quantity sold, sales price, total cost, and the margin, with a subtotal of 
all invoices for each reported item. Combined totals for all selected 
items are shown at the bottom of the report. You can select one month 
or a range of months for this report.

Purchase Summary This report shows the item name, quantity purchased, unit cost, and total 
cost with combined totals for all reported items. Combined totals for all 
selected items are shown at the bottom of the report. You can select one 
month or a range of months for this report.

Purchase Detail This report shows the date, document number, vendor name, quantity 
purchased, unit cost, and total cost, with a subtotal of all Item Purchases 
for each reported item. Combined totals for all selected items are shown 
at the bottom of the report. You can select one month or a range of 
months for this report.

Inventory-Current This report shows the item name, quantity on hand, unit cost, and 
current total cost. This report always shows the current inventory 
values, regardless of the month selected in the Month list. The general 
ledger balance for the inventory account selected on Interface Accounts 
is shown at the end of the report when all items are reported. This is 
handy for verifying that your inventory general ledger balance and 
inventory detail amounts are in balance.

Inventory-Selected
date

This report shows inventory values as of a month-end date. It shows the 
item name, quantity on hand, unit cost, and total cost as of the last day 
of the last selected month. The general ledger balance for the inventory 
account selected on Interface Accounts is shown at the end of the report 
when all items are reported. This is handy for verifying that your 
inventory general ledger balance and inventory detail amounts are in 
balance.

Price List This report shows your item list and the three different selling prices for 
each item.

Graph Sales $ This report gives you a bar chart that graphs an item’s sales volume by 
month for the current year. This report shows one item at a time and all 
months are reported regardless of the month selected in the list box.

Graph Sales Qty This report gives you a bar chart that graphs an item’s quantity sold by 
month for the current year. This report shows one item at a time and all 
months are reported regardless of the month selected in the list box.
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Item Report Options
Omit if zero QOH When this option is selected, the reports will not include any items that 

have a zero Quantity on Hand.

Include Non-Inventory When this option is selected, the reports will include items that are 
marked as Non-Inventory in the Item setup window.

Qty Only When this option is selected, the Current Inventory report will show the 
Quantity on Hand, Minimum Quantity on Hand, and Reorder Quantity.

Working with Item Reports
Click Item Reports in the Command Center.

1 Select the item or items.

If necessary, scroll the list box to find the item that you want. You can also 
use the Find command to select a specific item name from the item list (see 
“Using the Find Command with Reports” on page 240).

You can select a consecutive or non-consecutive series of items from the 
list for details, see “Making Selections in a Reports List” on page 242.

If no items are selected, all items will be reported.

If you have set up codes for your items and would like those codes to 
appear on reports, check the Show Code Field on Reports option on 
Preferences under the File menu.
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2 Select a report type from the pull-down menu.

For details, see the previous descriptions of the types of item reports 
available.

3 Click View, Print, or Text File.

Sales Summary report example:

 

Sales Detail report example:

 

Each item is shown,
along with quantity

sold, sales amount,
cost, and margin for
the selected months

Combined totals for all selected items
are shown here

Item sales are
shown by invoice,

including the
quantity sold,

sales amount,
cost, and margin

Subtotals are shown after
each item

Combined totals for all selected
items are shown here
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Purchase Summary report example:

 

Purchase Detail report example:

 

Each item is
shown, along with

quantity
purchased, unit

cost, and total cost
for the selected

months

Combined totals for all selected items
are shown here

Item Purchases are
shown by invoice,

including the
quantity purchased,

unit cost, and total
cost

Subtotals are shown after each
item

Combined totals for all selected
items are shown here
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Inventory-current report example:

 

Inventory-selected date report example:

 

Price List example:

The report total and the total for the
Inventory ledger account should agree

Report total

Report total

The report total and the total for the
Inventory ledger account should agree

Each item is shown,
along with the three

different selling
prices
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Chapter 11
Financial & Other Reports

This chapter contains descriptions and examples of the following types 
of reports:

• Chart of accounts

• Trial Balance

• Transaction journals

• General Ledger

• Balance Sheet

• Income Statement

• Cash Flow Statement

• Financial Snapshot

• Sales tax report

• Salesperson report

• Job reports
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Chart of Accounts Reports
The Chart of Accounts report window offers the following options:

• Print a list of your chart of accounts.

• Print or view a graph showing period comparisons.

• Print or view a graph showing account balances versus budget 
amounts.

Note If you want to look at account balances for a specific period, see “Trial 
Balance Report” on page 275.

Click Account Reports in the Command Center.

When you first open the Chart of Accounts Reprts window, the Graph 
and Print Graph buttons are dimmed. These buttons remain dimmed 
until you select accounts.
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Printing Your Chart of Accounts
You can print a list of the chart of accounts showing account numbers 
and names grouped under headings. All accounts, regardless of any 
accounts highlighted, are reported.

To change account descriptions, see “Setting Up the Chart of 
Accounts” on page 22.To change account groupings or group 
descriptions, see “Customizing Financial Statements” on page 80.

Click the Print button to print your chart of accounts.

A standard print dialog box appears on your screen. Select the print 
options that you want, and click Print or OK.

Graphing Comparisons
You can print or view a bar graph comparing a balance for an account 
or a range of accounts for each period in the open accounting periods.

1 Select the account or accounts to be reported.

If necessary, scroll the list box to find the name of the account or 
accounts.

You can select a consecutive series of accounts (for details, see 
“Making Selections in a Reports List” on page 242.) 

2 Click Graph or Print Graph. 

If you click Graph, the report appears on your screen.

If you click Print Graph, a standard Print dialog box appears on your 
screen. Select the print options that you want, and then click OK or 
Print.
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Here’s an example graph showing a cash account’s comparative 
balances:

Graphing Account Balances versus 
Budget Amounts
If budget amounts have been set up for your chart of accounts, you can 
print or view a bar graph comparing a balance for an account or a range 
of accounts for each period versus budget amounts in the open 
accounting periods. 

To set up budget amounts, see “Setting Up Budget Amounts” on 
page 70.

1 Select the account or accounts to be reported.

If necessary, scroll the list to find the name or names of the account or 
accounts that you want. You can select a consecutive series of accounts 
(for details, see “Making Selections in a Reports List” on page 242.).

2 Check the Actual vs Budget check box.

3 Select the year.

4 Click Graph or Print Graph.
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Trial Balance Report
A trial balance report shows ledger accounts, their beginning balances 
(optional), their monthly activity and their year-to-date balances, and 
whether or not your debits equal your credits. Debits should equal 
credits for your books to balance. 

You can use a trial balance report to quickly look at your account 
balances for a particular period.

1 Click Trial Balance in the Command Center.

 

2 Select a period for the report.

Only one period can be selected at a time. The default period selected 
corresponds to the last month in which transactions were entered.

3 If necessary, check the option Show Zero Balances.

If Show Zero Balances is checked, the report will show balances for all 
accounts in your chart of accounts, including those with zero activity 
and zero year-to-date balances.

4 If desired, check the option Show Beginning Balances. 

If checked, the report will show the beginning balances for the period 
selected along with monthly activity and YTD balances.

5 Click View, Print, or Text File.
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Drill Down on Trial Balance Report
The Trial Balance report has a drill-down function that allows you to 
quickly see the general ledger listing for any amount in the Monthly 
Activity column on a Trial Balance report. To utilize the drill-down 
capabilities, do the following:

1 While viewing a Trial Balance report, move the pointer over the 
Monthly Activity column.

The pointer tool changes to a magnifying glass tool.

2 With the magnifying glass tool, click on the amount in the Monthly 
Activity column that you want to see in drill-down mode.

A General Ledger listing for that specific month and account appears. 
From this General Ledger listing you can go directly to an original 
transaction. For more details, see “Drill Down on General Ledger 
Report” on page 284.

3 To return to the Trial Balance report, click the General Ledger 
report’s close box.

Prior Year Income

If you have 2014, 2015, & 2016 open in your files, 2015 is considered 
your current year. You need to keep 2014 open in order to get Prior 
Year comparison reports for 2014 vs 2015.

Because you haven't closed 2014, your income and expenses for 2014 
haven't rolled into retained earnings yet in the General Ledger or Trial 
Balance. So when you look at your trial balance for 2015, it shows the 
retained earnings from 2014 as a separate line at the bottom under the 
totals in "Prior Income".

As long as the Ledger Debit line equals the total of the Ledger Credit 
+/- the Prior Income, then you are in balance.

If you look at the Balance Sheet, it reflects the amount going into 
Retained Earnings. 
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Trial Balance report example:

 

Amounts with
parentheses are

credits.

Amounts without
parentheses are

debits

Debits and credits
should balance or
credits plus prior

income should
equal debits
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Transaction Journals Reports
You can view, print or create a text file of any journal from any of the 
open months. You can also export any journal from any of the open 
months using the Export command under the File Menu.

Click Transaction Journals in the Command Center.

Sorting Transaction Journal Reports
You can sort Transaction Journal reports by date or by document 
number. The default selection is by document number. To change the 
sort, simply make a selection from the pop-up menu.

The default month
selected on this window
corresponds to the last

month transactions were
entered
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Types of Transaction Journal Reports
MultiLedger provides the following types of transaction journal 
reports:

Disbursements Shows transactions recorded in both Vendor Payments and 
Disbursements Journal for the selected month(s). 

Receipts Shows transactions recorded in both Customer Payments and Receipts 
Journal for the selected month(s). 

General Shows transactions recorded in both General Journal and Adjust 
Inventory for the selected month(s). 

Item Purchases &
Payables

Shows transactions created in both Item Purchases and Payables 
Journal for the selected month(s). 

Customer Invoices &
Sales

Shows transactions created in both Customer Invoices and Sales 
Journal for the selected month(s). 

Purchase Orders Shows transactions created with the Purchase Order option checked in 
Item Purchases for the selected month(s).

Quotes Shows transactions created with the Quote option checked in Customer 
Invoices and Sales Journal for the selected month(s).

Last Used Recurring
Entries

If checked, the last-used recurring entries for the selected journal 
appear regardless of the month selected. The Last Used Recurring 
Entries check box is dimmed when either the Purchase Orders or 
Quotes radio buttons is selected.
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Working with Transaction Journal Reports
1 Select the desired month or months for the report.

2 Select a journal by clicking the journal name.

When a journal radio button is clicked, a list of documents from the 
selected month(s) is shown for that journal.

 

3 Select the document or documents for the report.

If necessary, scroll the list to find the document you want. Or use the 
Find command under the Edit menu. (see “Using the Find Command 
with Reports” on page 240.)

You can select a consecutive or non-consecutive series of documents 
(see “Making Selections in a Reports List” on page 242.).

If no documents are selected, all documents for that journal and period 
will be reported.
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4 Click View, Print or Text File.

Transaction Journal report example:

 

A summary of all accounts
affected and total debits and

credits appear at the bottom of
the report
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Drill Down on Transaction Journal Reports
Transaction Journal reports have a drill-down function that allows you 
to quickly move to an original transaction to see details or make 
modifications. To utilize the drill-down capabilities, do the following:

1 While viewing a Transaction Journal report, move the pointer over the 
document number of the desired transaction.

The pointer tool changes to a magnifying glass tool.

2 With the magnifying glass tool, click on the transaction you want to see 
in drill-down mode. 

The transaction journal used to create the original transaction opens 
and the transaction appears. You can modify the transaction if 
necessary. For more details on modifying transactions, see “Modifying 
or Deleting a Transaction” on page 120.After you modify the 
transaction, open report windows need to be refreshed by closing the 
report window and reopening it before the modified transaction will 
appear.

3 To return to the Transaction Journal report, either click Save, then 
close the transaction window or click the transaction window’s close 
box. You can also choose the report from the Windows menu.

If you close the transaction window without making changes or 
without saving any changes you have made, a Save Changes message 
appears. If you click Yes, you return to the transaction window. Click 
Save, then close the transaction window; you then return to the 
Transaction Journal report window. If you click No, you return to the 
Transaction Journal report window. 
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General Ledger Reports
A General Ledger report shows the General Ledger accounts with their 
detailed activity for selected months. You can also create year-to-date 
reports. If you only want ending balances and not the daily details, 
create a trial balance report (see “Trial Balance Reports” earlier in this 
chapter).

1 Click General Ledger in the Command Center.

 

2 Select the account or accounts for the report.

If necessary, scroll the list to find the name of the account you want.

You can select a consecutive or non-consecutive series of accounts 
(see “Making Selections in a Reports List” on page 242.).

If no accounts are selected, all accounts will be reported.

3 Select a period for the report.

You can select a consecutive series of months (see “Making Selections in a 
Reports List” on page 242.).

You can create a year-to-date General Ledger report by selecting all the 
periods from the beginning of the year through the last month of the year.
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4 If necessary, select one or more Profit Centers.

If you select one or more Profit Centers, then just the accounts that 
have been set up for those Profit Centers will be reported.

5 If necessary, select Omit Customer/Vendor Name

If you select the checkbox to Omit Customer/Vendor Name, that 
column will not show on report.

6 Click View, Print, or Text File.

Drill Down on General Ledger Report
The General Ledger report has a drill-down function that allows you to 
quickly move to an original transaction to see details or make 
modifications. To utilize the drill-down capabilities, do the following:

1 While viewing a General Ledger report, move the pointer over the 
desired transaction.

The pointer tool changes to a magnifying glass tool.

2 With the magnifying glass tool, click on the transaction you want to see 
in drill-down mode. 

The transaction journal that was used to create the original transaction 
opens and the transaction appears. You can modify the transaction if 
necessary. For more details on modifying transactions, see “Modifying 
or Deleting a Transaction” on page 120. After you modify the 
transaction, open report windows need to be refreshed by closing the 
report window and reopening it before the modified transaction will 
appear.

3 To return to the General Ledger report, either click Save, then close 
the transaction window or click the transaction window’s close box. 
You can also choose General Ledger from the Windows menu.

If you close the transaction window without making changes or 
without saving any changes you have made, a Save Changes message 
appears. If you click Yes, you return to the transaction window. Click 
Save, then close the transaction window; you then return to the General 
Ledger report window. If you click No, you return to the General 
Ledger report window. 
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General Ledger report example:

Journal initial

The beginning
balance of the
account being

reported

The debit and credit totals
are shown, and the

difference is shown here

The ending balance for
the account, based on the
month(s) being reported,

is shown here
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The J column on the General Ledger report shows the initial of the 
journal that was used to create the transaction. The journal initials 
represent the following:

D Transactions created in the Disbursements Journal or Vendor Payments.

P Transactions created in Item Purchases or the Payables Journal.

S Transactions created in Customer Invoices or the Sales Journal.

R Transactions created in the Receipts Journal or Customer Payments.

G Transactions that were created in the General Journal, and includes 
transactions created in Adjust Inventory.

Balance Sheet Reports
A Balance Sheet shows your company’s assets, liabilities, and equity 
as of a specific month-end date.

1 Click Balance Sheet in the Command Center.
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MultiLedger provides the following types of balance sheet reports:

Types of Balance Sheet Reports 
Selected Date A standard Balance Sheet report for the selected month.

Prior Month
Comparison

Compares the selected month with the previous month.

Prior Year
Comparison

Compares the selected month with the same period in the prior year.

Prior Year-End
Comparison

Compares the selected month with the prior year-end.

Balance Sheet Report Options
Three options are available for each type of report:

Whole Dollars Rounds dollars and cents to whole dollars on report.

Show Detail Accounts Shows all accounts regardless of groupings that have been made with 
the Financial Statements window.

Show Date & Time Date and time printed at bottom of page.

2 Select a report type.

For details, see the previous descriptions of the types of balance sheet 
reports available.

3 Select a period for the report.

Only one period can be selected for each report.

4 If necessary, click the appropriate checkboxes to select or deselect 
report options.

For details, see the previous descriptions of balance sheet report 
options.

5 If necessary, change the report title or footer line.

Entering data in these fields will print the information on the Balance 
Sheet report.

6 Click View, Print, or Text File.
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Balance Sheet—Selected Date report example:

 

You can customize
headings for this
report using the

Financial
Statements

window

Total Assets and
Total Liabilities

and Equity should
match
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Income Statement Reports
An Income Statement shows whether or not your company has earned 
a profit. In addition to dollar values, the income statement report shows 
income and expense as a percent of total sales.

If you are using profit centers, you can create individual income 
statements for each profit center as well as a consolidated income 
statement for your company. For more information on Profit Center 
Income Statements, see “Profit Center Income Statements” later in this 
chapter.

1 Click Income Statement in the Command Center.

 

Types of Income Statement Reports 
MultiLedger provides the following types of income statements:

Selected Period A standard income statement created for the selected month or range of 
months.

Period & Y-T-D Compares selected month or range of months with year-to-date 
information through the latest date selected.

Prior Month
Comparison

Compares selected month or range of months with the previous month.
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Prior Year
Comparison

Compares the selected month or range of months with the same period 
in the prior year.

Income vs. Budget Compares actual income and expenses for the selected month in the 
current year with budget amounts for the same period.

Budget Report Shows budget amounts for selected month or range of months.

Income Statement Report Options 
Four options are available for each report:

Whole Dollars Rounds dollar and cents values to whole dollars on report.

Show Detail Accounts Shows all accounts regardless of groupings that have been made with 
the Financial Statements window.

Show Date & Time Date and time printed at bottom of page.

Show Net Before
Taxes

Shows a total for net income or loss before taxes. 

2 Select a report type.

For details, see the previous descriptions of the types of income 
statement reports available.

3 Select a period for the report.

You can select a month or a range of months.

4 If necessary, click the appropriate checkboxes to select or deselect 
report options.

For details, see the previous descriptions of income statement report 
options.

5 If necessary, change the report title or footer line.

Entering data in these fields will print the information on the Income 
Statement report.

6 Click View, Print, or Text File.

Profit Center Income Statements
If you are using profit centers, you can create individual profit center 
income statements and a consolidated report.

The profit centers are listed under the heading Profit Center on the 
Income Statement window:

For details about setting up profit centers, see “Setting Up Profit 
Centers” on page 73.
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Creating Income Statements for Individual 
Profit Centers

1 Click Income Statement in the Command Center.

2 Select one or more profit centers to be reported.

Note You can only select consecutive profit centers from the list.

3 Select a report type.

For details, see the previous descriptions of the types of income 
statement reports available.

4 If necessary, click the appropriate checkboxes to select or deselect 
report options.

For details, see the previous descriptions of income statement report 
options.

5 If necessary, change the report title or footer line.

Entering data in these fields will print the information on the Income 
Statement report.

6 Click View, Print, or Text File.
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Creating a Consolidated Income 
Statement for Profit Centers
If you set up a general profit center account in your chart of accounts, 
this account will be used for the consolidated description.

If you did not set up a general profit center account, the first profit 
center will be used for the consolidated description.

For details about setting up a general profit center account, see “Setting 
Up Profit Centers” on page 73.

1 Make sure no profit center names are selected (highlighted) in the 
Profit Center list.

2 Select a report type.

For details, see the previous descriptions of the types of income 
statement reports available.

3 If necessary, click the appropriate checkboxes to select or deselect 
report options.

For details, see the previous descriptions of the options available for 
income statements.

4 If necessary, change the report title or footer line.

Entering data in these fields will print the information on the Income 
Statement report.

5 Click View, Print, or Text File.
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Income Statement—Selected Period report example:

You can customize
headings for this
report using the

Financial
Statements

window
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Cash Flow Reports
A Statement of Cash Flows shows the incoming and outgoing cash 
over the selected period. This is shown by starting with the net income 
(or loss) at the beginning of the period from the Income Statement, 
then showing each asset, liability, and equity account whose value has 
changed during the selected period. The result is net cash at the end of 
the period. Please note that this report shows only the net increase or 
decrease in each account, not the balance.

The Statement of Cash Flows report calculates the net cash at the end 
of the period by adding the following items:

• Net Income for the period 

• Changes to accounts shown in the three report sections: Operating 
Activities, Investing Activities, and Financing Activities 

• Cash at beginning of period.

For details about assigning accounts for the Cash Flow Statement, see 
“Setting Up Cash Flow Designations” on page 24.

1 Click Cash Flow in the Command Center.



Cash Flow Reports 295

MultiLedger provides the following types of cash flow reports:

Types of Cash Flow Reports 
Selected Date A standard Statement of Cash Flows report for the selected month or 

range of months.

Prior Month
Comparison

Compares the selected month(s) with the previous month.

Prior Year
Comparison

Compares the selected month(s) with the same period in the prior year.

Cash Flow Report Options
Three options are available for each type of report:

Whole Dollars Rounds dollars and cents to whole dollars on report.

Show Detail Accounts Shows all accounts regardless of groupings that have been made with 
the Financial Statements window.

Show Date & Time Date and time printed at bottom of page.

2 Select a report type.

For details, see the previous descriptions of the types of cash flow 
reports available.

3 Select a period for the report.

You can select one month or a range of months.

4 If necessary, click the appropriate checkboxes to select or deselect 
report options.

For details, see the previous descriptions of cash flow report options.

5 Click View, Print, or Text File.
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Cash Flow Statement—Selected Date report example:
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Financial Snapshot Report
A Financial Snapshot report shows a summary of your business’ 
current cash, receivables, payables, inventory and several financial 
ratios as of the date of the last entry.

1 Click Financial Snapshot in the Command Center.

2 Click View, Print, or Text File.

Financial Snapshot—report example:
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Sales Tax Report
MultiLedger provides a detailed sales tax report that can help in 
completing sales tax forms for various state and local agencies. Sales 
tax amounts are recorded on the Customer Invoices window.

Click Sales Tax Report in the Command Center.

 

The Sales Tax report can include all or a selected group of sales tax 
categories. The Sales Tax report includes the following information for 
the selected month or range of months:

• Sales Tax category’s name and tax percentage

• The date, the invoice number, and the customer name for each 
invoice that was charged to the sales tax category

• The taxable and non-taxable amounts for each invoice, along with 
the tax that was charged.

• The total tax, taxable, and non-taxable amounts for each sales tax 
category

The sales tax
categories you
set up appear

here

You can select a
month or range of

months for the
report
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Creating Sales Tax Report
1 Select the sales tax category or categories for the report.

If necessary, scroll the list box to find the name of the sales tax 
category you want.

You can select a consecutive or non-consecutive series of sales tax 
categories from the list (for details, see “Making Selections in a 
Reports List” on page 242.).

2 Select the month or range of months for the report.

3 Click View, Print, or Text File.

Sales Tax report example:

 

The sales tax
category’s name
and percentage

appear here

Totals for each
sales tax category

are shown



300 Chapter 11 Financial & Other Reports

Salesperson Report
MultiLedger provides a Salesperson report that shows commissionable 
sales, gross margin, and commission calculations for any salesperson 
you’ve set up. Sales associated with a salesperson are recorded on the 
Customer Invoices window. 

Click Salesperson Report in the Command Center.

 

The Salesperson report can include all or a selected group of 
salespeople. The Salesperson report includes the following information 
for the selected month or range of months:

• Salesperson’s name, commission rate, and whether the 
commission is based on gross sales or on gross margin

Note If you created Long Names in the Salesperson setup, those names will 
show on the report. Otherwise, you will see what was entered in the 
Name field.

• Date, invoice number, customer name, and sales for each invoice 
associated with the salesperson

The salespeople
you set up on the

Salesperson
window appear

here

You can select a
month or range of

months for the
report
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• Total commissionable sales, gross margin, and the salesperson’s 
commission

• Invoices that have been paid in full by the customer are marked 
with an asterisk (*) in the report

• Total of all invoices, as well as the total for all invoices that have 
been paid in full. This is helpful if you pay salesperson 
commissions only after payment has been received

Creating a Salesperson Report
1 Select the salesperson or salespeople for the report.

If necessary, scroll the list box to find the name of the salesperson you 
want.

If you want all the salespeople to print at once, but want them on 
separate pages, select the “Separate page per Salesperson” checkbox.

You can select a consecutive or non-consecutive series of salespeople 
from the list (for details, see “Making Selections in a Reports List” on 
page 242). If no salespeople are selected, all salespeople will be 
reported.

2 Select a month or range of months.

3 Click View, Print, or Text File.

Salesperson report example:
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The salesperson’s
name and

commission rate
are shown

Total invoices, as
well as total paid
invoices appear

here

Totals for all
selected

salespeople
appear here

Invoices that have been paid by
the customer are marked with

asterisk
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Job Reports
Job summary report shows actual and estimated job income and 
expense, estimated cost, the difference between these values, and the 
net income. There is also a Job Detail report that provides more detail.

Click Job Reports in the Command Center.

 

Job Summary This report shows the following information for each selected job:

• Job number and name

• The general ledger accounts that are affected

• Current and prior income and expense

• Total income & expense, and the net for the job

• Total estimated income & expense, and net for the job

• Totals for all jobs selected

You can select a month or range of months for this report.

 

The jobs you set
up on the Jobs
window appear

here

You can select a
month or range of

months for the
report
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Job Detail This report shows the following income and expense details for each 
selected job:

• Ledger account number for each income or expense

• Income or expense date

• Description of each income or expense

• Document number associated with each income or expense

• Journal type used to record the income or expense

• Amount of each income or expense

• Totals of all jobs selected

After closing the year, job reports will no longer show job detail for the 
closed year. However, the income and expense for the Job are added to 
Prior Income and Prior Expense in the new year. 

Creating Jobs Reports
1 Select the job name or names.

If necessary, scroll the list box to find the name of the job you want.

You can select a consecutive or non-consecutive series of jobs from the 
list (for details, see “Making Selections in a Reports List” on 
page 242).

If no jobs are selected, all jobs will be reported.

2 Select a month or range of months.

3 Select the Job Summary or Job Detail radio button. 

4 Click View, Print, or Text File.
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Job Summary report example:

 

Income and
expense, including
estimated income

and expense, for a
job are shown on

this report

Balance Sheet
accounts (1000-

2999) are shown,
but do not figure in

the totals for income
and expense
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Job Detail report example:

Income and
expense for a job is

shown by invoice,
including ledger

account, date, and
transaction journal

Current income and
expense are

summarized here
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Chapter 12
Backing Up & Restoring 

This chapter discusses the importance of backing up your company 
files. It also discusses how to make and how to restore a backup.
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Backing Up Your Company Files
MultiLedger has a backup feature that compresses your company files 
into a Zip file (.zip) and lets you choose where you want to save the 
archive. When you want to open a backup archive, you must first 
restore it using the Restore Backup command under the File menu. 
For more information on restoring a backup, see “Restoring a Backup 
Archive on Windows” on page 311. Or “Restoring a Backup Archive 
on Macintosh” on page 313.

Important We cannot stress enough the importance of making frequent backups of 
your company files. Backups are sometimes the only way to restore data 
that is lost due to a power failure or a system crash. Please use the 
Backup feature in MultiLedger, we cannot support or help recover 
backups made by other methods.

Suggestions for Backing Up
Backing up your company files is very important. While there are no 
set rules for how frequently you should back up, you should consider 
how much work you could reasonably reconstruct if a crash or problem 
should occur. For some companies, this would mean daily backups; for 
others, once a month is fine. If you are using MultiLedger in a multi-
user environment, you should consider making daily backups.

It is also important to keep a backup that is not on your hard drive, in 
case your hard drive should fail. You could backup to a another hard 
drive, or any other external media.

Automatic Backup Reminder
You can set up an automatic alert in MultiLedger that will remind you 
to make a backup of your company files. This way, you can be sure you 
have current backups of your accounting records. For more 
information on setting up the automatic backup reminder, see “Setting 
User Settings” on page 78.
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Backing Up Your Company Files on Windows
1 Choose Backup Company from the File menu.

A dialog appears that allows you to name the backup archive and 
choose where you want to save it.

2 Change the name of the backup archive, if necessary.

The default name for the archive is “m,” followed by part of your 
company name, the current date, and the suffix “.zip.” Don’t change or 
delete the “.zip” suffix.

3 Choose where you want to save the backup archive.

Be sure to pay attention to where you save the backup. You may want 
to change the folder using the pull-down menu and list below. You can 
save the backup archive anywhere, such as on your hard drive or 
another type of media.

Note While it’s a good idea to store backups on external media, you could 
also make a folder named “Backups” in the MultiLedger directory and 
store all your backups there. That way they will be easy to find when 
you want to restore one.

4 Click Save.

When the backup is complete a “Backup successful” message appears.

The default name for your
backup is “m,” followed by part

of your company name, today’s
date, and the suffix .zip

Use the pop-up menu to choose
where you want to save the

backup. You can even backup to
a floppy or ZIP drive
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Backing Up Your Company Files on Macintosh
1 Choose Backup Company from the File menu.

A dialog appears that allows you to name the backup archive and 
choose where you want to save it.

2 Change the name of the backup archive, if necessary.

The default name for the archive is the letter “m” (for MultiLedger), 
plus part of the name of your company files followed by the current 
date and the suffix “.zip.” Don’t change or delete the “.zip” suffix.

3 Choose where you want to save the backup archive.

The default for the dialog is your company folder. You should change 
the folder before clicking Save. You can save the backup archive 
anywhere, such as on your hard drive, or another type of media.

4 Click Save.

Note While it’s a good idea to store backups on external media, you could 
also create a folder in the MultiLedgerƒ folder, name it “Backups,” and 
store all your backups there. That way they will be easy to find when 
you want to restore one.

Use the pop-up menu to
choose where you want to
save the backup. You can
even backup to a floppy or

ZIP drive.

The default name for your
backup is the letter “m”,
plus part of the name of

your company files
followed by today’s date

and the suffix .zip.
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Restoring a Backup Archive on Windows
In order to open company files stored as a .zip backup archive, first you 
must restore the backup archive.

Important If you try to double click the “.zip” backup file to open, you will most 
likely get the message that it can’t find an application to open. The files 
must be restored using the Restore Backup command as described 
below before they can be opened.

1 Open MultiLedger, but don’t open a set of company files. Or, if a 
company is open, choose Close Company from the File menu.

2 Choose Restore Backup from the File menu.

An Open dialog box appears.

3 Locate the backup archive using the dialog box.

If you backed up your company files on a an external drive, you should 
insert the disk now. Use the Look In pop-up menu and list below to 
locate the backup archive.

Note If you created a folder named “Backups” in the MultiLedger directory, 
as suggested above, simply use the Look In pop-up menu to locate the 
Backups folder in the MultiLedger directory (in Program Files), then 
click Open.

You may have to
use the pop-up

menu and list to
locate the .zip

backup archive
saved using the

Backup Company
command, then

click Open
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4 Click Open.

An Extract To dialog similar to the following appears:

5 Select where you want to restore the company files using the Extract To 
dialog box. 

Note If you created a folder named “Backups” as suggested in the Backing 
Up Your Company Files section above, you could also restore the 
backup in the Backups folder. Simply locate and select the Backups 
folder in the MultiLedger directory (in Program Files), then click OK. 
Keep in mind that you may have to click the plus sign (+) next to a 
folder to see the folder’s contents. 

Important Unless your intent is to replace your original company files with the 
restored files, you should avoid selecting the folder where your original 
company files are located, as the restored files will replace your original 
files.

Use the list to choose where
you want to save the restored

backup.

Avoid restoring the backup in
the folder where your original
company files are located, as
they will replace your original

files
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Note You can create a new folder for the restored files by clicking the Make 
New Folder button on this dialog. Right Click “New Folder” then 
choose Rename. Type a name for the folder, then hit Enter on the 
keyboard. Make sure the folder you just created is automatically 
selected as the location for the restored files. 

6 Click OK.

7 The restored company files open automatically.

Restoring a Backup Archive on Macintosh
In order to open company files stored as a backup archive, first you 
must restore the backup archive.

Important If you try to double click the “.zip” backup file to open, you will most 
likely get the message that it can’t find an application to open. The files 
must be restored using the Restore Backup command as described 
below before they can be opened.

1 Open MultiLedger, but don’t open a set of company files. Or, if a 
company is open, choose Close Company from the File menu.

2 Choose Restore Backup from the File menu.

An Open dialog box appears.

3 Locate the backup archive using the dialog box.

If you backed up your company files on an external drive, you should 
insert the disk now. Use the pop-up menu and list to locate the backup 
archive.

Note If you created a folder named “Backups” in the MultiLedgerƒ, as 
suggested above, simply use the dialog box to locate the Backups folder 
in the MultiLedgerƒ folder (on your hard drive), then click Open.
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4 Click Open.

A dialog similar to the following appears:

Use the pop up menu and list
to locate the backup archive,

then click Open

Use the pop-up menu and list
to choose where you want to

save the restored backup.

Avoid restoring the backup in
the folder where your original
company files are located, as
they will replace your original

files
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5 Select where you want to restore the company files using the dialog 
box. 

Note If you created a folder named “Backups” as suggested in the Backing 
Up Your Company Files section above, you could also restore the 
backup in the Backups folder. Simply locate and select the Backups 
folder in the MultiLedgerƒ folder (on your hard drive), then click Open 
or Choose. 

Important Unless your intent is to replace your original company files with the 
restored files, you should avoid selecting the folder where your original 
company files are located, as the restored files will replace your original 
files.

Note You can create a new folder for the restored files by clicking the New 
Folder button on this dialog. Name the folder, then click Create. The 
folder you just created is automatically selected as the location for the 
restored files. 

6 Click Open or Choose.

The restored company files open automatically.

The original backup archive remains unchanged and can be restored 
again.
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Using Backups in a Cross-Platform Environment
Because MultiLedger compresses the backup as .zip file, you can 
restore a backup on any Macintosh computer or Windows computer 
that is running the current version of MultiLedger. This makes it easy 
to transfer company files between Mac and Windows platforms. 

Note Since PCs cannot read a Macintosh-formatted disk, you should make all 
backups to PC-formatted disks if you’re using the backups in a cross-
platform environment. 
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Appendix A Working with 
CheckMark Payroll

This appendix describes how to post employee and employer cheque 
information from CheckMark Payroll into MultiLedger.
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Posting Employee Cheques to MultiLedger for Windows
Employee cheque information from CheckMark Payroll for Windows 
can be posted to MultiLedger for Windows  by following these 
instructions.

Set up Ledger Accounts in CheckMark 
Payroll
Before posting to MultiLedger, you should assign account numbers to 
payroll categories in CheckMark Payroll.

1 In CheckMark Payroll, click Ledger Accounts in the Command 
Center.

2 Assign MultiLedger account numbers to all applicable Payroll 
Categories.

For more information on setting up Ledger Accounts, see your 
CheckMark Payroll User’s Manual.

Review Posting Summary
After you have calculated payroll and created cheques in CheckMark 
Payroll, you should review the Posting Summary to make sure the 
information is correct before you post to MultiLedger. 

3 In CheckMark Payroll, click Employee Paycheques in the Command 
Center, then select Posting Summary.

4 Select Month or cheque Dates for the Report Range, then select the 
month or cheque dates.

5 Highlight the cheques that you want to review from the list on the left. 

If no cheques are highlighted, information for all cheques will be 
reported.

6 Click View or Print.

The Posting Summary report shows cheque information in a 
summarized format. The net for each cheque is shown, along with 
totals for wages, income, taxes, and deductions. Employer payroll 
taxes are shown as an entry at the bottom of the report. These are 
accrued tax liabilities and total expense for FICA, FUTA, and SUTA.

7 Verify that all ledger accounts are assigned correctly.

For help with incorrectly assigned Ledger Accounts, see your 
CheckMark Payroll User’s Manual.
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Posting to MultiLedger for Windows
8 Make sure you have your MultiLedger company files open.

9 In CheckMark Payroll, click Employee Paycheques in the Command 
Center if you haven’t already.

10 Select Month or Cheque Dates for the Report Range, then select the 
month or cheque dates.

11 Highlight the cheques that you want to post to MultiLedger from the 
list on the left.

If no cheques are highlighted, all cheques will be saved to the text file.

12 If you distribute wages or hours to jobs, you should check the Include 
Jobs in Post Summary option. 

13 Check the Mark Posted Cheques option.

That way, cheques that have been posted to MultiLedger will be 
marked with an “x”.

14 Verify that the Cheques Reference #, Taxes Reference #, Cheques 
Posting Date, and Taxes Posting Date are correct.

You can use these edit boxes to enter reference numbers and posting 
dates for cheques posted to MultiLedger. The default name for the 
Cheques Reference # is "PR" followed by the date of the first 
unmarked cheque in the list. The default name for the Taxes Reference 
# is "ET" followed by the date of the first unmarked cheque in the list. 
For information on marking cheques that have been posted to 
MultiLedger, see step 13 above.

The default date for the Cheques Posting Date and Taxes Posting Date 
is the date of the first unmarked cheque in the list. If necessary, you 
can change the information in these edit boxes.

Note If you need to post payroll cheques that have the same date as cheques 
you've already posted, you should change the Cheques Reference # and 
Taxes Reference #. Otherwise, you will receive an error message and 
the posting will fail, as MultiLedger cannot accept entries with both the 
same reference number and same date. 
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15 Click Post to MultiLedger. 

A Save As dialog appears. The file is named Payroll by default.

Note The Payroll file is a temporary file that can be dragged to the trash when 
posting is complete. Or, if you save it in the same location each time, 
you can simply choose to replace it each time you post payroll, thus 
avoiding confusion of having multiple Payroll files on your hard drive. 

16 Choose where you want to save the file, then click Save.

When the posting is complete, you will receive a message. Two files 
are posted to the General Journal in MultiLedger. A PR-[date] entry for 
employee cheques and an ET-[date] entry for employer taxes.

17 Click OK.

Note When you receive the message that posting has been sent, it does not 
necessarily mean that the posting was successful. The posting process 
sends information from CheckMark Payroll to MultiLedger, but does 
not send information from MultiLedger back to CheckMark Payroll. 
You should check the General Journal in MultiLedger to make sure the 
PR and ET entries were sent correctly. 
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Posting Employer Cheques to MultiLedger for Windows
Employer payment cheques from CheckMark Payroll for Windows can 
be posted to MultiLedger for Windows  by following these 
instructions.

Set up Ledger Accounts in CheckMark 
Payroll
Before posting to MultiLedger, you should assign account numbers to 
payroll categories in CheckMark Payroll.

1 In CheckMark Payroll, click Ledger Accounts in the Command 
Center.

2 Assign MultiLedger account numbers to all applicable Payroll 
Categories.

For more information on setting up Ledger Accounts, see your 
CheckMark Payroll User’s Manual.

Review Posting Summary
After you have created employer payment cheques in CheckMark 
Payroll, you should review the Posting Summary to make sure the 
information is correct before you post to MultiLedger. 

3 In CheckMark Payroll, click Employer Cheques in the Command 
Center, then select Posting Summary.

4 Select the month.

5 Highlight the cheques that you want to review from the list on the left. 

If no cheques are highlighted, information for all cheques will be 
reported.

6 Click View or Print.

7 Verify that all ledger accounts are assigned correctly.

For help with incorrectly assigned Ledger Accounts, see your 
CheckMark Payroll User’s Manual.

Posting to MultiLedger for Windows
8 Make sure you have your MultiLedger company files open.

9 In CheckMark Payroll, click Employer Cheques in the Command 
Center if you haven’t already.

10 Select the month.
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11 Highlight the cheques that you want to post to MultiLedger from the 
list on the left.

If no cheques are highlighted, all cheques will be saved to the text file.

12 Click Post to MultiLedger. 

A Save As dialog appears. The file is named Employer by default.

Note The Employer file is a temporary file that can be dragged to the trash 
when posting is complete. Or, if you save it in the same location each 
time, you can simply choose to replace it each time you post payroll, 
thus avoiding confusion of having multiple Employer files on your hard 
drive. 

13 Choose where you want to save the file, then click Save.

If a vendor does not exist in MultiLedger, you will be asked to add the 
vendor. When the posting is complete, you will receive a message. The 
cheques are posted to the Disbursements Journal in MultiLedger.

14 Click OK.

Note When you receive the message that posting has been sent, it does not 
necessarily mean that the posting was successful. The posting process 
sends information from CheckMark Payroll to MultiLedger, but does 
not send information from MultiLedger back to CheckMark Payroll. 
You should check the Disbursements Journal in MultiLedger to make 
sure the cheques were sent correctly. 
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Posting Employee Cheques to MultiLedger for Macintosh
Employee cheque information from CheckMark Payroll for Macintosh 
can be posted to MultiLedger for Macintosh by following these 
instructions.

Set up Ledger Accounts in CheckMark 
Payroll
Before posting to MultiLedger, you should assign account numbers to 
payroll categories in CheckMark Payroll.

1 In CheckMark Payroll, click Ledger Accounts in the Command 
Center.

2 Assign MultiLedger account numbers to all applicable Payroll 
Categories.

For more information on setting up Ledger Accounts, see your 
CheckMark Payroll User’s Manual.

Review Posting Summary
After you have calculated payroll and created cheques in CheckMark 
Payroll, you should review the Posting Summary to make sure the 
information is correct before you post to MultiLedger. 

3 Click Employee Paycheques in the Command Center, then select 
Posting Summary.

4 Select the cheque date(s) from the list.

5 Select the desired cheques from the list on the left.

If no cheques are highlighted, information for all cheques will be 
reported.

6 Click View or Print.

The Posting Summary report shows cheque information in a 
summarized format. The net for each cheque is shown, along with 
totals for wages, income, taxes, and deductions. Employer payroll 
taxes are shown as an entry at the bottom of the report. These are 
accrued tax liabilities and total expense for FICA, FUTA, and SUTA.

7 Verify that all ledger accounts are assigned correctly.

For help with incorrectly assigned Ledger Accounts, see your 
CheckMark Payroll User’s Manual.
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Posting to MultiLedger for Macintosh
8 Make sure you have your MultiLedger company open.

9 In CheckMark Payroll, click Employee Paycheques in the Command 
Center, if you haven’t already.

10 Select the cheque date(s) from the list.

11 Select the desired cheques from the list on the left.

If no cheques are selected, all cheques for the selected cheque date(s) 
will be posted.

12 If you enter hours or distribute wages by MultiLedger Job, check the 
Include Jobs in Post Summary check box.

13 Make sure the 'x' Post Summary Entries check box is checked.

That way, the cheques that have been posted to MultiLedger will be 
marked with an X.

14 Verify that the Cheques Reference #, Taxes Reference #, Cheques 
Posting Date, and Taxes Posting Date are correct.

You can use these edit boxes to enter reference numbers and posting 
dates for cheques posted to MultiLedger. The default name for the 
Cheques Reference # is "PR" followed by the date of the first 
unmarked cheque in the list. The default name for the Taxes Reference 
# is "ET" followed by the date of the first unmarked cheque in the list. 
For information on marking cheques that have been posted to 
MultiLedger, see step 13 above.

The default date for the Cheques Posting Date and Taxes Posting Date 
is the date of the first unmarked cheque in the list. If necessary, you 
can change the information in these edit boxes.

Note If you need to post payroll cheques that have the same date as cheques 
you've already posted, you should change the Cheques Reference # and 
Taxes Reference #. Otherwise, you will receive an error message and 
the posting will fail, as MultiLedger cannot accept entries with both the 
same reference number and same date. 

15 Click the Post to MultiLedger button.
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A Save As dialog appears. The file is named Posting Summary by 
default.

Note The Posting Summary file is a temporary file that can be dragged to the 
trash when posting is complete. Or, if you save it in the same location 
each time, you can simply choose to replace it each time you post 
payroll, thus avoiding confusion of having multiple Posting Summary 
files on your hard drive. 

16 Choose where you want to save the file, then click Save.

When the posting is complete, you will receive a message. Two files 
are posted to the General Journal in MultiLedger. A PR-[date] entry for 
employee cheques and an ET-[date] entry for employer taxes.

Note When you receive the message that posting has been sent, it does not 
necessarily mean that the posting was successful. The posting process 
sends information from CheckMark Payroll to MultiLedger, but does 
not send information from MultiLedger back to CheckMark Payroll. 
You should check the General Journal in MultiLedger to make sure the 
PR and ET entries were sent correctly. 
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Posting Employer Cheques to MultiLedger for Macintosh
Employer payment cheques from CheckMark Payroll for Macintosh 
can be posted to MultiLedger for Macintosh by following these 
instructions.

Set up Ledger Accounts in CheckMark 
Payroll
Before posting to MultiLedger, you should assign account numbers to 
payroll categories in CheckMark Payroll.

1 In CheckMark Payroll, click Ledger Accounts in the Command 
Center.

2 Assign MultiLedger account numbers to all applicable Payroll 
Categories.

For more information on setting up Ledger Accounts, see your 
CheckMark Payroll User’s Manual.

Review Cheque Summary
After you have created employer payment cheques in CheckMark 
Payroll, you should review them to make sure the information is 
correct before you post to MultiLedger. 

3 In CheckMark Payroll, click Employer Cheques in the Command 
Center.

4 Select the month.

5 Highlight the cheques that you want to review from the list on the left. 

If no cheques are highlighted, information for all cheques will be 
reported.

6 Click View or Print.

The report shows individual cheque information.

7 Verify that all ledger accounts are assigned correctly.

For help with incorrectly assigned Ledger Accounts, see your 
CheckMark Payroll User’s Manual.

Posting to MultiLedger for Macintosh
8 Make sure you have your MultiLedger company open.

9 In CheckMark Payroll, click Employer Cheques in the Command 
Center, if you haven’t already.

10 Select the cheque month from the list on the right.
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11 Select the desired cheques from the list on the left.

If no cheques are selected, all cheques for the selected month will be 
posted.

12 Click the Post to MultiLedger button.

A Save As dialog appears. The file is named Employer Cheques by 
default.

Note The Employer Cheques file is a temporary file that can be dragged to 
the trash when posting is complete. Or, if you save it in the same 
location each time, you can simply choose to replace it each time you 
post payroll, thus avoiding confusion of having multiple Employer 
Cheques files on your hard drive. 

13 Choose where you want to save the file, then click Save.

When the posting is complete, you will receive a message. The 
cheques are posted to the Disbursements Journal in MultiLedger

Note When you receive the message that posting has been sent, it does not 
necessarily mean that the posting was successful. The posting process 
sends information from CheckMark Payroll to MultiLedger, but does 
not send information from MultiLedger back to CheckMark Payroll. 
You should check the Disbursements Journal in MultiLedger to make 
sure the cheques were sent correctly. 
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Possible Posting Errors for Employee Cheques
Below are some possible error messages you can receive when trying 
to post employee cheques into MultiLedger and ways to correct them.

• "MultiLedger 5.1 or higher must be running and company 
files must be open to post"— To correct this, simply open your 
MultiLedger company files and try posting again. You must be 
using MultiLedger 5.1.x or higher.

• "Account <8000> not found-Record 1"—You have a general 
ledger account in CheckMark Payroll that is not found in 
MultiLedger. To correct this, verify that all accounts in the Posting 
Summary report in CheckMark Payroll have matching accounts in 
your MultiLedger company files. Then make any necessary 
changes in either CheckMark Payroll or MultiLedger. 

• "Account <Chk 2> not found-Record 1"—There are two 
possible explanations for this error message.

1) You distribute wages or hours to jobs but have not checked the 
Include Jobs in Post Summary check box. To correct this, check the 
Include Jobs in Post Summary checkbox on the Employee Paycheques 
window then try posting again.

2) You do not distribute wages or hours to jobs but have checked 
the Include Jobs in Post Summary check box. To correct this, 
uncheck the Include Jobs in Post Summary checkbox on the Employee 
Paycheques window then try posting again.

• "Duplicate Document number found. Document not 
imported."—There are three possible explanations for this error 
message.

1) You have imported the payroll cheques already. You should 
verify in MultiLedger that the cheques you are trying to post have not 
already been posted. To do this:

Click Transaction Journals in MultiLedger's Command Center, then 
select the month from the month list. 

Select the General radio button, then look for PR and ET entries for 
that date to see if cheques have already been posted.

2) You are importing payroll cheques with the same date as 
cheques you have imported already. If you are posting cheques that 
have the same date as cheques you have already posted to MultiLedger, 
the Cheques Reference # and the Taxes Reference # on the Employee 
Paycheques window in Payroll will be the same as the cheques you 
already posted. You should change the Cheques Reference # and Taxes 
Reference # and try posting again. 
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3) You have a General Journal transaction in MultiLedger that has 
the same document number and date as the payroll transaction 
you are trying to post. Check the General Journal in MultiLedger for 
a transaction with the same document number and date as the 
transaction from Payroll. Usually it is the ET-[date] entry that is 
duplicated. If necessary, change the Cheques Reference # and the 
Taxes Reference # in Payroll and try posting again. 

Possible Posting Errors for Employer Cheques
Below are some possible error messages you can receive when trying 
to post employer cheques into MultiLedger and ways to correct them. 

• "MultiLedger 5.1 or higher must be running and company 
files must be open to post"— To correct this, simply open your 
MultiLedger company files and try posting again. You must be 
using MultiLedger 5.1.x or higher.

• "Account <8000> not found-Record 1"—You have a general 
ledger account in CheckMark Payroll that is not found in 
MultiLedger. To correct this, verify that all accounts in the 
Employer Cheques report in CheckMark Payroll have matching 
accounts in your MultiLedger company files. Then make any 
necessary changes in either CheckMark Payroll or MultiLedger. 

• "Duplicate Document number found. Document not 
imported."—There are two possible explanations for this error 
message.

1) You have imported the cheques already. You should verify in 
MultiLedger that the cheques you are trying to post have not already 
been posted. To do this:

Click Transaction Journals in MultiLedger's Command Center, then 
select the month from the month list. 

Select the Disbursements radio button, then look those cheque 
numbers to see if cheques have already been posted.

2) You have a cheque number in MultiLedger that has the same 
document number as the cheque you are trying to post. Change the 
document number, and try posting again.
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Appendix B Sample COAs

The charts of accounts in this appendix are contained in the folder, 
"Sample COAs," on your master disk.
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Basic Chart of Accounts
1010 Cash In Bank - Chequeing Acct. 6800 Insurance - Business

1020 Money Market Account 6900 Insurance - Health

1100 Accounts Receivable 7000 Interest Expense

1200 Prepaid Expenses 7100 Legal & Professional Services

1700 Computer Equipment 7200 Meals & Entertainment

1720 Office Furniture & Equipment 7300 Miscellaneous Expense

1740 Vehicles 7400 Office Supplies

1800 Accum. Depr. - Computer Equip. 7500 Pension/Profit Sharing Expense

1820 Accum. Depr. - Office 7600 Postage

1840 Accum. Depr. - Vehicles 7700 Rent

2100 Accounts Payable 7800 Repairs & Maintenance

2200 Sales Tax Payable 7900 Salaries

2300 Federal Withholding Tax 8000 Taxes & Licenses

2400 State Withholding Tax 8100 Telephone

2500 FICA Tax Payable 8200 Travel

2550 State Disability Tax 8300 Utilities

2700 Bank Loan 9100 Interest Earned

3000 Capital 7400 Office Supplies

3100 Owners Draw 7500 Pension/Profit Sharing Expense

3200 Retained Earnings

4100 Sales

5000 Cost of Sales

6000 Automobile Expense

6100 Advertising/Marketing

6200 Bad Debts

6300 Bank Charges

6400 Contributions

6500 Depletion

6600 Depreciation Expense

6700 Dues & Memberships
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Construction Partnership Chart of Accounts
1010 Cash In Bank - Chequeing Acct 3100 Partner B Investment

1020 Cash in Bank - Payroll Acct 3150 Partner B Withdrawal

1030 Undeposited Cash 3300 Retained Earnings

1040 Petty Cash 4000 Sales-Commercial

1100 Accounts Receivable 4100 Sales-Land

1200 Contracts Receivable 4200 Sales-Extras

1400 Inventory 4300 Sales-Residential

1410 Construction in Progress 4400 Other Income

1420 Material-Unused & Unassigned 5000 Cost of Sales-Commercial

1430 Unimproved Land/Non-subdiv. 5100 Cost of Sales-Land

1500 Prepaid Insurance 5200 Cost of Sales-Extras

1510 Prepaid Taxes 5300 Cost of Sales-Residential

1520 Prepaid Interest 5400 Cost of Delivery/Shipping

1710 Furniture & Equipment 6000 Advertising

1720 Leasehold Improvements 6050 Auto-Gas, Oil, & Maintenance

1730 Vehicles 6100 Automotive Equipment

1810 Accum Depr - Furn & Equip 6150 Bad Debts

1820 Accum Depr - Leasehold Improv 6200 Bank Service Charges

1830 Accum Depr - Vehicles 6250 Casualty & Liability Insurance

2100 Accounts Payable 6300 Commissions Paid

2200 State Sales Tax Payable 6350 Depletion

2250 City Sales Tax Payable 6400 Depreciation Expense

2300 Federal Withholding Tax 6450 Dues & Subscriptions

2310 Federal Unemployment Tax 6500 Equipment Rental

2400 State Withholding Tax 6550 Insurance - Fire & Ext Covg

2410 State Unemployment Tax 6600 Insurance - General

2500 FICA Tax Payable 6650 Insurance - Health

2510 Employee 401K Savings Plan 6700 Interest on Morg/Loans

2520 Employee Health Insurance 6750 Legal & Accounting

2530 Employee Cafeteria Plan 6800 License Fees

2540 United Way 6850 Machinery Fuel & Supplies

2550 Union Dues 6900 Meals & Entertainment

2600 Accrued Real Estate Taxes 6950 Mileage Exp

2700 Construction Loans Payable 7000 Office Supplies

2800 Customer Escrow Deposits 7050 Pension/Profit Sharing Exp

2900 Other Long-Term Liabilities 7100 Postage

3000 Partner A Investment 7150 Real Estate Taxes-Other

3050 Partner A Withdrawal 7200 Rent
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7250 Repairs-Auto & Machinery 8700 Wages

7300 Repairs-Other 8800 Wages - Tax Expense

7350 State Franchise Taxes 8900 Workmen's Comp Insurance

7400 Stationery & Printing 9000 Gain/Loss on Sales of Assets

7450 Telephone 9100 Interest Income

7500 Travel 9500 Interest Expense

7550 Utilities 9600 Tax Expense
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Graphic Artist Chart of Accounts
1010 Chequeing 4500 Miscellaneous income

1020 Payroll Chequeing 5000 Freight

1030 Cash register drawer 6000 Professional promotion

1040 Petty cash 6100 Commissions paid

1100 Accounts receivable 6200 Depreciation

1200 Other current assets 6300 Discounts given

1400 Inventory 6400 Discounts taken

1600 Graphic arts equipment cost 6500 Dues and subscriptions

1620 Furniture and fixtures cost 6600 Insurance

1640 Automobiles cost 6700 Interest

1700 Accum depr-graphic arts equip 6800 Late fees paid

1720 Accum depr-furniture and fixt. 6900 Legal and accounting

1740 Accum depr-automobiles 7000 License fees

1900 Deposits paid 7100 Maintenance

1920 Other non-current assets 7200 Office supplies

2100 Accounts payable 7300 Payroll wages

2200 Sales tax payable 7400 Payroll employer expense

2300 Accrued payroll taxes 7500 Graphic art supplies

2320 Accrued employer expenses 7600 Postage

2400 Customer deposits 7700 Rent

2500 Other current liabilities 7800 Supplies

2600 Bank loans 7900 Telephone

2700 Other long-term liabilities 8000 Travel and entertainment

3000 Owner's investment 8100 Utilities-electric

3100 Owner's withdrawal 8200 Utilities-gas

3200 Suspense 8300 Utilities-water

3300 Retained earnings 9000 Interest income

4000 Contract fees 9500 Interest expense

4100 Commissions 9600 Suspense

4400 Late fees collected
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Medical Partnership Chart of Accounts
1010 Cash In Bank - Chequeing Acct. 6200 Bad Debts

1020 Money Market Account 6200.01 Bad Debts - Partner A

1100 Accounts Receivable 6200.02 Bad Debts - Partner B

1200 Prepaid Expenses 6300 Bank Charges

1700 Medical Equipment 6400 Contributions

1720 Office Furniture & Equipment 6500 Depletion

1740 Vehicles 6600 Depreciation Expense

1800 Accum. Depr. - Medical Equip. 6700 Dues & Subscriptions

1820 Accum. Depr. - Office 6700.01 Dues & Subscriptions-Partner A

1840 Accum. Depr. - Vehicles 6700.02 Dues & Subscriptions-Partner B

2100 Accounts Payable 6800 Insurance - General

2200 Sales Tax Payable 6900 Insurance - Group

2300 Federal Withholding Tax 6950 Insurance - Owner

2400 State Withholding Tax 6950.01 Insurance - Owner - Partner A

2500 FICA Tax Payable 6950.02 Insurance - Owner - Partner B

2550 State Disability Tax 7100 Legal & Accounting Services

2700 Bank Loan 7200 Meals & Entertainment

3000 Capital - Partner A 7200.01 Meals & Entertainment-Partner A

3050 Capital - Partner B 7200.02 Meals & Entertainment-Partner B

3100 Owners Draw - Partner A 7300 Miscellaneous Expense

3150 Owners Draw - Partner B 7300.01 Miscellaneous Exp.- Partner A

3200 Retained Earnings 7300.02 Miscellaneous Exp.- Partner B

4100 Patient Fees 7400 Office Supplies

4100.01 Patient Fees - Partner A 7410 Equipment Rental

4100.02 Patient Fees - Partner B 7420 Laboratory Expenses

4110 Consultation Fees 7420.01 Laboratory Exp. - Partner A

4110.01 Consultation Fees - Partner A 7420.02 Laboratory Exp. - Partner B

4110.02 Consultation Fees - Partner B 7440 Reference Material

4120 Miscellaneous Income 7440.01 Reference Material - Partner A

4120.01 Miscellaneous - Partner A 7440.02 Reference Material - Partner B

4120.02 Miscellaneous - Partner B 7450 Laundry

4130 Fee Refund 7450.01 Laundry - Partner A

4130.01 Fee Refund - Partner A 7450.02 Laundry - Partner B

4130.02 Fee Refund - Partner B 7460 Medical Supplies

6000 Automobile Expense 7500 Pension/Profit Sharing Expense

6000.01 Automobile Expense - Partner A 7600 Postage

6000.02 Automobile Expense - Partner B 7700 Rent

6100 Advertising/Marketing 7800 Repairs & Maintenance
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7900 Payroll Salaries 8200 Travel

7950 Payroll Taxes 8200.01 Travel - Partner A

8000 Licenses 8200.02 Travel - Partner B

8000.01 Licenses - Partner A 8300 Utilities

8000.02 Licenses - Partner B 9100 Interest Earned

8100 Telephone 9500 Interest Expense
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Newspaper Chart of Accounts
1010 Cash in bank 4600 Merchandise sales

1020 Cash on hand 4700 Miscellaneous revenue

1100 Notes and accounts receivable 6000 Office salaries

1150 Allowance for doubtful account 6100 Taxes on payroll salaries

1200 Prepaid expenses 6200 Depr on machinery, furn, type

1400 Inventory 6300 Depr on building

1600 Land 6400 Feature and ad mat services

1620 Building 6500 Insurance and professional svc

1640 Machinery and equipment 6600 Light, power, water, gas

1660 Furniture and fixtures 6700 Memberships and dues

1680 Motor vehicles 6800 Motor vehicles and mileage

1700 Type and metal 6900 Office supplies and postage

1720 Accum depr-building 7000 Rent, fuel and heating

1740 Accum depr-machinery and equip 7100 Repairs and maintenance equip

1760 Accum depr-furniture and fixtures 7200 Taxes on plant and business

1780 Accum depr-motor vehicles 7300 Taxes and maintenance on build

1800 Accum depr-type and metal 7400 Telephone and telegraph

1900 Goodwill 7500 Miscellaneous

2100 Accounts and notes payable 8000 Shop wages

2300 Federal unemployment tax 8100 Taxes on shop payroll

2320 State unemployment tax 8200 Bad debts

2340 FICA tax payable 8300 Commissions on sales

2360 Federal withholding tax 8400 Materials

2380 State withholding tax 8500 Photos and engravings

2400 Local withholding tax 8600 Second class postage

2500 Interest payable 8700 Contributions

2560 Income tax payable 8800 Advertising and promotion

2600 Mortgage and long term notes 8900 Travel and entertainment

3000 Capital stock 9000 Cash discounts taken

3020 Retained earnings 9100 Interest earned

3040 Dividends paid 9200 Miscellaneous other income

3060 Profit and loss clearing acct 9500 Cash discounts allowed

4000 Local advertising 9600 Interest paid

4100 National advertising 9700 Miscellaneous other expense

4200 Classified advertising

4300 Legal advertising

4400 Circulation

4500 Commercial printing
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Non-Profit Chart of Accounts
1000 Current Assets 2500 Collections Due Headquarters

1010 Cash in Bank - General 2600 Long Term Liability

1020 Cash in Bank - Payroll 2700 Deposits for Future Services

1030 Petty Cash 2800 Line of Credit - Bank

1040 Undeposited Cash 2850 Notes Payable - Bank

1050 Cash Register Drawer 3000 Equity

1100 Pledges Receivable 3100 Retained Earnings

1200 Prepaid Expenses 3200 Suspense

1300 Accounts Receivable 4000 Income

1400 Inventory 4100 Donations

1500 Investments 4200 Activities Income

1550 Long Term Assets 4300 Licensing Income

1600 Building 4400 Subsidies

1620 Computer Equipment 4500 Fund Income

1640 Furniture & Fixtures 4510 Poor Fund

1660 Leasehold Improvements 4520 Youth Fund

1680 Vehicles 4530 Foreign Fund

1700 Accum. Depr. - Building 4540 Building Fund

1720 Accum. Depr. - Comp. Equip. 4550 Other Fund

1740 Accum. Depr. - Furn. & Fix. 4600 Miscellaneous Income

1760 Accum. Depr. - Leaseholds 5000 Cost of Goods

1780 Accum. Depr. - Vehicles 6000 Expenses

1900 Construction in Progress 6100 Advertising

1930 Deposits 6200 Bad Debts

1950 Long Term Notes Receivable 6300 Bank Service Charges

2000 Current Liabilities 6400 Travel & Entertainment

2100 Accounts Payable 6500 Miscellaneous

2200 Sales Tax Payable 6600 Late Fees Paid

2300 Employee Health Insurance 6700 Dues & Memberships

2310 Employee 401k Savings Plan 6900 Freight and Shipping

2320 Federal Unemployment Tax 7000 Insurance Expenseq

2330 State Unemployment Tax 7010 Insurance-Group Health

2340 FICA Tax Payable 7020 Insurance-Life

2350 Federal Withholding Tax 7030 Insurance-Disability

2360 State Withholding Tax 7100 Interest Expense

2370 Local Withholding Tax 7200 Legal Fees

2380 State Disability Ins. Tax 7300 Messenger Services

2400 Credit Card 7400 Accounting Fees
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7500 Parking 8400 Supplies - Office

7600 Pension Plan Expense 8410 Supplies - Other

7700 Postage 8500 Taxes - Payroll

7800 Rent 8600 Telephone

7900 Repairs & Maintenance 8700 Utilities

8000 Reproduction & Printing Chgs. 9000 Other Income

8100 Salaries - Staff 9100 Gain/Loss on Sale of Assets

8200 Storage 9200 Interest Earned

8300 Subscriptions 9500 Other Expenses



Partnership Chart of Accounts 341

Partnership Chart of Accounts
1010 Chequeing 6300 Bank charges

1020 Payroll Chequeing 6400 Contributions

1030 Cash register drawer 6500 Commissions and fees

1040 Petty cash 6600 Depletion

1100 Accounts receivable 6700 Depreciation

1200 Prepaid expenses 6800 Dues and memberships

1400 Inventory 6900 Employee benefits

1600 Computer equipment 7000 Insurance

1620 Office furniture and equipment 7100 Late fees

1640 Vehicles 7200 Legal and professional

1660 Leasehold improvements 7300 Maintenance and repairs

1700 Accum. depr.-computer equipment 7400 Miscellaneous

1720 Accum. depr.-office furniture 7500 Office supplies

1740 Accum. depr.-vehicles 7600 Payroll-wages

1760 Accum. depr.-leasehold improv 7700 Payroll-taxes

2100 Accounts payable 7800 Postage

2200 Sales tax payable 7900 Rent

2300 FICA tax payable 8000 Rent or lease equipment

2320 Federal withholding tax 8100 Taxes and licenses

2340 State withholding tax 8200 Telephone

2360 Federal unemployment tax 8300 Travel, meals and entertainment

2380 State unemployment tax 8400 Utilities

2400 State disability tax 9000 Interest income

2600 Note payable 9500 Interest expense

3000 Partner A investment

3020 Partner B investment

3100 Partner A withdrawal

3120 Partner B withdrawal

3200 Retained earnings

4000 Sales

4100 Returns and allowances

4200 Miscellaneous income

5000 Cost of sales

5100 Freight

5200 Purchase discounts

6000 Advertising/marketing

6100 Automobile

6200 Bad debts
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Printing/Copy Center Chart of Accounts
1010 Chequeing 5000 Paper purchases

1020 Payroll Chequeing 5020 Binder purchases

1030 Cash register drawer 5040 Stamp purchases

1040 Petty cash 5060 Other purchases

1100 Accounts receivable 5080 Ink purchases

1200 Other current assets 5100 Freight

1400 Inventory 6000 Advertising

1600 Printing equipment cost 6100 Depreciation

1620 Furniture and fixtures cost 6200 Discounts given

1640 Leasehold improvement cost 6300 Discounts taken

1700 Accum depr-printing equipment 6400 Dues and subscriptions

1720 Accum depr-furniture and fixtures 6500 Insurance

1740 Accum depr-leasehold improv. 6600 Late fees paid

1900 Deposits paid 6700 Leasehold improvements

1920 Other non-current assets 6800 Legal and accounting

2100 Accounts payable 6900 Maintenance

2200 Sales tax payable 7000 Store supplies

2300 Accrued payroll taxes 7100 Payroll wages

2320 Accrued employer expenses 7200 Payroll employer expense

2400 Customer deposits 7300 Postage and shipping

2500 Other current liabilities 7400 Rent

2600 Bank loans 7500 Telephone

2700 Other long-term liabilities 7600 Travel and entertainment

3000 Owner's investment 7700 Utilities-gas

3100 Owner's withdrawal 7800 Utilities-electricity

3200 Suspense 7900 Utilities-water

3300 Retained earnings 9000 Interest income

4000 Photocopy 9500 Interest expense

4020 Signage 9600 Suspense

4040 Other printing sales

4100 Paper

4120 Binders

4140 Stamps

4160 Other retail items

4200 Printing services

4300 Shipping collected

4400 Late fees collected

4500 Miscellaneous income
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Professional Chart of Accounts
1010 Cash In Bank - Chequeing Acct. 7200 Meals & Entertainment

1020 Money Market Account 7300 Miscellaneous Expense

1100 Accounts Receivable 7400 Office Supplies

1200 Prepaid Expenses 7500 Pension/Profit Sharing Expense

1700 Leasehold Improvements 7600 Postage

1720 Office Furniture & Equipment 7610 Printing

1740 Vehicles 7700 Rent

1800 Accum. Depr. - Leasehold 7800 Repairs & Maintenance

1820 Accum. Depr. - Office 7900 Payroll Salaries

1840 Accum. Depr. - Vehicles 7950 Payroll Taxes

2100 Accounts Payable 8000 Licenses

2200 Sales Tax Payable 8100 Telephone

2300 Federal Withholding Tax 8200 Travel

2400 State Withholding Tax 8300 Utilities

2500 FICA Tax Payable 9100 Interest Earned

2550 State Disability Tax 9500 Interest Expense

2700 Bank Loan

3000 Capital 

3100 Owners Draw

3200 Retained Earnings

4100 Fee Income

4200 Commissions

4300 Consulting

4400 Reimbursement Expenses

4500 Miscellaneous Income

6000 Automobile Expense

6100 Advertising/Marketing

6200 Bad Debts

6300 Bank Charges

6400 Contributions

6600 Depreciation Expense

6700 Dues & Memberships

6800 Insurance - General

6900 Insurance - Group

7000 Insurance - Owner

7100 Legal & Accounting Services

7110 Professional Fees

7120 Commissions Paid
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Profit Center Chart of Accounts
1010 Cash in Bank - General 3000 Common Stock

1020 Cash in Bank - Payroll 3020 Retained Earnings

1030 Petty Cash 4100 Sales - Consulting

1040 Money Market Account 4200 Sales - Labor

1100 Accounts Receivable 4300 Sales - Merchandise

1140 Allowance - Bad Debts 4300.01 Sales - Merchandise - Store 1

1200 Prepaid Expenses 4300.02 Sales - Merchandise - Store 2

1400 Inventory 4600 Sales Discounts

1600 Land 4600.01 Sales Discounts - Store 1

1620 Building 4600.02 Sales Discounts - Store 2

1640 Computer Equipment 4700 Sales Returns & Allowances

1660 Furniture & Fixtures 4700.01 Sales Returns & Allow. Store 1

1680 Leasehold Improvements 4700.02 Sales Returns & Allow. Store 2

1690 Vehicles 4800 Other Income - Finance Charges

1720 Accum. Depr. - Building 4800.01 Other Income - Store 1

1740 Accum. Depr. - Comp. Equip. 4800.02 Other Income - Store 2

1760 Accum. Depr. - Furn. & Fix. 4900 Freight Revenue

1780 Accum. Depr. - Leaseholds 4900.01 Freight Revenue - Store 1

1790 Accum. Depr. - Vehicles 4900.02 Freight Revenue - Store 2

1800 Construction in Progress 5000 Cost of Goods Sold

1900 Deposits 5000.01 Cost of Goods Sold - Store 1

1950 Long Term Notes Receivable 5000.02 Cost of Goods Sold - Store 2

2100 Accounts Payable 5050 Delivery & Freight Charges

2200 Sales Tax Payable 5050.01 Delivery & Freight - Store l

2300 Employee Health Insurance 5050.02 Delivery & Freight - Store 2

2310 Employee 401k Savings Plan 5060 Purchase Discounts

2320 Federal Unemployment Tax 5060.01 Purchase Discounts - Store 1

2330 State Unemployment Tax 5060.02 Purchase Discounts - Store 2

2340  FICA Tax Payable 6000 Accounting Fees

2350 Federal Withholding Tax 6000.01 Accounting Fees - Store l

2360 State Withholding Tax 6000.02 Accounting Fees - Store 2

2370 Local Withholding Tax 6100 Advertising

2380 State Disability Ins. Tax 6100.01 Advertising - Store l

2390 Credit Union 6100.02 Advertising - Store 2

2400 United Way 6200 Bad Debts

2700 Line of Credit - Banks 6200.01 Bad Debts - Store l

2750 Notes Payable - Bank 6200.02 Bad Debts - Store 2

2800 Notes Payable - Shareholders 6300 Bank Service Charges
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6300.01 Bank Service Charges - Store l 7030.01 Insurance-Off. Health-Store l

6300.02 Bank Service Charges - Store 2 7030.02 Insurance/Off. Health-Store 2

6400 Business - Entertainment 7040 Insurance - Officer Life

6400.01 Business/Entertainment-Store l 7040.01 Insurance/Off. Life - Store l

6400.02 Business/Entertainment-Store 2 7040.02 Insurance/Off. Life - Store 2

6410 Business - Meals 7100 Interest Expense

6410.01 Business/Meals - Store l 7100.01 Interest Exp - Store l

6410.02 Business/Meals - Store 2 7100.02 Interest Expense - Store 2

6420 Business - Travel 7200 Legal Fees

6420.01 Business/Travel - Store l 7200.01 Legal Fees - Store l

6420.02 Business/Travel - Store 2 7200.02 Legal Fees - Store 2

6500 Contributions - Charitable 7300 Messenger Services

6500.01 Contrib/Charitable - Store l 7300.01 Messenger - Store l

6500.02 Contrib/Charitable - Store 2 7300.02 Messenger - Store 2

6510 Contributions - Political 7400 Miscellaneous

6510.01 Contrib/Political - Store l 7400.01 Miscellaneous - Store l

6510.02 Contrib/Political - Store 2 7400.02 Miscellaneous - Store 2

6600 Depreciation Expense 7500 Parking

6600.01 Depreciation Expense - Store l 7500.01 Parking - Store 1

6600.02 Depreciation Expense - Store 2 7500.02 Parking - Store 2

6700 Dues and Memberships 7600 Pension Plan Expense

6700.01 Due and Memberships - Store l 7600.01 Pension Plan Expense - Store l

6700.02 Dues and Memberships - Store 2 7600.02 Pension Plan Expense - Store 2

6800 Employee - Moving Expenses 7700 Postage

6800.01 Employee/Moving - Store l 7700.01 Postage - Store l

6800.02 Employee/Moving - Store 2 7700.02 Postage - Store 2

6900 Freight and Shipping 7800 Rent

6900.01 Freight & Shipping - Store l 7800.01 Rent - Store l

6900.02 Freight & Shipping - Store 2 7800.02 Rent - Store 2

7000 Insurance - Disability 7900 Repairs & Maintenance

7000.01 Insurance/Disability - Store l 7900.01 Repairs/Maint. - Store l

7000.02 Insurance/Disability - Store 2 7900.02 Repairs/Maint. - Store 2

7010 Insurance - Group Health 8000 Reproduction & Printing Chgs.

7010.01 Insurance/Group Health-Store l 8000.01 Reproduction/Printing-Store l

7010.02 Insurance/Group Health-Store 2 8000.02 Reproduction/Printing-Store 2

7020 Insurance - Life 8100 Salaries - Agency Temp. Fees

7020.01 Insurance/Life - Store l 8100.01 Salaries-Temp. Fees - Store l

7020.02 Insurance/Life - Store 2 8100.02 Salaries-Temp. Fees - Store 2

7030 Insurance - Officer Health 8110 Salaries - Commissions
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8110.01 Salaries/Commissions - Store l 8500 Taxes - Personal Property 

8110.02 Salaries/Commissions - Store 2 8500.01 Taxes/Personal Prop. - Store l

8120 Salaries - Officers 8500.02 Taxes/Personal Prop. - Store 2

8120.01 Salaries/Officers - Store l 8510 Taxes - Payroll

8120.02 Salaries/Officers - Store 2 8510.01 Taxes/Payroll - Store l

8130 Salaries - Staff 8510.02 Taxes/Payroll - Store 2

8130.01 Salaries/Staff - Store l 8520 Taxes - Real Estate

8130.02 Salaries/Staff - Store 2 8520.01 Taxes/Real Estate - Store l

8200 Storage 8520.02 Taxes/Real Estate - Store 2

8200.01 Storage - Store l 8600 Telephone

8200.02 Storage - Store 2 8600.01 Telephone - Store l

8300 Subscriptions 8600.02 Telephone - Store 2

8300.01 Subscriptions - Store l 8700 Utilities

8300.02 Subscriptions - Store 2 8700.01 Utilities - Store l

8400 Supplies - Office 8700.02 Utilities - Store 2

8400.01 Supplies/Office - Store l 9100 Gain/Loss on Sale of Assets

8400.02 Supplies/Office - Store 2 9200 Interest Earned

8410 Supplies - Other 9600 Federal Income Tax

8410.01 Supplies/Other - Store l 9700 State Income Tax

8410.02 Supplies/Other - Store 2
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Restaurant Chart of Accounts
1010 Cash in Bank - General 5100 Cost of Sales-Food

1020 Cash in Bank - Payroll 5200 Cost of Sales-Beverage

1030 Cash Register Drawer 5300 Cost of Sales-Catering

1040 Petty Cash 5400 Cost of Sales-Rentals

1100 Accounts Receivable 5500 Other Cost of Sales

1200 Inventory 6000 Automobile Expense

1300 Deposits Paid 6010 Advertising/Marketing

1310 Prepaid Insurance 6020 Bad Debts

1320 Prepaid Taxes 6030 Bank Charges

1330 Prepaid Licenses 6040 Contributions

1700 Kitchen Equipment 6050 Dues & Subscriptions

1720 Dining Room Furn & Fixt 6060 Employee Meals

1730 China, Glass, Silver, Linen 6070 Exterminator

1740 Office Furniture & Fixtures 6080 General Insurance

1750 Automobiles 6090 Group Insurance

1760 Improvements 6100 Laundry & Linen

1800 Accum Depr-Kitchen Equipment 6110 Late Fees (Penalties)

1820 Accum Depr-DR Furn & Fixt 6120 Legal & Professional

1830 Accum Depr-Ch, Gl, Sil, Lin 6130 Kitchen Supplies

1840 Accum Depr-Office Furn & Fixt 6140 Office Supplies

1850 Accum Depr-Automobiles 6150 Postage

1860 Amortization-Improvements 6160 Repairs & Maintenance

2100 Accounts Payable 6170 Rent

2200 Sales Tax Payable 6180 Replacements

2300 Federal Withholding Tax 6190 Rubbish Removal

2400 State Withholding Tax 6200 Salaries-Management

2500 FICA Tax Payable 6210 Salaries-Host/Hostess

2550 State Disability Tax 6220 Salaries-Waiter/Waitress

2560 Employees' Payroll Deductions 6230 Salaries-Bus Person

2700 Note Payable 6240 Salaries-Dishwasher

2999 Suspense 6250 Payroll Tax Expenses

3000 Capital Stock 6260 Retirement Plan Compensation

3020 Retained Earnings 6300 Telephone

4100 Food Sales 6350 Travel & Entertainment

4200 Beverage Sales 6400 Uniforms

4300 Catering Fees 6450 Utilities

4400 Rental Fees 9000 Interest Income

4500 Other Income 9100 Gain on Assets
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9500 Interest Expense

9600 Loss on Assets
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Retail Chart of Accounts
1010 Cash In Bank - Chequeing Acct 5100.02 Cost of Sales Returns-Store 2

1020 Cash in Bank - Payroll Acct 5200.01 COS Damage/Shrinkage-Store 1

1030 Cash Register Drawer 5200.02 COS Damage/Shrinkage-Store 2

1040 Petty Cash 5300 Shipping/Postage

1100 Accounts Receivable 6000 Advertising/Marketing

1200 Prepaid Expenses 6100 Automobile Expense

1400 Inventory 6200 Bad Debts

1710 Furniture & Equipment 6300 Bank Service Charges

1720 Leasehold Improvements 6400 Commissions Paid

1730 Vehicles 6500 Contributions

1810 Accum Depr - Furniture & Equip 6600 Depletion

1820 Accum Depr - Leasehold 6700 Depreciation Expense

1830 Accum Depr - Vehicles 6800 Dividend Expense

2100 Accounts Payable 6900 Dues & Memberships

2200 State Sales Tax Payable 7000 Equipment Rental

2250 City Sales Tax Payable 7100 Franchise Fees

2300 Federal Withholding Tax 7200 Insurance - General

2310 Federal Unemployment Tax 7300 Insurance - Health

2400 State Withholding Tax 7400 Interest Expense

2410 State Unemployment Tax 7500 Legal & Accounting Services

2500 FICA Tax Payable 7600 Licenses

2510 Employee 401K Savings Plan 7700 Meals & Entertainment

2520 Employee Health Insurance 7800 Mileage Expense

2530 Employee Cafeteria Plan 7900 Pension/Profit Sharing Exp

2540 United Way 8000 Printing

2550 Union Dues 8100 Rent

2600 Bank Loan 8200 Repairs & Maintenance

2700 Other Long-Term Liabilities 8300 Store Supplies

3000 Capital Stock 8400 Telephone

3300 Retained Earnings 8500 Travel

4000.01 Sales-Store 1 8600 Utilities

4000.02 Sales-Store 2 8700 Wages

4100.01 Sales Returns-Store 1 8800 Wages - Officers

4100.02 Sales Returns-Store 2 8900 Wages - Tax Expense

4200 Other Income 9000 Gain/Loss on Sales of Assets

5000.01 Cost of Sales-Store 1 9001 Interest Income

5000.02 Cost of Sales-Store 2 9002 Interest Expense

5100.01 Cost of Sales Returns-Store 1 9003 Tax Expense
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Sole Proprietorship Chart of Accounts
1010 Chequeing 6200 Bad debts

1020 Payroll Chequeing 6300 Bank charges

1030 Cash register drawer 6400 Contributions

1040 Petty cash 6500 Commissions and fees

1100 Accounts receivable 6600 Depletion

1200 Prepaid expenses 6700 Depreciation

1400 Inventory 6800 Dues and memberships

1600 Computer equipment 6900 Employee benefits

1620 Office furniture and equipment 7000 Insurance

1640 Vehicles 7100 Late fees

1660 Leasehold improvements 7200 Legal and professional

1700 Accum. depr.-computer equipment 7300 Maintenance and repairs

1720 Accum. depr.-office furniture 7400 Miscellaneous

1740 Accum. depr.-vehicles 7500 Office supplies

1760 Accum. depr.-leasehold improv 7600 Payroll-wages

2100 Accounts payable 7700 Payroll-taxes

2120 American Express 7800 Postage

2140 MasterCard 7900 Rent

2160 Visa 8000 Rent or lease equipment

2200 Sales tax payable 8100 Taxes and licenses

2300 FICA tax payable 8200 Telephone

2320 Federal withholding tax 8300 Travel, meals and entertainment

2340 State withholding tax 8400 Utilities

2360 Federal unemployment tax 9000 Interest income

2380 State unemployment tax 9500 Interest expense

2400 State disability tax

2600 Note payable

3000 Owner's investment

3100 Owner's draw

3200 Retained earnings

4000 Sales

4100 Returns and allowances

4200 Miscellaneous income

5000 Cost of sales

5100 Freight

5200 Purchase discounts

6000 Advertising/marketing

6100 Automobile
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Appendix C Glossary
This appendix contains a glossary of accounting terms, as well as terms 
related to MultiLedger and your computer.
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Accrual Accounting - a method of accounting in which transactions 
are recorded in the period that they occur, which is not necessarily 
when cash changes hands.

ASCII - an abbreviation for the American Standard Code for 
Information Interchange. It is a standard way of representing text in 
computer files.

Assets- property owned by the company, such as cash, inventory, 
furniture, equipment, and buildings.

Audit Trail - records of the transactions of a company.

Balance Sheet - a report which lists the assets, liabilities, and equity in 
a company as of a certain date.

Bank Reconciliation - a screen in MultiLedger used to reconcile the 
cash accounts with the bank statements.

Beginning Balances - those account balances that are carried forward 
from a previous accounting period.

Cash Accounting - a method of accounting in which revenues are 
recorded when cash is received and expenses are recorded when cash is 
paid.

Cash Flow Statement- a report which shows the cash in and out for a 
given period of time.

Chart of Accounts - the account numbers and descriptions which a 
company uses to record all transactions.

Check Box - a small square box that appears in a dialog box used to 
choose an option.

Click- positioning the pointer on the object to be selected, and then 
pressing and releasing the mouse button.

Close Box- a small square box in the upper left hand corner of the title 
bar of the current window or dialog box on Macintosh or the ‘X’ box in 
the upper right hand corner of the current window on Windows.

Close Year - an accounting procedure in which the balances in the 
income and expense accounts are transferred to the balance sheet (to 
Equity).

Control Buttons - buttons which are used to cause an action to take 
place. The action is indicated by the button title. 

Customer Invoices - a screen in MultiLedger used to record sales of 
items and generate invoices.

Customer Payments - a screen used to record payments on account 
from customers.
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Dialog Box - a box where choices are made or data is entered.

Disbursements Journal - a journal used to record cheques for items 
not entered in accounts payable.

Double-click - positioning the pointer on the object to be selected, and 
then clicking twice in quick succession with the mouse button.

Double Entry Accounting - a method of accounting in which each 
transaction has equal debit and credit amounts. In this way, the 
accounts remain balanced.

Drag - the act of positioning the pointer over the item to be dragged, 
and then holding the mouse button down while moving the mouse. 

Equity (Owner’s Equity) - the rights to the properties of a business, 
such as common stock and retained earnings.

Expenses - expenditure for operating costs of an accounting period.

Export - the capability to move data into a text file which can be used 
by other applications.

Financial Snapshot- a report which shows a summary of cash, 
receivables, payables, inventory and several financial ratios.

Fiscal Year - the twelve-month accounting period used by a company.

Format - the ability to define the placement of fields for cheques.

General Journal - a journal used to record transactions that do not fit 
within the scope of the Receipts or Disbursements Journal, such as 
depreciation or amortization adjustments.

General Ledger - a collection of ledger accounts which track a 
company’s financial activities.

Icon- a picture on the desktop that represents a file. 

Income - revenues received by a company, usually from sales.

Income Statement - a report which shows the income and expenses of 
a company for a given time period.

Item Purchases - a screen in MultiLedger used to record purchases of 
items.

Interface Accounts - a screen used to assign ledger accounts to 
posting categories.

Liabilities- any debts owed by a company, such as accounts payable or 
sales taxes payable.

Payables Journal - a journal used to record payables.

Pointer- the small shape on the screen that follows the movement of 
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the mouse (usually an arrow).

Profit Center - a portion of a company that is responsible for its own 
income and expenses.

Radio Button - a hollow button which, when clicked on, becomes 
filled in with a black circle. Radio buttons are a means of making a 
single choice from several related alternatives within a dialog.

Receipts Journal - a journal used to record deposits to cash accounts 
for items not entered in accounts receivable.

Retained Earnings - that portion of Owner’s Equity which represents 
the retained net income/loss of a company.

Reversing Entry - an entry that reverses a previous entry.

Sales Journal - a journal used to record sales and generate invoices.

Scroll - to move lines of text within a box so that a different portion of 
the text may be viewed.

Select - to use the mouse to click and drag across some information in 
order to highlight it.

Text File - a file which can be opened by word processing and other 
software packages.

Trial Balance - a listing of all of the accounts from the chart of 
accounts along with their balances.

Vendor Payments - a screen used to record payments to vendors and 
to generate cheques.

Year-to-date - the total balance of an account from the first period in 
the fiscal year to the current period.
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Appendix D AppleScript and 
Importing

This appendix describes how to use MultiLedger’s built-in AppleScript 
capabilities for importing information into MultiLedger for Macintosh.



356 Appendix D AppleScript and Importing

Importing Information into MultiLedger Using AppleScript

AppleScript is a feature of the Mac OS that lets you automate tasks on 
your computer. All of the available Import functions in MultiLedger, 
such as importing customers, vendors, invoices, disbursements, etc..., 
can be called automatically using AppleScript commands. This means 
you can automate interaction from other AppleScript-aware 
applications, such as FileMaker Pro or Microsoft Excel.

AppleScript is a scripting language. A scripting language lets you 
control a computer by writing a series of commands, which make up 
the script. When you run the script, the computer performs the actions 
indicated by the commands. As with any programming or scripting 
language, AppleScript consists of a set of commands, operators, 
control structures, and syntax rules. Writing successful scripts is a skill 
that takes time to acquire. Details about the AppleScript language, 
including a beginner’s tutorial, can be found on Apple’s AppleScript 
web site, http://www.apple.com/applescript.
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MultiLedger’s AppleScript Dictionary is available from any scripting 
tool, including Apple’s Script Editor. Below is MultiLedger’s scripting 
dictionary.

 

The Required Suite of scriptable commands are Open, Run, and 
Quit, and are standard with most scriptable applications. 

The Open command opens a specified set of MultiLedger company 
files. Be sure to type in the complete path name, including the file 
name with the extension .ML0 (e.g. 
HardDisk:Folder1:Folder2:FileName.ML0).

The MultiLedger Suite consists of three commands: Launch, 
Import, and Exists.

The Launch command opens the specified application. In the example 
below, it is the application MultiLedger.

Import is used from within a script to call any import function within 
MultiLedger.

Scripting commands begin with a “tell application” command and end 
with an “end tell” command. Comments are prefaced with a double 
hyphen (- -). 
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Below is an example of an import script written in Apple’s Script 
Editor that imports a cheque into MultiLedger. This script checks first 
to see if the disbursement "Ck 1234" already exists in the MultiLedger 
company files. If the transaction already exists in the company files, 
the import command is skipped.

Note The field order used for the import is the same as the field order in the 
Import List (on the Import window under the File menu) for the 
company you are importing into. You should check the Import List in 
the company files you are importing into to make sure that the field 
order is correct.

The Import commands use the keywords import, thedata, from, and 
alias.

Exists is used to determine if a customer, vendor, or item name, or, in 
this case, a transaction document number already exists in the 
MultiLedger company files.
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Appendix E Error Messages
This appendix describes various MultiLedger error messages and 
suggestions to help resolve these errors.
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Macintosh or Windows Error Messages

-39 File incorrect size - In most cases, a file has either been moved out of 
the folder replaced by an older file, or renamed. If the message indicates 
that it is the ML9 file, make sure you have a backup, then continue with 
the open and Rebuild the Files. If there is a transaction or transactions 
that are not complete, doing a Rebuild of the files should either delete 
the problem transaction or fix it. After the Rebuild is complete, view the 
General Ledger for the whole year to verify that it is in balance. If it’s 
not the ML9 file, or the rebuild doesn’t work, the fastest and easiest 
solution is to revert to a recent backup. If that’s not an option, you need 
to contact Tech Support.

Macintosh Error Messages

-36 Input/Output Error - You might get this error by itself or with a -38 
error. Either way, it’s BAD NEWS! It means a sector on the drive or 
media you are using (hard drive, CD, zip, USB, etc.) is bad and the 
files affected by that bad sector can’t be recovered. You will have to 
revert to a backup. Make sure if the problem is with the hard drive that 
you have the drive checked.

-38 File not Open - If you get this message by itself and not in conjunction 
with the above error, you can generally close out of the company, shut 
down your computer, then when you restart you shouldn’t get the error 
message.

-5000 File Access Error - If you are getting this error message when trying 
to open either MultiLedger or Payroll files on Mac OSX, it means 
either the folder the datafiles are in, the application, or the datafiles 
themselves have lost their access priviledges and need to be set to read 
and write. If you need detailed instructions on how to do this, please 
refer to the Knowledge Base on our website, www.checkmark.com.

Windows Error Messages

Unhandled Exception This generally means there is a transaction or transactions that are not 
complete. Doing a Rebuild of the files should either delete the problem 
transaction or fix it. PLEASE make a backup of the files even if you 
have to make a copy of the folder with the data files in it before doing a 
Rebuild.
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DZIP32.DLL and/or 
DUNZIP32.DLL

If you are getting these error messages, you need to first make a 
backup of your files by copying the folder they are into a disk or 
different location on your hard drive. Then you need to Uninstall the 
MultiLedger or Payroll program. Then re-stall the most recent version 
you have and download any patches from our website to bring your 
application current. The re-install will install the DLL files into the 
Windows folder where they need to be.
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252
customizing financial statments 80
disbursements 279
drill down on general ledger 284
drill down on transaction journal re-

ports 282
financial snapshot 297
find command 240
general journal 279
general ledger 283
graph item sales 265
income statement for profit centers

290
income statements 289
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income statment options 290
income versus budget income state-

ment 290
inventory price list 265
inventory-current 265, 269
inventory-selected date 265, 269
item 265
item price list 265, 269
item purchase detail 265, 268
item purchase summary 265, 268
item purchases and payables 279
item sales detail 265, 267
item sales summary 265, 267
job detail 304
job summary 303
jobs 303
mailing labels for customers 246
mailing labels for vendors 258
making selections in list 242
period and YTD income statement

289
printing multiple 243
prior month comparison income

statement 289
prior year comparison balance sheet

287, 295
prior year comparison income state-

ment 290
prior year-end comparison balance

sheet 287
purchase orders 279
quotes 279
receipts 279
recurring entries 279
sales tax 298
salesperson 300
selected date inventory 265
selecting print font for 89
show detail accounts on balance

sheet 287, 295
show detail accounts option on in-

come statement 290
show net before taxes option on in-

come statement 290
show whole dollars on balance sheet

287, 295
sorting transaction journal 278
summary aged accounts payable 257,

261
summary aged accounts receivable

246, 251
transaction journals 278
trial balance 275
trial balance drill down 276
types of balance sheets 287, 295
types of income statements 289
vendor 257
vendor history 258
vendor information 258, 263, 264
vendor item purchase detail 258, 261,

263
vendor mailing labels 258
vendor transaction detail 258, 261,

262
vendor transaction summary 258,

261, 262
whole dollar option on income state-

ment 290
Restoring a backup

Extract to dialog on Windows 312
on Macintosh 313
on Windows 311

Retained earnings
assigning account 26
definition 354
interface account 26

Reuse
adjust inventory 217, 219
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Reversing a payable 201
Reversing entry definition 354
Revised bank balance

bank reconciliation 210

S

Sales detail item report 265, 267
Sales journal

defined 132
definition 354
field descriptions 143
invoice total 145
job 144
ledger account 144
modifying and deleting invoices 149
printing invoices 148
printing labels 90
quote 143
recording a sale with 145
recording advance deposits 163
recurring entry 143
report 279
show customer history 147
statement description 144
terms 144

Sales journal invoices
printing 90

Sales journal labels
printing 90

Sales summary
item report 267

Sales summary item report 265
Sales tax

assigning to customer 54
customer invoices 135
deleting 86
modifying 86
reports 298

setup 85
setup field descriptions 85

Salespeople
commission on gross margin 87
commission rate 87
customer invoices 136
deleting 89
modifying 88
report 300
setting up 87
setup field descriptions 87

Salesperson
(see Salespeople)
assigning to customer 54

Sample company
opening on Macintosh 8
opening on Windows 6

Saving transactions 120
Scripting in MultiLedger 356
Scroll definition 354
Searching in reports 240
Select definition 354
Selling price on customer invoices 137
Setting 78
Setting up

automatic backup reminder 79
basic company information 20
chart of accounts 22
customer terms 51
customers 53, 56
interface accounts 26
inventory 45
items 45, 65
jobs 82
new company 15
outstanding payables 38
outstanding receivables 30
passwords 106
posting categories 237
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sales tax 85
salespeople 87
users 106
vendors 61

Ship charge 136
Ship date on customer invoices 136
Ship to on customer invoices 134
Ship via

customer invoices 136
Shipping

amount on item purchases 178
Shipping charged

interface account 26
Shipping labels 90
Shipping methods

customer invoices 136
Shipping paid

interface account 26
Show 79
Show cleared items

bank reconciliation 209
Show detail accounts

on balance sheet 287, 295
option on income statement 290

Show history
from customer invoices 140
from item purchases 181, 186
from sales journal 147

Show net before taxes
on income statement 290

Sort 79
Sort by ref number

bank reconciliation 209
Starting month 14
Statement description

customer invoices 135
customer payments 154
sales journal 144

Statement of cash flows 294

Statements
(see also Customer statements)
formatting 94

Steps to setting up a company 15
Support

fax number 3
phone number 3

System requirements 1

T

Tab-delimited file
importing and exporting 223

Tax
(see Sales tax)

Tax ID for vendors 59
Tax paid on item purchases 178
Technical support 2
Terms

customer invoices 136
sales journal 144
See Customer terms

Text file
definition 354
importing and exporting 222

Transaction dates 117
Transaction detail

customer report 246, 252
vendor report 258, 262

Transaction journal reports 278
Transaction journals

customer invoices and sales report
279

disbursements report 279
drill down on reports 282
general report 279
item purchases and payables report

279
purchase order report 279
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quotes report 279
receipts report 279
recurring entries report 279
sorting reports 278

Transaction journals reports 278
Transaction summary

customer report 252
vendor report 258, 262

Transactions
30 open months 116
adding comment lines to 119
checking for duplicate document

numbers 116
customer flowchart 130
date alert messages 118
dates 117
document numbers 115
modifying and deleting 120
modifying comment lines 120
moving between fields 112
recording in general journal 207
recurring (also see Recurring entries)
removing comment lines 120
saving 120
using pop-up lists 112
valid dates 118
voiding 123

Trial balance
definition 354
drill down on report 276
report 275

U

Unit cost
customer invoices 138
item purchases 178

Unlocking months 108, 117
User settings

open last company on launch 79
prompt if no backup in this many

days 79
sort customers by name 79
sort items by name 79

Users
deleting 108
modifying 108
passwords 106
setting up 106

V

Vendor information report 264
Vendor payments 194

applying credit amounts in 203
cash account 194
check number 194
definition 354
discount/adjustment account 194
field descriptions 194
modifying or deleting 198
recording checks with 195
report 279
reversing a payable 201

Vendors
1 time button on disbursements jour-

nal 188, 191
accounts payable report 257, 260
aged accounts payable report 257,

260
applying credit 203
deleting 62
history reports 258
information report 258, 263, 264
item purchase detail report 258, 263
mailing labels 258
marking as inactive 57, 65
marking for 1099 58
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modifying 62
notes 58
recording vendor credit 202
reports 257
separating city, state, zip when ex-

porting 225
setting credit limit for 60
setting default account for 59
setting default amount for 59
setting discount % for 60
setting discount days for 60
setting up 61
setting up codes for 100
setup field descriptions 57
show history in item purchases 181,

186
special situations 201
summary aged accounts payable re-

port 257, 261
tax ID 59
transaction detail report 258, 262
transaction summary report 258, 262

Voiding transactions 123

W

Whole dollars
show on balance sheet 287, 295
show on income statement 290

Windows
backing up on 309
creating a new company 16
installing MultiLedger 5
mapping drive for multi-user 102
new line in customer invoices 138
new line in disbursements journal

189
new line in general journal 207, 208
new line in item purchases 179, 182

new line in payables journal 185, 187
new line in receipts journal 150
new line in sales journal 145
posting employee payroll checks to

MultiLedger 318
posting employer checks to Multi-

Ledger 321
printing Metafile 91
restoring a backup on 311
version of MultiLedger 4

Y

Year
closing 234

Year-to-date
definition 354

Z

Zip file
backing up as 309, 310
restoring backup 311, 313
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